Hospira GemStar® Infusion Pump
System Operating Manual

For use with the
Hospira GemStar Pump

List 13000-04-07/08
List 13100-04-07/08

PLEASE
Read this entire manual before
using the Hospira GemStar Pump

This manual is designed for use by healthcare professionals, caregivers, and patients. The Hospira Technical Support Operations hotline is available 24 hours a day (in the USA) to provide consultation and technical assistance regarding the Hospira GemStar Pump.

In the USA: Hospira Technical Support Operations
1-800-241-4002

Outside the USA: Contact your local Hospira sales office

To order additional copies of this manual
(List 13981) call Hospira Customer Care:
1-877-9HOSPIRA
(1-877-946-7747)
Change History

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description of Change</th>
<th>Pages Changed</th>
</tr>
</thead>
<tbody>
<tr>
<td>430-00897-001</td>
<td>Original issue</td>
<td>N/A</td>
</tr>
<tr>
<td>(Rev. 9/02)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>430-00897-A01</td>
<td>Updated Cover</td>
<td>Front and Back</td>
</tr>
<tr>
<td>(Rev. 12/03)</td>
<td>Updated Change History</td>
<td>ii</td>
</tr>
<tr>
<td></td>
<td>Updated Battery Pack Information</td>
<td>19</td>
</tr>
<tr>
<td>430-00897-002</td>
<td>Second Release</td>
<td>Inclusive</td>
</tr>
<tr>
<td>(Rev. 10/04)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>430-00897-A02</td>
<td>Updated Cover</td>
<td>Front and Back</td>
</tr>
<tr>
<td>(Rev. 02/05)</td>
<td>Updated Change History</td>
<td>ii</td>
</tr>
<tr>
<td></td>
<td>Aligned Note and Tip icons</td>
<td>21, 51, 69, 55, 87, 102–102, 105–107, 111, 122, 125, 144, 149, 175, 180</td>
</tr>
<tr>
<td></td>
<td>Corrected typographical error in note</td>
<td>579</td>
</tr>
<tr>
<td></td>
<td>Replaced dashed line with solution icon</td>
<td>121–126</td>
</tr>
<tr>
<td></td>
<td>Added USA/Canada information</td>
<td>271</td>
</tr>
<tr>
<td></td>
<td>Updated CSA information</td>
<td>Back</td>
</tr>
</tbody>
</table>

Note: Change page manuals assembled by Hospira include a change page identifier in the part number on the cover page and on the bottom of each changed page. This change page manual is identified as 430-00897-A02.
## Contents

### 1. Introduction

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>GemStar Pump Layout</td>
<td>2</td>
</tr>
<tr>
<td>GemStar Pump Components</td>
<td>4</td>
</tr>
<tr>
<td>Therapies</td>
<td>5</td>
</tr>
<tr>
<td>GemStar Pump Features</td>
<td>6</td>
</tr>
<tr>
<td>Menu System</td>
<td>7</td>
</tr>
<tr>
<td>Operating Modes</td>
<td>9</td>
</tr>
<tr>
<td>Indications for Use</td>
<td>10</td>
</tr>
<tr>
<td>Contraindications for Use</td>
<td>11</td>
</tr>
<tr>
<td>Warnings and Cautions</td>
<td>11</td>
</tr>
</tbody>
</table>

### 2. Basic Operation

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>17</td>
</tr>
<tr>
<td>Selecting a Power Source</td>
<td>18</td>
</tr>
<tr>
<td>Connecting to the GemStar Docking Station</td>
<td>23</td>
</tr>
<tr>
<td>Powering On the Pump</td>
<td>24</td>
</tr>
<tr>
<td>Accessing the Programming Menu</td>
<td>26</td>
</tr>
<tr>
<td>Programming the Pump</td>
<td>27</td>
</tr>
<tr>
<td>Starting a New Container</td>
<td>29</td>
</tr>
<tr>
<td>GemStar Pump Set</td>
<td>29</td>
</tr>
<tr>
<td>Loading the Cassette</td>
<td>32</td>
</tr>
<tr>
<td>Releasing the Cassette</td>
<td>33</td>
</tr>
<tr>
<td>Priming a GemStar Pump Set</td>
<td>34</td>
</tr>
</tbody>
</table>

### 3. Total Parenteral Nutrition (TPN)

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Therapy Features and Specifications</td>
<td>47</td>
</tr>
<tr>
<td>TPN Programming</td>
<td>48</td>
</tr>
<tr>
<td>Changing a TPN Program</td>
<td>49</td>
</tr>
<tr>
<td>TPN Auto Taper Down</td>
<td>50</td>
</tr>
<tr>
<td>TPN Programming Worksheet</td>
<td>51</td>
</tr>
</tbody>
</table>
## Contents

### 4. Pain Management

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Therapy Features and Specifications</td>
<td>53</td>
</tr>
<tr>
<td>Pain Management Programming</td>
<td>54</td>
</tr>
<tr>
<td>Bolus Delivery</td>
<td>56</td>
</tr>
<tr>
<td>Loading Dose Delivery</td>
<td>58</td>
</tr>
<tr>
<td>Changing a Pain Management Program</td>
<td>58</td>
</tr>
<tr>
<td>Pain Management Programming Worksheet</td>
<td>59</td>
</tr>
</tbody>
</table>

### 5. Intermittent

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Therapy Features and Specifications</td>
<td>61</td>
</tr>
<tr>
<td>Intermittent Programming</td>
<td>62</td>
</tr>
<tr>
<td>Intermittent Delivery Interruptions</td>
<td>64</td>
</tr>
<tr>
<td>Changing an Intermittent Program</td>
<td>65</td>
</tr>
<tr>
<td>Intermittent Programming Worksheet</td>
<td>66</td>
</tr>
</tbody>
</table>

### 6. Continuous

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Therapy Features and Specifications</td>
<td>69</td>
</tr>
<tr>
<td>Continuous Programming</td>
<td>76</td>
</tr>
<tr>
<td>Rate Titration</td>
<td>71</td>
</tr>
<tr>
<td>Figitabbing</td>
<td>71</td>
</tr>
<tr>
<td>Changing a Continuous Program</td>
<td>74</td>
</tr>
<tr>
<td>Continuous Programming Worksheet</td>
<td>75</td>
</tr>
</tbody>
</table>

### 7. Weight Dosed

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Therapy Features and Specifications</td>
<td>77</td>
</tr>
<tr>
<td>Weight Dosed Programming</td>
<td>78</td>
</tr>
<tr>
<td>Auto KVC</td>
<td>79</td>
</tr>
<tr>
<td>Rate Titration</td>
<td>78</td>
</tr>
<tr>
<td>VTBI Threshold</td>
<td>80</td>
</tr>
<tr>
<td>Changing a Weight Dosed Program</td>
<td>80</td>
</tr>
<tr>
<td>Weight Dosed Programming Worksheet</td>
<td>81</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>6. mL/hr Only</td>
<td>83</td>
</tr>
<tr>
<td>Therapy Features and Specifications</td>
<td>83</td>
</tr>
<tr>
<td>mL/hr Only Programming</td>
<td>84</td>
</tr>
<tr>
<td>Auto KVC</td>
<td>85</td>
</tr>
<tr>
<td>Rate Titration</td>
<td>85</td>
</tr>
<tr>
<td>VTBI Titration</td>
<td>86</td>
</tr>
<tr>
<td>Piggybacking</td>
<td>86</td>
</tr>
<tr>
<td>Changing a mL/hr Only Program</td>
<td>89</td>
</tr>
<tr>
<td>mL/hr Only Programming Worksheet</td>
<td>90</td>
</tr>
<tr>
<td>9. Variable Time</td>
<td>91</td>
</tr>
<tr>
<td>Therapy Features and Specifications</td>
<td>91</td>
</tr>
<tr>
<td>Variable Time Programming</td>
<td>92</td>
</tr>
<tr>
<td>Variable Time Delivery Interruptions</td>
<td>93</td>
</tr>
<tr>
<td>Changing a Variable Time Program</td>
<td>94</td>
</tr>
<tr>
<td>Variable Time Programming Worksheet</td>
<td>95</td>
</tr>
<tr>
<td>10. Options Menu</td>
<td>97</td>
</tr>
<tr>
<td>Overview</td>
<td>97</td>
</tr>
<tr>
<td>Tips for Using the Options Menu</td>
<td>97</td>
</tr>
<tr>
<td>Review Program</td>
<td>99</td>
</tr>
<tr>
<td>Histories</td>
<td>99</td>
</tr>
<tr>
<td>Keypad Lock</td>
<td>104</td>
</tr>
<tr>
<td>Change Pump Settings</td>
<td>106</td>
</tr>
<tr>
<td>Sex Clock</td>
<td>106</td>
</tr>
<tr>
<td>Print</td>
<td>106</td>
</tr>
<tr>
<td>Speed Protocol</td>
<td>106</td>
</tr>
<tr>
<td>Next Dose</td>
<td>110</td>
</tr>
<tr>
<td>Connecting to the Data Port</td>
<td>111</td>
</tr>
<tr>
<td>Transferring Data Using a Computer</td>
<td>117</td>
</tr>
<tr>
<td>11. Clinician Instructions</td>
<td>121</td>
</tr>
<tr>
<td>Clinician Locking Sequence Instructions</td>
<td>122</td>
</tr>
<tr>
<td>Program and Deliver a Clinician Activated</td>
<td>124</td>
</tr>
<tr>
<td>Shift Totals and History</td>
<td>125</td>
</tr>
</tbody>
</table>
## Contents

12. Troubleshooting .................. 127
   - Alarm Messages .................. 128
   - Alert Messages .................. 135
   - Other Display Messages ........... 138

13. Maintenance ..................... 139
   - Pump Storage .................... 139
   - Cleaning and Disinfecting ........ 139
   - Repair .......................... 141

14. Operation Test ................... 142
   - Equipment Required ............... 143
   - Test Setup ...................... 144
   - Performing the Operation Test .... 144
   - Printing Test Results ............ 149
   - Operation Test Checklist .......... 151

15. Optional System Components ......... 153
   - Connecting the Salus Cord .......... 156
   - Using the GemStar Lockboxes ..... 156
   - Using the Hospiva Carrying Cases . 159
   - Using the GemStar Docking Station 165

16. Pump Sets ....................... 167

17. GemStar Pump Specifications ........ 171
   - Occlusion Information .............. 174

18. Warranty/Technical Assistance ..... 189

Index ................................ 421

IEC Symbols .......................... Inside back cover
Chapter 1

Introduction

The GemStar Pump is a small and lightweight, single-channel infusion device designed for use in the home, in the hospital, or anywhere electronic infusion is required. The GemStar Pump can be powered by AC mains adaptor, rechargeable battery pack, docking station, or two disposable AA alkaline or lithium batteries. When powered by batteries, the GemStar Pump is ideal for ambulatory patients.

The following conventions are used throughout this manual:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Use</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ALL CAPS]</td>
<td>Pump keys</td>
<td>Press [YES/ENTER] to continue</td>
</tr>
<tr>
<td>ALL CAPS</td>
<td>Display messages</td>
<td>The pump displays:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENTER TO CONFIRM.</td>
</tr>
</tbody>
</table>

**WARNING:** A WARNING message contains special safety information and must be observed at all times. Failure to observe a warning message could be life threatening.

**CAUTION:** A CAUTION contains information that could prevent irreversible product damage or hardware failure. Failure to observe a caution could result in serious patient or user injury.

Note: A NOTE contains information or examples to help explain instructions.

Tip: A TIP contains information that makes the pump easier to use.

Note: Examples are provided only to help explain a pump function and may not be clinically relevant. Graphics are for illustrative purposes only and may not reflect the actual product.
1. Introduction

GemStar Pump Layout

Shown approximately size
1. Introduction

1 DISPLAY • Displays the pump's status.

2 • Silences an alarm.

3 • Stops infusion.

4 • Starts infusion.

5 Power Indicator
   • Lights continuously when the pump is powered by AC mains.
   • Flashes when the pump is powered by external batteries (e.g., battery pack).
   • Not lit when using disposable AA batteries.

6 • Powers the pump on or off. To power-off the pump, press and hold until the display clears.

7 • Returns to previous steps during programming.
   • Exits Help, Change, and Options menus.

8 • Displays the following menu items from the STOP or RUN mode*:
   New Container
   New Program
   Piggybacking
   • Resets a numeric value to zero.

9 • Displays the following Options Menu items from the STOP or RUN mode*:
   1 Review Program
   2 Hitories
   3 Keypad Lock
   4 Pump Settings
   5 Set Clock
   6 Print
   7 Speed Protocol
   8 Next Dose

10 • Scrolls through display messages.
    • Toggles between AM and PM in time-based entries.
    • UP arrow enters a decimal point in numeric entries.
    • DOWN arrow toggles between units of measure when entering concentrations.

11 • Responds "YES" to display questions.
    • Accepts entries and goes to the next step.

12 • Responds "NO" to display questions.

13 • Displays information during programming steps and alarm conditions.
    • Displays Shift Totals, except during programming steps and alarm conditions.

14 • Clears an ATR-TNPE-NPE alarm.
    • Primers a GemStar Pump Set.

15 [0] - [9] • Selects menu items and enters numeric values. If two numbers appear before a
menu item (e.g., 02), press both number keys to select that item.

* Not all menu items are available with all modes.
1. Introduction

GemStar Pump Components

1. Bolus Button: Press this button to start a bolus delivery if available in the current program.
2. Pole Clamp Track: Use to connect to an optional pole clamp.
3. Cassette Release Button: Push down on this button to release the cassette.
4. Power Connector: Use to connect the AC mains adapter.
5. Data Port Connector: Use to connect the GemStar serial cable.
6. Bolus Connector: Use to connect a bolus cord.
7. Tubing Channel: Place the pump set tubing in this channel.
8. Cassette Pocket: Load the cassette into this pocket.
9. I.V. Tubing Guide: Use to hold the I.V. tubing.
11. Battery Compartment: Install two fresh, disposable AA batteries in this compartment.
### Therapies

Seven types of therapy are available for infusion of medications and fluids. The following table lists possible applications and available features of each therapy.

| Therapy         | Possible Applications                                      | tfm  | tet  | arr  | paz  | beta | max  | infl  | dop  | cont  | prov  | prop  | temp  | note  | transports | adapter | connc  | ports  | speed  | options | features |*   |
|-----------------|-----------------------------------------------------------|------|------|------|------|------|------|-------|------|-------|-------|-------|-------|-------|--------|----------|---------|--------|--------|--------|---------|----------|------|
| TPN             | Total Parenteral Nutrition fluid delivery                |      |      |      |      |      |      |       |      |       |       |       |       |       |        |          |         |        |        |        |         |          |      |
| Pain Management| Infusion of analgesics or anesthetics for patient-controlled pain management (PCA) |      |      |      |      |      |      |       |      |       |       |       |       |       |        |          |         |        |        |        |         |          |      |
| Intermittent    | Interval based therapies such as antibiotics             |      |      |      |      |      |      |       |      |       |       |       |       |       |        |          |         |        |        |        |         |          |      |
| Continuous      | Infusion of mg, mcg, or mL/hr with a selectable KVO (Keep Vein Open) option |      |      |      |      |      |      |       |      |       |       |       |       |       |        |          |         |        |        |        |         |          |      |
| Weight Dosed    | Critical care, pediatrics                                |      |      |      |      |      |      |       |      |       |       |       |       |       |        |          |         |        |        |        |         |          |      |
| mL/hr Only      | Simple rate programming                                  |      |      |      |      |      |      |       |      |       |       |       |       |       |        |          |         |        |        |        |         |          |      |
| Variable Time   | Chronotherapy                                            |      |      |      |      |      |      |       |      |       |       |       |       |       |        |          |         |        |        |        |         |          |      |

* = Available

**Note:** Not all therapies are available in all pump configurations.
# GemStar Pump Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Reference Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjustable Settings</td>
<td>Adjusts the distal occlusion pressure limits, air sensor sensitivity, real-time clock, and audible alarm volume.</td>
<td>Chapter 10 Options Menu</td>
</tr>
<tr>
<td>Alerts and Alarms</td>
<td>Signals audible and visual alarms when attention is required.</td>
<td>Chapter 12 Troubleshooting</td>
</tr>
<tr>
<td>Audible Keypad Response</td>
<td>Sounds a single beep when any key is pressed. If an invalid key is pressed, the pump sounds a stutter tone.</td>
<td>Chapter 1 Introduction, GemStar Pump Layout</td>
</tr>
<tr>
<td>Keypad Lock</td>
<td>Restricts access to various options. Four lock levels are available.</td>
<td>Chapter 10 Options Menu and Chapter 11 Clinician Instructions</td>
</tr>
<tr>
<td>New Container</td>
<td>Repeats the current program without reprogramming the pump.</td>
<td>Chapter 2 Basic Operation</td>
</tr>
<tr>
<td>Piggybacking</td>
<td>Allows delivery from a secondary container during a Continuous or mL/h only program.</td>
<td>Chapter 6 Continuous and Chapter 8 mL/h Only</td>
</tr>
<tr>
<td>Power-on Self-test</td>
<td>Performs a self-test each time the pump is powered on.</td>
<td>Chapter 2 Basic Operation</td>
</tr>
<tr>
<td>Operation Test</td>
<td>Performs self-assessment tests to verify the pump is operating properly.</td>
<td>Chapter 14 Operation Test</td>
</tr>
<tr>
<td>Program History</td>
<td>Maintains a history event log, with a date and time stamp of each event for each program. Review the history on the display, or download it to a printer or computer.</td>
<td>Chapter 10 Options Menu</td>
</tr>
<tr>
<td>Speed Protocols</td>
<td>Stores up to nine frequently used programs in the pump's memory for quick access.</td>
<td>Chapter 10 Options Menu</td>
</tr>
</tbody>
</table>
1. Introduction

Menu System

The GemStar Pump uses a menu system that provides step-by-step instructions through all of the pump’s functions. Refer to the following table for a list of functions in each menu.

Use the keypad to select menu items, respond to display messages, and enter numeric values. For example, press [2] to select PAIN MANAGEMENT from the Programming Menu.

*Note: Menu items may vary depending on the pump’s configuration.*

Tip: A menu item does not have to be on the display to be selected. For example, when the Programming Menu first displays, only the first four therapies are shown. Instead of pressing the down arrow to see the other menu items, press [7] to go directly to Variable Time Programming.
### 1. Introduction

<table>
<thead>
<tr>
<th>Menu</th>
<th>Display the Menu</th>
<th>Do This</th>
<th>Menu Items Available</th>
</tr>
</thead>
</table>
| **Programming Menu** | 1 Press [CHANGE] to display the Change menu. | 1. TPH  
2. PAIN MANAGEMENT  
3. INTERMITTENT  
4. CONTINUOUS  
5. WEIGHT Dosed  
6. MISC. ONLY  
7. VARIABALE TIME | |

**Note:** If a program is not currently stored in pump memory at power-on, the Programming menu automatically displays after the self-test.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Press</th>
<th></th>
</tr>
</thead>
</table>
| **Change Menu** | [CHANGE] | 1 NEW CONTAINER  
2. NEW PROGRAM  
3. CHANGE PROGRAM  
4. STORYBANDING |

**Note:** If the current therapy is Weight Dosed or MISC. Only and the pump in RUN mode:
- 3 Always VAT with replace
- 3 CHANGE PROGRAM on the menu display.

**Note:** Piggybacking is available only in MISC. Only and Continuous therapies.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Press</th>
<th></th>
</tr>
</thead>
</table>
| **Options Menu** | [CHANGE] | 1. REVIEW PROGRAM  
2. ELECTRORS  
3. KEYPAD LOCK  
4. TIME SETTINGS  
5. SET CLOCK  
6. PRINT  
7. SPEAKS PROTOCOL  
8. NEXT DOSE |
### 1. Introduction

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Mode</td>
<td>The pump enters the HELP mode when HELP is pressed during programming or an alarm condition. The HELP mode displays additional information about the current condition.</td>
</tr>
<tr>
<td>Programming Mode</td>
<td>The pump enters the PROGRAMMING mode after the pump is powered on or when (RUN) is pressed.</td>
</tr>
<tr>
<td>Run Mode</td>
<td>After (RUN) is pressed, the pump enters the RUN mode, even when not infusing.</td>
</tr>
<tr>
<td>Stop Mode</td>
<td>When programming is complete, the pump enters the STOP mode until is pressed.</td>
</tr>
<tr>
<td></td>
<td>When the programmed therapy is complete, and during certain alarm conditions, the pump automatically enters the STOP mode.</td>
</tr>
<tr>
<td></td>
<td>Press (STOP) to enter the STOP mode any time, except during a CHECK CASSETTE alarm.</td>
</tr>
</tbody>
</table>
1. Introduction

Indications for Use

Physicians or certified, licensed healthcare professionals should always oversee infusions. Healthcare professionals should always supervise pump users and instruct users in pump operation and troubleshooting. Instruction should include how to prevent intravenous (I.V.) related complications, including how to prevent accidental infusion of air.

The pump is suitable for intravenous, arterial, subcutaneous, short-term epidural infusion and percutaneous administration of general I.V. fluids, medications, nutritional fluids, and blood/blood products. The epidural route is recommended to provide analgesia or anesthetic for periods up to 96 hours.

Note: Epidural administration of anesthetics is recommended in the continuous mode only. Epidural administration of analgesics may be delivered by continuous, bolus, or continuous with bolus.

For epidural use, the administration of drugs is restricted to those anesthetic and analgesic drugs approved for continuous epidural administration: e.g., Chloroprocaine Hydrochloride USP, Lidocaine Hydrochloride USP, and Morphine Sulfate Injection USP (Preservative Free).

WARNING: Delayed respiratory depression following continuous epidural administration of preservative-free morphine sulfate has been reported.

For epidural administration, the following is recommended:
+ Nylon or Teflon® catheter
+ Pump sets without Y-sites
+ Stickers for the tubing indicating ongoing administration

Note: Facilities practicing epidural anesthesia/analgesia must be staffed and equipped to manage cardio-pulmonary resuscitation (CPR). Supplies should include oxygen, saline, and other appropriate resuscitative drugs and equipment. Monitor patients continuously (e.g., pulse oximetry) during epidural administration. Frequently observe patient for side effects (for up to 24 hours) following completion of drug administration by the epidural route.
1. Introduction

Contraindications for Use

Persons who do not have the mental and physical capability or the emotional stability to properly use the GemStar Pump should not be operate this pump.

DO NOT use the following with the GemStar Pump System:
- Drugs not compatible with silicone rubber or PVC plastic
- Drugs not stable under infusion conditions

Warnings and Cautions

Pay attention to the following warnings and cautions when operating the GemStar Pump. These warnings and cautions are repeated in the manual when relevant to the procedure being discussed. Pay attention to all alert messages.

General Warnings and Cautions
- Federal (USA) law restricts this device to sale by or on the order of a physician or other licensed practitioner.
- Manual references to specific values are approximate only, unless indicated otherwise. Air-in-line sensitivity values are approximate only.
- When a Proximal Occlusion alarm activates, DO NOT power-off the pump.
- Closely supervise patients who are likely to be adversely affected by unintended operations and failures, including interrupted medication or fluid infusion. Ensure provisions for immediate corrective action are available.

Regarding Drugs Used, Pump Sets, and Containers
- USE ONLY GemStar Pump Sets with the GemStar Pump. Use of unauthorized sets may result in injury to the patient or damage to the pump.
- NEVER use drugs that are incompatible with silicone rubber or PVC plastic.
- To reduce the loss of potency for drugs known to be absorbed by PVC plastic and silicone, begin infusion as soon as practical after priming the pump set. Use of high flow rates during infusion will minimize drug absorption.
Introduction

- DO NOT use medications that are unstable under infusion conditions.
- ALWAYS use connections with Luer-Lock™ fittings.
- To prevent contamination, use aseptic technique with all fluid-path connections. Remove the protective coverings as assembly progresses.
- ALWAYS place the flow stop in the closed position when the set is not in the pump.
- Make sure the cassette is properly installed. When properly installed, all four cassette latches are visibly holding the cassette securely in the cassette pocket.
- Ensure the tubing is behind the tubing guide (at the distal end).
- Arrange tubing, cords, and cables to minimize the risk of patient strangulation or entanglement.
- NEVER use vented fluid containers (e.g., glass or rigid plastic) unless suspended from a pole. When using a vented drip set, ALWAYS use an air-eliminating filter OR set the air sensitivity to either ON or OFF.
- Stop infusion if signs or symptoms of infiltration occur.
- GemStar Pump Sets contain an anti-siphon valve to reduce the potential for gravity flow at a typical 36-inch head height.
- Failure to use the anti-siphon valve may result in unrestricted flow.
- ALWAYS close the slide clamps before removing the cassette from the pump.
- When using the pump for secondary delivery (piggybacking), ensure the fluids being infused are chemically and physically compatible.
- When infusing short-half-life drugs (i.e., those dosed with units of mcg/kg/min) at very low rates (0.8 mL/hr or less), the rate may be too slow for the drug. Consider using a lower drug concentration with these drugs at a pump rate above 0.8 mL/hr can be used.
- When using pre-filled vials, the system may underdeliver at low flow rates.
1. Introduction

Regarding Air-in-Line and Infusion
- To reduce the risk of infusing air, use an air-eliminating filter when the air sensitivity is set to OFF.
- ALWAYS prime the pump set to remove all air from the cassette, tubing, and injection site prior to connecting to the patient.
- ALWAYS disconnect the pump set from the patient prior to priming or purging.

Regarding Pump Operation
- If the pump does not perform as stated in this manual, remove the pump from service IMMEDIATELY.
- If the pump does not display the self-test or if beeps do not sound at power-on, check all power connections and install two fresh, disposable AA batteries. If the problem continues, contact Hospira Technical Support Operations before using the pump.
- Ensure a cassette is installed in the pump before connecting to a printer or computer. If the pump is connected to a patient: BEFORE connecting the pump to a computer or printer, press [STOP], close the slide clamp, and eject the cassette. Leave the pump set connected to the patient. Install another cassette in the pump before connecting to a printer or computer.
- Disconnect the pump from the patient BEFORE performing the Operation Test.
- ALWAYS connect to a grounded AC mains power source when using AC mains power. If the quality of the grounding source is in doubt, operate the pump only with batteries.
- USE ONLY the AC mains adaptors specifically labeled for use with the GemStar Pump.
- USE ONLY the AC mains adaptor specifically labeled for use with the GemStar Pump to charge the battery pack.
- The GemStar AC Mains Adaptor is for use with the GemStar Pump or GemStar Rechargeable Battery Pack only. DO NOT use the GemStar AC mains adaptor with other products.
- During charging, the battery pack is warm. If the battery pack becomes hot to the touch, IMMEDIATELY unplug the AC mains adaptor and contact Hospira Technical Support Operations.
1. Introduction

- When removing the cord from the bottom of the pump, firmly grasp the connector and pull straight out. DO NOT twist or bend the cord or connector.
- To ensure proper pump operation, ALWAYS replace BOTH disposable batteries with fresh, disposable AA batteries when a change is required.
- ALWAYS fully close the battery door when using disposable batteries.
- DO NOT use rechargeable batteries in the battery compartment.
- Ensure two fresh, disposable AA batteries are installed for backup power when using other power sources (e.g., docking station, battery pack). The pump will continue to operate on backup power if the external power source fails.
- ALWAYS avoid sources of high intensity electromagnetic radiation (e.g., radio transmitters, MRI scanners, microwave ovens, x-ray machines, and CAT scanners).
- Use of radio-frequency emitting devices, such as cellular telephones, 2-way radios, and Electrical Surgical Devices (ESU), in close proximity to this device may affect its operation.
- Possible explosion hazard exists if the pump is used in the presence of flammable anesthetics. NEVER use the pump in the presence of flammable or explosive vapors.
- Non-hazardous, low-level electrical potentials are commonly observed when fluids are administered using infusion devices. These potentials are well within accepted safety standards, but may create artifacts on voltage-sensing equipment, such as ECG, EKG, and EEG machines. These artifacts vary at a rate that is associated with the infusion rate. If the monitoring machine is not operating correctly or has loose or defective connections to its sensing electrodes, these artifacts may be accommodated so as to simulate actual physiological signals. To determine if the abnormality in the monitoring equipment is caused by the infusion device instead of some other source in the environment, set the infusion device so that it is temporarily not delivering fluid (if critically acceptable). Disappearance of the abnormality indicates that it was probably caused by electronic noise generated by the infusion device. Proper setup and maintenance of the monitoring equipment should eliminate the artifact. Refer to the appropriate monitoring system documentation for setup and maintenance instructions.
The GemStar pump, when connected to the GemStar AC adaptor, has been tested and found to comply with EMC/EMI limits in accordance with IEC/EN 60601-1-2 (2001). When connected to other power sources and/or optional system components, the GemStar system complies with EMC/EMI limits in accordance with IEC/EN 60601-1-2 (1993). These limits are designed to provide reasonable protection against harmful interference in a typical medical installation. The equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to other devices in the vicinity. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference with other devices, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving device.
- Increase the separation between the equipment.
- Connect the equipment to an outlet on a circuit different from that to which the other device is connected.
- Consult the manufacturer or field service technician for help.

The use of portable and mobile RF equipment may have an impact on this and other pieces of medical equipment.

Regarding Handling and Maintenance

- Use proper care during unpacking, installation, and operation of the pump. If the pump is inadvertently mishandled, check connections and programmed data to ensure there is no damage. Refer to Chapter 14 Operation Test for further information.
- ALWAYS avoid dropping or hitting the pump. If the pump is dropped or hit, ALWAYS check connections and programmed data.
- NEVER use sharp objects (e.g., fingernails, pens, pencils, or other probes) to program or clean the pump.
- Use care not to damage the silicone seals around the sensor bodies in the cassette pocket.
- To avoid mechanical or electronic damage, NEVER submerge pump in water or other fluids and avoid fluid spills. If the pump becomes wet, dry it immediately with a dry, lint-free cloth. Check connections and programmed data.
1. Introduction

- Some cleaning and sanitizing compounds may slowly degrade components made from some plastic materials. DO NOT use compounds containing combinations of isopropyl alcohol and dimethyl benzyl ammonium chloride (i.e., alcohol wipes).
- DO NOT sterilize by heat, steam, ethylene oxide (ETO), or radiation. Apply disinfectants to the outside surface of the pump only. DO NOT use abrasive cleaners or materials on the pump. Using abrasive cleaners or cleaning solutions not recommended by Hospira may result in product damage.
- Please comply with local disposal and recycling regulations as appropriate for disposable batteries, rechargeable battery packs, medical electronic components, and pump sets.
Chapter 2

Basic Operation

The minimum elements required for using the GemStar Pump are:

- GemStar Pump
- Appropriate power source
- Appropriate GemStar Pump Set
- Appropriate fluid container
- Patient-access device

Overview

To start a therapy:

1. Determine the program settings. Refer to the appropriate therapy chapter for a worksheet that may be copied and used to record program settings.

2. Select a power source. Refer to Selecting a Power Source on page 18.


4. Load the cassette into the pump. Refer to Loading the Cassette on page 32.


6. Select the appropriate optional system components, such as a bolus cord.

7. Select the therapy type and enter a program. Refer to the appropriate therapy chapter for detailed instructions.

8. Press [START] to begin delivery.
2. Basic Operation

Selecting a Power Source

The GemStar Pump may be powered by one or more of the following:

<table>
<thead>
<tr>
<th>Power Source</th>
<th>Description</th>
<th>Ambulatory</th>
<th>Hospital</th>
<th>Home</th>
</tr>
</thead>
<tbody>
<tr>
<td>GemStar AC Main Adaptor</td>
<td>Wall-mount adapter plugs into a 110 VAC mains supply.</td>
<td></td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>(USA)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GemStar AC Main Adaptor</td>
<td>Tablet top adapter plugs into a 100–240 VAC mains supply.</td>
<td></td>
<td></td>
<td>*</td>
</tr>
<tr>
<td>(Universal)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GemStar Docking Station</td>
<td>Plugs into a 100–240 VAC Volt mains supply while mounted on an IV pole. The docking station's internal batteries power the GemStar Pump during periods of transport.</td>
<td></td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>GemStar Battery Pack</td>
<td>The battery pack's internal batteries power the GemStar Pump during periods of transport when use of AC power is not desirable.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disposable Batteries</td>
<td>Two disposable AA alkaline or lithium batteries (available from local sources)</td>
<td></td>
<td>*</td>
<td>*</td>
</tr>
</tbody>
</table>

CAUTION: To ensure proper pump operation, ALWAYS replace BOTH batteries with fresh, disposable AA batteries when a change is required.

DO NOT use rechargeable batteries in the battery compartment.
Ensure two fresh, disposable AA batteries are installed for backup power when using other power sources (e.g., docking station, battery pack). The pump will continue to operate on backup power if the external power source fails.
Installing Disposable Batteries

1. Flip open the tab of the battery door on the bottom of the pump.

2. With the pump keypad facing up, hold onto the tab and turn the battery door to the left (counterclockwise) until it is released from the battery compartment.

3. Pull the door free and remove any existing batteries.

4. Install two fresh, disposable AA batteries into the battery compartment. Ensure the batteries are inserted as shown.

5. Return the battery door to the battery compartment.

6. Turn the battery door to the right (clockwise). Ensure the battery door is secured under the slot.

7. Flip closed the tab of the battery door to lock in place.
2. Basic Operation

Connecting the GemStar AC Mains Adaptor

1. Connect the cord of the AC mains adaptor to the connector labeled “5 VDC” on the bottom of the pump.

2. Plug the AC mains adaptor into a standard wall outlet.

CAUTION: ALWAYS connect to a grounded AC mains power source when using the AC mains adaptor. USE ONLY AC mains adaptors specifically labeled for use with the GemStar Pump.

When removing the cord from the bottom of the pump, firmly grasp the connector and pull straight out. DO NOT twist or bend the cord or connector.

Note: The green LED on the pump remains lit when connected to AC mains power.
2. Basic Operation

Using the GemStar Rechargeable Battery Pack

Use the GemStar AC Mains Adaptor (List 13026-01 [USA] or 13072-01 [Universal]) to recharge the GemStar Battery Pack.

CAUTION: ALWAYS connect to a grounded AC mains outlet when using AC mains adaptor.

Use only AC mains adaptors specifically labeled for use with the GemStar Pump to charge the battery pack.

During charging, the battery pack is warm. If the battery pack becomes hot to the touch, IMMEDIATELY unplug AC mains power and contact Hospira Technical Support Operations.

Note: A charged battery pack will last approximately 24 hours when the pump is infusing at rates less than 1.25 mL/hr.

To connect the battery pack:

1. Line up the connectors on the top of the battery pack with the holes on the bottom of the pump.
2. Snap the battery pack into place.

To release the battery pack:

1. Press the release button on the battery pack.
2. Pull the battery pack straight out from the pump.

Note: When the pump is connected to the battery pack, the pump's green LED flashes and the battery pack light is off.

When the pump is connected to the battery pack at power-on, the pump displays USING EXT BATT.
2. Basic Operation

To recharge the battery pack:

1. Plug the pin connector of the AC mains adaptor into the port on the bottom of the battery pack.
2. Plug the AC mains adaptor into a standard wall outlet.
3. Leave the battery pack connected to the AC mains adaptor for at least 3 hours to recharge the battery pack.

CAUTION: When removing the cord from the bottom of the pump, firmly grasp the connector and pull straight out. DO NOT twist or bend the cord or connector.

Note: The battery pack light is yellow while the battery pack is charging. When the battery pack is charged, the battery pack light is green.
2. Basic Operation

Connecting to the GemStar Docking Station

**Connecting the Pump**

1. Mount the docking station to the i.V. pole and tighten the knob.

2. Line up the connectors on the bottom of the pump with the connectors on the docking station.

3. Slide the pump into the docking station until it snaps into place.

4. Connect the docking station to AC mains power.

*Note: The docking station light is yellow while the docking station is charging. When the docking station is charged, the light is green.*

**Disconnecting the Pump**

To remove the pump:

1. Press the release button on the top of the docking station.

2. Slide the pump out.
2. Basic Operation

Powering On the Pump

CAUTION: If the pump does not display the self-test or if beeps do not sound at power-on, check all power connections and install two fresh, disposable AA batteries. If the problem continues, contact Hospira Technical Support Operations before using the pump.

Note: If a cassette is not properly loaded, the pump will alarm after the power-on test is complete.

1. Press [ON/OFF] to power-on the pump. The pump completes a self-test and displays the time and date. No response is required.

   Note: The self-test takes approximately 30 seconds to complete. If the pump is locked, lock symbols appear at the beginning and end of the second line: 00:00 00:00.

2. The pump checks for available power sources. Respond to the display message as shown in the following table:

<table>
<thead>
<tr>
<th>Display Message</th>
<th>Power Source(s)</th>
<th>Other Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>No message displays</td>
<td>AC power and disposable batteries</td>
<td>No response required, the pump goes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>to the next step.</td>
</tr>
<tr>
<td>LOW POWER</td>
<td>AC power and weak (voltage) disposable batteries; or weak disposable batteries only.</td>
<td>Press ( ) to confirm. Power-off the pump and install two fresh, disposable AA batteries as a backup power source.</td>
</tr>
<tr>
<td>ENTER TO CONFIRM</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NO INTERNAL BATTERY</td>
<td>No disposable batteries or external power.</td>
<td>Press ( ) to confirm. Power-off the pump and install two fresh, disposable AA batteries as a backup power source.</td>
</tr>
<tr>
<td>NO POWER LOW</td>
<td></td>
<td></td>
</tr>
<tr>
<td>READY AVAILABLE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ENTER TO CONFIRM</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Hospira GamStar Manual 430-00067-002 (Rev. 10/04)
## 2. Basic Operation

<table>
<thead>
<tr>
<th>Display Message</th>
<th>Power Source(s)</th>
<th>User Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>USING BATTERIES</td>
<td>Disposable batteries only.</td>
<td>Press ` confirm.</td>
</tr>
<tr>
<td>ENTER TO CONFIRM</td>
<td>If an external power source is in use,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ensure the connections are secure.</td>
<td></td>
</tr>
<tr>
<td>USING EXT BATT</td>
<td>External batteries</td>
<td>Press ` confirm.</td>
</tr>
<tr>
<td>ENTER TO CONFIRM</td>
<td>(docking station battery or battery pack)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>and disposable batteries.</td>
<td>If an AC mains adaptor is in use,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ensure the connections are secure.</td>
</tr>
</tbody>
</table>

*Note:* To power-off the pump, press and hold ` until the display clears. The pump cannot be powered off during a CHECK CASSETTE alarm (except during PROGRAMMING mode). Refer to Chapter 12 Troubleshooting for information on clearing a CHECK CASSETTE alarm.

![For more information on:](image)  
Setting the clock:  
Locking the keypad:  
Refer to the following pages:  
*Set Clock* in Chapter 10 Options Menu, on page 108.  
*Keypad Lock* in Chapter 10 Options Menu, on page 104.
### 2. Basic Operation:

## Accessing the Programming Menu

After power-on, the pump checks its memory for a stored program. Respond to the display message as shown in the following table:

<table>
<thead>
<tr>
<th>Operation</th>
<th>Condition</th>
<th>User Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>The pump displays the Programming Menu.</td>
<td>Pump memory is clear.</td>
<td>To enter a new program: Select a therapy from the Programming Menu and enter a new program. Refer to the appropriate therapy chapter for instructions.</td>
</tr>
<tr>
<td>1. RESUME PROGRAM</td>
<td>A program is currently stored in pump memory.</td>
<td>To continue the current program, press [1]. To reset the current program: 1. Press [1]. 2. Press [CHANGE] to display the Change Menu and select NEW CONTAINER. To enter a new program and clear shift totals: Press [1]. The pump clears the program and shift totals from memory and enters PROGRAMMING mode. To enter a new program, clear shift totals, and clear history: Press [2]. The pump clears the program and history from memory and enters PROGRAMMING mode.</td>
</tr>
<tr>
<td>2. CLR PROG SHIFT AND HISTORY</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Tip:
To enter a new program when the pump is already powered on:

1. Press [STOP] to place the pump in STOP mode.
2. Press [CHANGE] to display the Change Menu.
3. Select NEW PROGRAM. The pump clears the current program and displays the Programming Menu.
Programming the Pump

Programming Overview

The pump’s menu system provides step-by-step guidance through all of the programming steps. Refer to the appropriate therapy chapter for detailed programming instructions.

Programming worksheets are available at the end of each therapy chapter. Each worksheet lists the minimum and maximum value (program range) allowed for that therapy. If a number outside of the program range is entered, the pump displays the minimum or maximum value allowed.

1. Select the desired therapy from the Programming Menu.
2. Respond to display messages and enter requested values.
   
   Note: Program entries can be changed any time before the Program Review is complete. Press [BACK-UP] to return to previous program displays and make changes as desired.

3. Review the program, if required. Press (✓) to begin review. Press [YES/ENTER] when done.

4. SAVING PROGRAM displays. The pump stores the program in memory and then enters STOP mode.

Tip: If you enter an incorrect number during programming, press [CHANGE] BEFORE pressing [YES/ENTER] to reset the number to zero. Then enter the correct number.
2. Basic Operation

**Programming Tips**
The following table explains how to use the keypad during programming:

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0]</td>
<td>Press the number keys to select menu items and to enter numeric values.</td>
</tr>
<tr>
<td>[1]</td>
<td>Note: Some menu items require pressing two number keys to select them.</td>
</tr>
<tr>
<td>[4]</td>
<td>For example, when selecting a unit of measure for a weight dose program, the menu may display as:</td>
</tr>
<tr>
<td></td>
<td>01 mg/kg/hr</td>
</tr>
<tr>
<td></td>
<td>02 mg/kg/min</td>
</tr>
<tr>
<td></td>
<td>03 mg/kg/min</td>
</tr>
<tr>
<td></td>
<td>04 mg/kg/min</td>
</tr>
<tr>
<td></td>
<td>To select mg/kg/min, press [0][4].</td>
</tr>
<tr>
<td></td>
<td>Press [HELP] to accept entries or to continue when done viewing a display.</td>
</tr>
<tr>
<td>[HELP]</td>
<td>Press [HELP] during programming and alarm conditions to display information about the current condition.</td>
</tr>
<tr>
<td>[&gt;]</td>
<td>Press [&gt;] or [&lt;] to scroll through display messages.</td>
</tr>
<tr>
<td></td>
<td>Press [HELP] to insert a decimal point in a numeric value.</td>
</tr>
<tr>
<td>[CANCEL]</td>
<td>When entering a numeric value during programming, press [CANCEL] before pressing [HELP] to reset the value to zero.</td>
</tr>
<tr>
<td>[BACKUP]</td>
<td>Press [BACKUP] to return to a previous display, to exit the Options Menu, or to exit the HELP mode.</td>
</tr>
</tbody>
</table>
Starting a New Container

Note: The NEW CONTAINER function is not available when the pump is in FULL Lock. Refer to Chapter 10 Options Menu, page 97 for more information on locking the keypad.

To repeat the current program with a new container:

1. From the STOP mode, press [CHANGE] to display the Change Menu.
2. Select NEW CONTAINER from the Change Menu. The pump displays NEW CONTAINER for several seconds and clears the amount infused from memory.
3. Review the program. Press \( \checkmark \) to begin review.
4. Press [START] to begin delivery.

GemStar Pump Set

The GemStar Pump Set is a sterile, single-use, disposable pump set. It is designed for one-time use only and should be properly discarded after use.

Fluid path and areas beneath undisturbed protective set covers are sterile and nonpyrogenic in the intact unit package.

Contact a Hospira representative for more information on selecting the appropriate pump set configuration. Additional disposable components, such as air-eliminating filters and extension sets, may be added to the line as required. To use a GemStar Pump Set, follow the instructions included with the set.

Note: GemStar Pump Sets contain an anti-siphon valve to reduce the potential for gravity flow at a typical 36-inch head height.

False occlusion alarms and fluid delivery inconsistencies may occur when pumping viscous fluids in microbore tubing at rates greater than 500 mL/hr.
2. Basic Operation

A typical GemStar Pump Set is shown below:

1. Piercing Pin
2. Distal End
3. Cassette
4. Flow Stop (open ( ) close ( )
5. Distal End
6. Tubing
7. Slide Clamp
8. Secure Lock
9. Anti-Siphon Valve

Hospira GemStar Manual 450-06897-002 (Rev. 10/04)
2. Basic Operation

**WARNING:** ALWAYS prime the pump set to remove air from the cassette, tubing, and injection sites prior to connecting to the patient. ALWAYS disconnect the pump set from the patient prior to priming or purging. Arrange tubing, cords, and cables to minimize the risk of patient strangulation or entanglement.

Failure to use the anti-siphon valve may result in unrestricted flow.

**CAUTION:** USE ONLY GemStar Pump Sets with the GemStar Pump. Use of unauthorized sets may result in injury to the patient or damage to the pump.

To prevent contamination, use aseptic technique with all fluid-path connections. Remove protective coverings as assembly progresses.

**Opening the Pump Set**

1. Open the GemStar Pump Set package and remove the contents.
2. Remove the protective covers from the fluid container administration port and the pump set.
2. Basic Operation

Loading the Cassette

1. Identify the four black cassette latches inside the cassette pocket.

2. Line up the cassette as shown (with the flow stop button facing the pump).

3. Insert the cassette into the cassette pocket by pushing firmly along the entire cassette until it is firmly sealed.
2. Basic Operation

4 Verify that all four cassette latches are securely holding the cassette.

[Diagram of cassette latches]

**CAUTION:** Ensure the cassette is properly installed. When properly installed, all four cassette latches are visibly holding the cassette securely in the cassette pocket.

5 Place the tubing in the tubing channel.

[Diagram of tubing channel]

Note: Ensure the tubing is behind the tubing guide (at the distal end).

Note: The pump cannot be powered off during a CHECK CASSETTE alarm (except during PROGRAMMING mode). Refer to Chapter 12 Troubleshooting for information on clearing a CHECK CASSETTE alarm.

---

**Releasing the Cassette**

1 Close the CAIR® (roller) clamp or slide clamp on the distal line.

[Diagram of clamp positions]

2 Push down on the cassette release (large black button) on the top of the pump.

[Diagram of cassette release]

3 Remove the cassette.

*Note: When the cassette is released from the pump, the cassette flow stop automatically closes, preventing free flow.*

Hospira GemStar Manual 430-00697-002 (Rev. 10/04)
2. Basic Operation

Priming a GemStar Pump Set

Priming Pump Sets WITHOUT a Drip Chamber

WARNING: Failure to use the anti-siphon valve may result in unrestricted flow.

1. Push down on the flow stop (⑧) to close the cassette.

2. Hold the container with the administration port toward the ceiling and insert the piercing pin.

3. Push down on the flow stop (⑨) to open (piercing position) the cassette.

4. Invert the cassette approximately 45°.

5. While holding the rotated cassette, squeeze or roll the container to remove air from the container and cassette.

6. Return the cassette to the upright position. Continue priming until fluid fills the tubing.
2. Basic Operation

7 Push down on the flow stop (●) to close the cassette.

8 Load the cassette.

\[\text{CAUTION: Ensure all four cassette latches are clearly visible after the cassette is installed. Refer to \textit{Loading the Cassette} on page 32.}\]

\[\text{Note: Ensure the tubing is behind the tubing guide (at the distal end).}\]

\[\text{CAUTION: When priming is complete, ensure no fluid flows at the distal end of the pump set. If flow is observed, DO NOT use the pump set.}\]

9 Connect the pump set to the patient-access device.
2 Basic Operation

Priming Pump: Sets WITHOUT a Drip Chamber Using the PURGE Key

WARNING: Failure to use the anti-siphon valve may result in unrestricted flow.

Note: The PURGE function is available only if there is a program in the pump.

1. Push down on the flow stop (a) to close the cassette.

2. Hold the container with the administration port toward the ceiling, and insert the piercing pin.

3. Load the cassette.

CAUTION: Ensure all four cassette latches are clearly visible after the cassette is installed. Refer to Installing the Cassette on page 33.

Note: Ensure the tubing is behind the tubing guide (at the distal end).

4. Program desired therapy.
2. Basic Operation

5. Press [PURGE].


7. While holding the container with the administration port toward the ceiling, press and hold [PURGE].

   Note: Purge rate is 250 mL/hr. The pump purges for up to 2 minutes each time you press and hold [PURGE].

   Continue using the [PURGE] key until fluid fills the tubing. Ensure all air is removed from the container, cassette, and tubing.

   CAUTION: When priming is complete, ensure no fluid flows at the distal end of the pump set. If flow is observed, DO NOT use the pump set.

8. Connect the pump set to the patient-access device.
2. Basic Operation

**Priming Pump Sets WITH a Drip Chamber**

**WARNING:** Failure to use the anti-siphon valve may result in unrestricted flow.

When using a vented chamber, ALWAYS use an air-eliminating filter OR set the air sensitivity to either ON or 1 mL.

1. Push down on the flow stop \( \odot \) to close the cassette.

2. Insert the piercing pin into the container. Suspends the container on an I.V. Pole.

3. Squeeze the drip chamber until filled halfway.

4. Push down on the flow stop \( \odot \) to open (priming position) the cassette.

5. Ensure the CAJR® (roller) clamp is open.

6. Invert the cassette approximately 45°.
2. Basic Operation

7 While holding the rotated cassette, remove air from the container and cassette.

CAUTION: Ensure all four cassette latches are clearly visible after the cassette is installed. Refer to Loading the Cassette on page 32.

8 Return the cassette to the upright position. Continue priming until fluid fills the tubing.

Note: Ensure the tubing is behind the tubing guide (at the distal end)

9 Push down on the flow stop to close the cassette.

10 Load the cassette.

CAUTION: When priming is complete, ensure no fluid flows at the distal end of the pump set. If flow is observed, DO NOT use the pump set.

11 Connect the pump set to the patient-access device.
2. Basic Operation

**Priming Pump Sets WITH a Drip Chamber Using the PURGE Key**

**WARNING:** Failure to use the anti-siphon valve may result in unrestricted flow.

When using a vented set, ALWAYS use an air-eliminating filter OR set the air sensitivity to either ON or 2 mL.

*Note: The Purge function is available only if there is a program in the pump.*

1. Push down on the flow stop (©) to close the cassette.

2. Insert the piercing pin into the container. Suspend the container on an I.V. Pole.

3. Squeeze the drip chamber until filled halfway.

4. Push down on the flow stop (©) to open (priming position) the cassette.

5. Ensure the CAR® (roller) clamp is open.
2. Basic Operation

6 Load the cassette.

CAUTION: Ensure all four cassette latches are clearly visible after the cassette is installed. Refer to Loading the Cassette on page 32.

Note: Ensure the tubing is behind the tubing guide (at the distal end).

7 Program the desired therapy.

8 Press [PURGE].

9 The pump displays PRIME THE SET. Press [YESS/ENTER].

10 Press and hold [PURGE].

Note: Purge rate is 250 ml/hr. The pump purges for up to 2 minutes each time you press and hold [PURGE].

Continue using the [PURGE] key until fluid fills the tubing. Ensure all air is removed from the container, cassette, and tubing.

CAUTION: When priming is complete, ensure no fluid flows at the distal end of the pump set. If flow is observed, DO NOT use the pump set.

11 Connect the pump set to the patient-access device.
2. Basic Operation

**Priming Pump Sets Using Prefilled Vials**

| WARNING: Failure to use the anti-siphon valve may result in unrestricted flow. |

CAUTION: When using pre-filled vials, the system may underdeliver at low flow rates.

1. If using a pump set with the Y-extension, use the slide clamp to close off the KVO (Keep Vein Open) side of the tubing.

2. Open the upper and lower slide clamps.

3. Push down on the flow step (↓) to close the cassette.

4. Connect the pump set to a Hospira pre-filled vial and injector.

5. Push down on the flow step (↑) to open (priming position) the cassette.

---

Hospira GemStar Manual 430-00097-002 (Rev. 10/04)
2. Basic Operation

6. Hold the vial and set upright (vertically) on a flat surface with the pump set extending from the top.

7. Slowly push down on the injector until fluid flows at the distal end of the tubing, which indicates that all air is cleared from the vial, injector, cassette, and tubing.

8. Push down on the flow stop to close the cassette.

9. If the set includes a KVO Y-extension, close the slide clamp below the pre-filled vial and open the slide clamp on the KVO side. Prime the KVO Y-extension.

10. Load the cassette.

CAUTION: Ensure all four cassette latches are clearly visible after the cassette is installed. Refer to Loading the Cassette on page 52.
2. Basic Operation

Note: Ensure the tubing is behind the tubing guide (at the distal end).

CAUTION: When priming is complete, ensure no fluid dewets at the distal end of the pump set. If flow is observed, DO NOT use the pump set.

1. Connect the pump set to the patient-access device.
2. Basic Operation

**Priming Pump Sets with Extensions**

**WARNING:** Failure to use the anti-siphon valve may result in unrestricted flow.

1. Push down on the flow stop \( \odot \) to close the cassette.

2. Hold the container with the administrative port toward the ceiling and insert the piercing pin.

3. Push down on the flow stop \( \odot \) to open (priming position) the cassette.

4. Invert the cassette approximately 45°.

5. While holding the rotated cassette, squeeze or roll the container to remove air from the container and cassette.

6. Return the cassette to the upright position. Continue priming until fluid fills the tubing.
2. Basic Operation

7. Push down on the flow stop (a) to close the cassette.

8. Connect the extension set to the pump set.

9. Load the cassette.

CAUTION: Ensure all four cassette latches are clearly visible after the cassette is installed. Refer to Loading the Cassette on page 52.

Note: Ensure the tubing is behind the tubing guide (at the distal end).

10. Program the desired therapy.

11. Press [PURGE].

12. The pump displays PRIME THE SET. Press [YES/ENTER].

13. Press and hold [PURGE].

Note: Purge rate is 250 mL/hr. The pump purges for up to 2 minutes each time you press and hold [PURGE].

Continue using the [PURGE] key until fluid fills the tubing. Ensure all air is removed from the container, cassette, and tubing.

CAUTION: When priming is complete, ensure no fluid flows at the distal end of the pump set. If flow is observed, DO NOT use the pump set.

14. Connect the pump set to the patient-access device.
Chapter 3

Total Parenteral Nutrition (TPN)

Therapy Features and Specifications

This therapy allows programming of Total Parenteral Nutrition (TPN) protocols.

- Taper Up and Taper Down may be programmed to gradually increase and decrease the infusion rate at the beginning and end of a therapy. If Taper Down is selected during programming, the pump allows auto tapering if the continuous delivery is stopped before the programmed volume has been infused.
- Set an optional KVO (Keep Vein Open) during programming.

Tip: The Programming Worksheet at the end of this chapter lists the minimum and maximum values allowed for this protocol. Use copies of the programming worksheet to record program values before programming the pump.

TPN Programming Tips

The following table explains how to use the keypad during TPN programming:

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0] - [9]</td>
<td>Selects menu items and enters numeric values.</td>
<td>🔗</td>
<td>Scrolls through program review and help messages. The up arrow inserts a decimal point in numeric value.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>🔗</td>
<td></td>
</tr>
<tr>
<td>'&quot;&quot;</td>
<td>Accepts entries or continues when done viewing a display</td>
<td>CHANGE</td>
<td>Clears a numeric value (sets to zero) during programming.</td>
</tr>
<tr>
<td>HELP</td>
<td>Displays information during programming and alarm conditions.</td>
<td>BACK-UP</td>
<td>Returns to a previous display, exits the Options Menu, and exits the HELP mode.</td>
</tr>
</tbody>
</table>
3. Total Parenteral Nutrition (TPN)

TPN Programming

1. Select press from the Programming Menu
2. Select the TPN delivery mode.
3. Enter the total VTBI (Volume To Be Infused).
   
   Note: Maximum VTBI is 9600 ml, minus any taper amount

4. Enter the Taper Up and Taper Down times (if applicable).

   Note: Time is entered in hours:minutes (00:00). For one hour thirty minutes press [1] [3] [0]; not [3] [0].

5. Enter the total time to infuse.

6. Enter the KVO rate. If no KVO is desired, press [YES ENTER] while the value displayed is zero.

   Note: KVO runs after Taper Down until the total container is infused.

7. Enter the container size (VTBI + KVO).

   Note: If KVO is programmed, increase the container size to accommodate the desired KVO volume.

8. Select the air sensitivity, if required.

9. Review the program. Press & up to begin review.

10. If using the PURGE key to prime the pump set, press [PURGE] now.

WARNING: ALWAYS disconnect the pump set from the patient before priming or purging.
3. Total Parenteral Nutrition (TPN)

Changing a TPN Program

<table>
<thead>
<tr>
<th>Can be changed before START is pressed</th>
<th>Can be changed at any time</th>
<th>Cannot be changed</th>
</tr>
</thead>
<tbody>
<tr>
<td>• VTSI</td>
<td>• KVO rate</td>
<td>• Delivery mode</td>
</tr>
<tr>
<td>• Taper times</td>
<td>• Increase container size only</td>
<td></td>
</tr>
<tr>
<td>• Total TPN time</td>
<td>• Air sensitivity</td>
<td></td>
</tr>
</tbody>
</table>

*Note: You cannot change a program when the pump is in FULL or CONTAINER Lock.*

**To change a program:**

1. From the STOP mode, press [CHANGE] and select CHANGE PROGRAM.
2. As each message displays, make the desired changes or press [YES/ENTER] to accept the current setting.
3. Review the program. Press ◀ to begin review.
3. Total Parenteral Nutrition (TPN)

TPN Auto Taper Down

Auto Taper Down is available only if a Taper Down time was entered during programming. Auto Taper Down may be activated when the continuous delivery portion of a TPN with Taper Down protocol is stopped. Auto Taper Down is not available while the pump is in an alarm condition.

1. Press [STOP] during TPN delivery.
   The pump displays DO YOU WANT AUTO TAPER DOWN?
   - Press [NO] to return to the STOP mode. Then press [START] to continue therapy.

2. Enter the Auto Taper Down time.
   The maximum Auto Taper Down time is three hours OR two times the remaining volume divided by the continuous infusion rate, whichever is less.
   Note: Time is entered in hours:minutes (00:00). For one hour thirty minutes, press [1][3][0]; not [8][9].

## 3. Total Parenteral Nutrition (TPN)

**GemStar<sup>®</sup>**

TPN Programming Worksheet

**GIVE:**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Select/Enter Values to Be Entered</th>
<th>Programmable Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Therapy</td>
<td>TPN</td>
<td>N/A TPN</td>
</tr>
<tr>
<td>Delivery Mode</td>
<td>□ Continuous □ Continuous + Taper Down □ Continuous + Taper Up □ Continuous + Taper Up and Down</td>
<td>N/A</td>
</tr>
<tr>
<td>VTBI (Volume To Be Infused)</td>
<td>_________ mL_ 1 - 9600 mL*</td>
<td></td>
</tr>
<tr>
<td>Taper Up</td>
<td>□ No □ Yes _________ hrs:min_ 1 min - 3 hrs</td>
<td></td>
</tr>
<tr>
<td>Taper Down</td>
<td>□ No □ Yes _________ hrs:min_ 1 min - 3 hrs**</td>
<td></td>
</tr>
<tr>
<td>Total Time to Infuse</td>
<td>_________ hrs:min_ 1 min - 24 hrs</td>
<td></td>
</tr>
<tr>
<td>KVO (Keep Vein Open)</td>
<td>□ No KVO Rate: 0.0 □ Yes KVO Rate: __________</td>
<td>1.0 - 5.0 mL/hr</td>
</tr>
<tr>
<td>Container Size</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(VTBI + KVO)</td>
<td>_________ mL_ 9999 mL max</td>
<td></td>
</tr>
<tr>
<td>Air Sensitivity</td>
<td>□ On □ 2 mL Alarms at approx. 0.5 mL of air □ Off □ No alarm</td>
<td>N/A</td>
</tr>
</tbody>
</table>

* Maximum VTBI is 9600 mL minus any taper amount.

** Programmable ranges for taper down are 1 minute to 3 hours OR 2 times the remaining volume divided by the continuous delivery rate, whichever is less.

Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
Chapter 4

Pain Management

Therapy Features and Specifications

This therapy allows programming of a continuous only, bolus only, or continuous with bolus delivery.

- In Continuous + Bolus protocols, you can enter zero for either the continuous rate or the bolus dose when entering or changing a program. The continuous rate and bolus dose cannot be zero at the same time.
- The default bolus delivery rate is 125 mL/hr.
- A loading dose may be set during programming, which can be delivered after programming and priming are complete. The default loading dose rate is 125 mL/hr.
- Priming using [PURGE] is only allowed before [START] is pressed or after one of the following events occur:
  - Complete Review of New Program
  - New Container
  - Air-in-Line Alarm

CAUTION: When using pre-filled vials, the system may underdeliver at low flow rates.

Note: New Container is allowed only when at least 1/2 of the container volume has been infused or 1 hour has elapsed since starting the infusion.

The use of a lockbox is recommended with pain management protocols. Refer to Chapter 15 Optional System Components, page 153, for instructions on using a lockbox with the GemStar Pump.

Tip: The Programming Worksheet at the end of this chapter lists the minimum and maximum values allowed for this protocol. Use copies of the programming worksheet to record program values before programming the pump.
4. Pain Management

Pain Management Programming Tips

The following table explains how to use the keypad during pain management programming:

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0] - [9]</td>
<td>Selects medications and enters numeric values.</td>
<td>[°]</td>
<td>Scrolls through program rows and help messages. The up arrow inserts a decimal point in a numeric value. The down arrow toggles units of measure when entering concentrations.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HELP</td>
<td>Accepts entries or continues when done viewing a display.</td>
<td>CHAGE</td>
<td>Clears a numeric value (sets to zero) during programming.</td>
</tr>
<tr>
<td>HELP</td>
<td>Displays information during programming and alarm conditions.</td>
<td>HELP</td>
<td>Returns to a previous display, exits the Options Menu, and sets the HELP mode.</td>
</tr>
</tbody>
</table>

Pain Management Programming

1. Select PAIN MANAGEMENT from the Programming Menu.

2. Select the delivery mode.

   Note: If Continuous + Bolus is selected, the continuous delivery rate or bolus dose can be set to zero through the CHANGES menu without reprogramming the pump.

3. Select the unit of measure and concentration as required.
4. Pain Management

4 Set the continuous delivery rate.

Note: The pump only delivers in increments of 0.1 mL. Values entered in a Pain Management therapy may be rounded to the nearest 0.1 mL. For example, at a concentration of 15 mg/mL, a rate of 3 mg rounds to 4.5 mg.

5 mg = 0.333 mL
4.5 mg = 0.3 mL

When a value is rounded, the pump sounds four quick beeps, displays ROUNding for a few seconds, and then displays the rounded value. Press [YES/ENTER] to accept the rounded value and continue to the next step.

5 Program a loading dose as required.

6 Program a bolus dose with lockout time and dose limit as required.

Regarding a 1-Hour or 4-Hour Dose Limit: The hour dose limit is the maximum volume (continuous plus bolus or bolus only amount) that can be delivered over the selected period. When the programmed dose limit is reached, the continuous delivery stops and a new bolus is not allowed. As the oldest delivery amounts age out of the 1-hour or 4-hour dose limit record, the pump accepts bolus requests or resumes continuous delivery (if programmed).

Note: If a 1-hour or 4-hour dose limit is programmed, a bolus in progress will stop when the amount infused reaches the dose limit.

Loading doses are included in a 1-hour or 4-hour dose limit. A dose limit in effect could prevent the delivery of a loading dose.

7 If programmed in units of mcg or mg, the line displaying the units flashes. Enter the container size in proper unit measure.

Note: To enter the total in mL when programming a concentration, press \(^{\circ}\) to move to the mL line. Enter the mL value when mL flashes on the display.

8 Select the air sensitivity, if required.

9 Review the program. Press \(^{\circ}\) to begin review.

10 If using the PURGE key to prime the pump set, press [PURGE] now.

**WARNING:** ALWAYS disconnect the pump set from the patient before priming or purging.
4. Pain Management

**Bolus Delivery**

Set bolus doses and delivery limits during programming. The default bolus dose delivery rate in a pain management protocol is 125 ml/hr.

A bolus cord is available for patient bolus requests. Refer to Connecting the Bolus Cord in Chapter 15 Optional System Components, on page 156, for more information.

**Delivering a Bolus Dose**

From the RUN mode, press either the bolus button [1] on the top of the pump or the button on the end of the bolus cord to begin bolus dose delivery. The pump flashes SOLUS DELIVERY on the display and the amount infused accrues as the delivery progresses.

When the bolus dose is complete, the pump does the following:

- Records the bolus request and delivery amount to the event and bolus history logs.
- Adds the delivered boluses to the total bolus amount in the program amounts.
- Resets the bolus lockout time (if applicable) and ignores other bolus requests until the lockout time has elapsed.
- Continues programmed infusion.

*Note: ALL bolus requests are recorded to the event and bolus history logs.*

If the bolus delivery does not start, it could be locked out by one of the following conditions:

- Bolus lockout period
- Loading dose delivery in progress
- Bolus dose delivery in progress
- Bolus per-hour limit
- 1-hour or 4-hour dose limit.
Bolus Dose Interruptions
Bolus deliveries may be interrupted by:

- Pressing [STOP];
- An alarm condition

To continue bolus delivery after an interruption:
1. Press [START]. The pump displays COMPLETE BOLUS NOW?
2. Respond as follows:

| To do that                              | Press this key | Bolus lockout time is set to:
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Deliver the remaining bolus amount</td>
<td>YES/ENTER</td>
<td>The time of delivery completion</td>
</tr>
<tr>
<td>Clear the undelivered bolus amount</td>
<td>NO</td>
<td>The time the bolus was</td>
</tr>
<tr>
<td></td>
<td></td>
<td>interrupted</td>
</tr>
</tbody>
</table>

Loading Dose Delivery
You can set a loading dose during programming, if desired. A loading dose can be delivered after programming and priming are complete.

*Note: Loading dose amounts are included in a 1-hour or 4-hour dose limit.*

Delivering a Loading Dose
1. After priming and programming, press [START].

When the loading dose is complete, the pump does the following:

- Automatically begins programmed infusion
- Records the dose amount to the history log
- Resets the bolus lockout time (if applicable) and ignores other bolus requests until the lockout time has elapsed
4. Pain Management

Loading Dose Interruptions
Loading dose deliveries can be interrupted by:

+ Pressing [STOP]
+ An alarm condition

To continue a loading dose:

1. Resolve the interruption.
2. Press [START]. The pump displays COMPLETE THE LOADING DOSE?
3. Respond as follows:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press this key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deliver the remaining loading dose amount</td>
<td>YES</td>
</tr>
<tr>
<td>Clear the remaining loading dose amount</td>
<td>NO</td>
</tr>
</tbody>
</table>

Changing a Pain Management Program

<table>
<thead>
<tr>
<th>Remaining parameters</th>
<th>Remaining parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery rate</td>
<td>Container size</td>
</tr>
<tr>
<td>Dose</td>
<td>Air sensitivity</td>
</tr>
<tr>
<td>Bomb lockout</td>
<td>Dose limit amount</td>
</tr>
<tr>
<td>Delivery mode</td>
<td>Unit of measure</td>
</tr>
<tr>
<td></td>
<td>Concentration</td>
</tr>
<tr>
<td></td>
<td>Dose limit type</td>
</tr>
</tbody>
</table>

Note: You cannot change a program when the pump is in FULL or CONTAINER Lock. With a RATE CHANGE Lock, the continuous delivery rate and bolus amount can be changed within the set ranges.

Although the delivery mode cannot be changed, if Continuous + Bolus is programmed, the continuous rate or bolus amount can be changed to zero. The minimum values set with a RATE CHANGE Lock could restrict this function.
4. Pain Management

To change a program:

1. From the STOP mode, press [CHANGE] and select CHANGE PROGRAM.
2. As each message displays, make the desired changes or press [YES/ENTER] to accept the current setting.
3. Review the program. Press (f) to begin review.
4. Press [START] to begin delivery.
## 4. Pain Management

### GemStar™

**Pain Management Programming Worksheet**

<table>
<thead>
<tr>
<th>Therapy</th>
<th>Selections When Pain Management</th>
<th>Programmable Ranges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pain Management</td>
<td></td>
<td>N/A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Delivery Mode</th>
<th></th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continuous</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bolius Only</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Continuous - Bolius</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Unit of Measure</th>
<th>Concentration</th>
<th>Programmable Ranges</th>
</tr>
</thead>
<tbody>
<tr>
<td>ml</td>
<td>mg/mL</td>
<td>0.1 - 100 mg/mL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 - 1000 mg/mL</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Continuous Rate</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>0.1 - 2500 mg/hr</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 - 25000 mg/hr</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.1 - 25.0 mL/hr</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Loading Dose</th>
<th>Yes</th>
<th>Amount</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Bolius Dose</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>0 - 2500 mg</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 - 25000 mg</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 - 25.0 mL</td>
</tr>
</tbody>
</table>

| Bolius Lockout | minutes | 5 - 999 min |

<table>
<thead>
<tr>
<th>Optional Dose Limit</th>
<th>4-hour limit Amount</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>400 mg, 500 mg, 4000 mg, 5000 mg</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>1-hour limit Amount</th>
<th>Rate</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>100 mg, 1000 mg</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Bolius/Non-Bolius</th>
<th></th>
<th>For continuous use, no Bolius delivery</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** For Bolius Only, the 4-hour or 1-hour dose limit is not the same as in a bolus dose.

<table>
<thead>
<tr>
<th>Container Size</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>0.1 - 992500 mg</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 - 9925000 mg</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.1 - 992 mg</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Air Sensitivity</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Alarms at approx. 0.3 mL of air</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 mL</td>
<td>Alarms at approx. 2 mL of air</td>
<td></td>
</tr>
<tr>
<td>Off</td>
<td>No alarm</td>
<td></td>
</tr>
</tbody>
</table>

---

hospital GemStar Manual 430-00897-003 (Rev. 10/01)
Chapter 5

Intermittent

Therapy Features and Specifications

This therapy allows programming of multiple doses at regular intervals.

- Optional KVO (Keep Vein Open) can be set during programming.
- The pump can be disconnected from the patient between dose deliveries. A call back alarm can be set to alert the patient or caregiver to reconnect the pump before the next scheduled delivery begins. The pump must remain powered on for the call back alarm to function. At the set time before each dose, the pump produces an audible and visual alarm and flashes START on the display.

Tip: The Programming Worksheet at the end of this chapter lists the minimum and maximum values allowed for this protocol. Use copies of the programming worksheet to record program values before programming the pump.

Intermittent Programming Tips

The following table explains how to use the keypad during intermittent programming:

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0] - [9]</td>
<td>Selects menu items and enters numeric values.</td>
<td>[ ]  [ ]</td>
<td>Scrolls through program review and help messages. Toggles between AM and PM in time-based entries. The up arrow inserts a decimal point in numeric values.</td>
</tr>
<tr>
<td>[ ]  [ ]</td>
<td>Accepts entries or continues when done viewing a display.</td>
<td>CHANGE</td>
<td>Clears a numeric value (resets to zero) during programming.</td>
</tr>
<tr>
<td>HELP</td>
<td>Displays information during programming and alarm conditions.</td>
<td>BACK-UP</td>
<td>Returns to a previous display, exits the Options Menu, and exits the HELP mode.</td>
</tr>
</tbody>
</table>
5. Intermittent

**Intermittent Programming**

1. Select **INTERMITTENT** from the Programming Menu.
2. Enter the dose amount in mL.
3. Enter the infusion time for each dose in hours:minutes (00:00). For example, press [4] [6] if each dose is to deliver for 46 minutes.
4. Enter the frequency of dose deliveries. For example, press [4] [3] [9] to start a dose every four hours.
5. Enter the total number of doses in the container. To determine the number of doses in the container, divide the volume in the container by the dose amount.
6. Enter the KVO rate in mL.
   - KVO delivers before a delayed start time, between doses, and after the last dose until the total container is infused.
   - If no KVO is desired, press [YES/ENTER] while the value displayed is zero.
7. Enter the container size.
   - The pump automatically calculates the minimum container size required to deliver the number of programmed doses and KVO between doses.

Note: If KVO is desired before a delayed start, increase the container size to include the desired KVO volume.

8. Select the air sensitivity, if required.
   - Note: DO NOT press [YES/ENTER] after selecting the air sensitivity. If [YES/ENTER] is accidentally pressed and a call back alarm is not desired, press [BACKUP] to return to the beginning of step 9 and press [NO].

9. The pump displays **SET CALL BACK ALARM FOR NEXT DOSE?**
   - Press [NO] if you do not want to set the call back alarm.
   - Press [YES/ENTER] to set the call back alarm.
   - Enter the time before the next dose that the alarm should sound. For example, press [1] [6] to set the alarm to sound 10 minutes before the start of the next scheduled delivery.
5. Intermittent

Note: When programming the call back alarm, be sure to allow enough time for the patient or caregiver to reconnect the pump to the patient and to press [START] before the scheduled dose start time.

10 The pump displays the current time.
   • If the displayed time is correct, press [YES/ENTER].
   • To set the clock, press [OPTIONS].

11 The pump displays the current time and START NOW?
   • Press [YES/ENTER] to begin delivery when the pump enters the RUN mode.
   • Press [NO] to set a delayed start time. The pump displays SET START TIME. Enter the desired start time and press [YES/ENTER] when done.

   Note: When entering the time in 12-hour format, press [↑] or [↓] to toggle between AM and PM.

12 Review the program. Press [✓] to begin review.

13 If using the PURGE key to prime the pump set, press [PURGE] now.

WARNING: ALWAYS disconnect the pump set from the patient before priming or purging.

Note: The call back alarm works only when the pump is powered on AND in the STOP mode. DO NOT power-off the pump while it is disconnected from the patient if you have set the call back alarm.

When the alarm sounds, press [SILENCE] to silence the alarm for three minutes. Then reconnect the pump to the patient.

Tip: To use a delayed start without specifying a start time:

1 Press [YES/ENTER].
2 Complete the program review.
3 Power-off the pump.
4 When the pump is powered on again, complete the program review, then press [START] to begin delivery.
5. Intermittent Delivery Interruptions

Missed Start Time
- If the programmed start time is missed, it can be changed through the Options Menu. Refer to Next Dose in Chapter 10 Options Menu, on page 111.
- If the pump remains in the STOP mode and the first dose is missed, press [START] to begin delivery immediately and all remaining doses will be shifted.
- If the pump is programmed with a delayed start time and is then powered off before [START] is pressed, the pump will skip to the NEXT occurrence of the programmed start time.

For example, the current time is 10:00 PM. The user sets the delayed start time for 10:30 PM and then powers off the pump. The user does not power on the pump until 10:40 PM, which is 10 minutes after the scheduled start time. The pump does not begin delivery until 10:30 PM the FOLLOWING day.

Dose Interruptions
To understand how interruptions are resolved, compare the normal Intermittent delivery diagram below for a 2-hour dose every four hours, to the interruption diagrams shown in the examples:

- If an Intermittent dose is interrupted and the pump is placed in the STOP mode during the on/off cycle of the current dose, the dose continues delivery from the point where it was interrupted and all remaining doses are shifted.

For example, in the following diagram, an Intermittent dose was started at 2:00. The dose was interrupted during the current dose cycle and was started again before the end of the current dose cycle.

Dose Delivered (96)

Hospira GemStar Manual 430-0607-002 (Rev. 10/04)
5. Intermittent

- If an intermittent dose is interrupted and the pump is placed in the RUN mode after the off cycle of the current dose, the next dose begins delivery. All remaining doses are shifted if necessary.

For example, in the following diagram, an intermittent dose was started at 2:00. It was interrupted during the current delivery cycle at 2:30, but was not started again until after the current delivery cycle at 6:45:

- When the dose is complete, the start time for the Next Dose displays. To change the start time refer to Chapter 10 Options Menu, page 97.
- Any missed Intermittent doses, except the first dose, are added to the end of the delivery schedule.
5. Intermittent

Changing an Intermittent Program

<table>
<thead>
<tr>
<th>Can be changed at any time</th>
<th>Can be changed if dose is in progress</th>
<th>Cannot be changed after [Start] is pressed</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Dose parameters</td>
<td>- Next dose start time</td>
<td>- Current time</td>
</tr>
<tr>
<td>- KCU rate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Container size</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Air sensitivity</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Call back alarm</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Note: You cannot change a program when the pump is in FULL or CONTAINER Lock.*

To change a program:

1. From the STOP mode, press [CHANGE] and select CHANGE PROGRAM.
2. As each message displays, make the desired changes or press [YES/ENTER] to accept the current setting.
3. Review the program. Press [No] to begin review.
4. Press [START] to begin delivery.
### GemStar®

**Intermittent Programming Worksheet**

**GIVE:**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Selections and/or Values to be Entered</th>
<th>Programmable Ranges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Therapy</td>
<td>Intermittent</td>
<td>N/A</td>
</tr>
<tr>
<td>Dose Amount</td>
<td></td>
<td>0.1 - 9600 mL</td>
</tr>
<tr>
<td>Infusion Time</td>
<td></td>
<td>1 min - 24 hrs</td>
</tr>
<tr>
<td>Per Dose</td>
<td></td>
<td>(Infusion time per dose + 1 min) to 66 hrs</td>
</tr>
<tr>
<td>Dose Frequency</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of Doses Per</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Containers</td>
<td></td>
<td></td>
</tr>
<tr>
<td>KVO (Keep Vein Open)</td>
<td>□ No KVO Rate: 0.0</td>
<td></td>
</tr>
<tr>
<td>□ Yes KVO Rate:</td>
<td></td>
<td>0.1 - 5.0 mL/hr</td>
</tr>
<tr>
<td>Container Size*</td>
<td></td>
<td>0.1 - 9999 mL</td>
</tr>
<tr>
<td>Air Sensitivity</td>
<td>□ On Alarms at approx. 0.5 mL of air</td>
<td>N/A</td>
</tr>
<tr>
<td>□ 2 mL Alarms at approx. 2 mL of air</td>
<td></td>
<td></td>
</tr>
<tr>
<td>□ Off No alarm</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Call Back Alarm</td>
<td>□ No</td>
<td>1 min to 15 min before start</td>
</tr>
<tr>
<td>□ Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start Time</td>
<td>□ Start immediately after programming</td>
<td></td>
</tr>
<tr>
<td>□ Specify AM or PM if not 24-hour clock.</td>
<td></td>
<td>12:00 AM - 11:59 PM or 00:00 - 23:59</td>
</tr>
</tbody>
</table>

* The pump automatically calculates the minimum container size required to deliver the number of programmed doses and KVO between doses. If KVO is desired before a delayed start, increase the container size to include the desired KVO volume.
Chapter 6
Continuous

Therapy Features and Specifications
This therapy allows programming of a continuous delivery.
- Optional KVO (Keep Vein Open) can be set during programming.
- The rate can be titrated while the pump is infusing.
- An optional secondary container can be "piggybacked" on the primary container during regular delivery using a GemStar Piggyback Pump Set. Refer to Piggybacking in this chapter for more information.

Tip: The Programming Worksheet at the end of this chapter lists the minimum and maximum values allowed for this protocol. Use copies of the programming worksheet to record program values before programming the pump.

Continuous Programming Tips
The following table explains how to use the keypad during continuous programming:

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0] - [9]</td>
<td>Selects menu items and enters numeric values.</td>
<td>⬆️ ⬇️</td>
<td>Scrolls through program review and help messages. The up arrow inserts a decimal point in a numeric value.</td>
</tr>
<tr>
<td></td>
<td>Accepts entries or continues when done viewing a display.</td>
<td>CHANGE</td>
<td>Clears a numeric value (resets to zero) during programming.</td>
</tr>
<tr>
<td>HELP</td>
<td>Displays information during programming and alarm conditions.</td>
<td>BACKUP</td>
<td>Returns to a previous display, exits the Options menu, and exits the HELP mode.</td>
</tr>
</tbody>
</table>
6. Continuous Programming

1. Select CONTINUOUS from the Programming Menu.
2. Select the unit of measure and concentration as required.
3. Enter the rate.
4. Enter the VTBI (Volume to be infused).
5. Enter the KVO rate, if desired.
   KVO runs after the programmed VTBI until the total container is infused. If no KVO is desired, press [YES/ENTER] while the value displayed is zero.
6. Enter the container size (VTBI + KVO).
   VTBI is the default value on the CONTAINER display.
   Note: If KVO is programmed, increase the container size to include the KVO delivery.
   To enter the total in mL when programming a concentration, press (\(\pi\)) to move to the mL line. Enter the mL size when set flashes on the display.
7. Select the air sensitivity, if required.
8. Review the program. Press (\(\pi\)) to begin review.
9. If using the PURGE key to prime the pump set, press [PURGE] now.

WARNING: ALWAYS disconnect the pump set from the patient before priming or purging.
6. Continuous

Rate Titration

To titrate the rate while the pump is infusing:

1. In the RUN mode, press the number key for the new rate. Press [YES/ENTER].
   For example: if the current rate is 100 mL/hr, press [5] [0] [YES/ENTER] to change the rate to 50 mL/hr.

   Note: You have approximately five seconds after pressing a key to press another numeric key, the decimal key, or [YES/ENTER]. If no key is pressed within five seconds, the rate does not change and the delivery continues as previously programmed.

2. NEW RATE displays with the new value.
   - Press [YES/ENTER] within 10 seconds to accept the change and begin delivery at the new rate.
   - Press [NO] to continue delivery at the previously programmed rate.

Piggybacking

Piggybacking with the GemStar pump requires a GemStar Primary Piggyback pump set with a proximal Y-site backcheck valve and a secondary piggyback set with an extension hook. The secondary container must be higher than the primary container. Refer to the instructions included with the piggyback pump set for more information.

WARNING: When using the pump for secondary delivery (piggybacking), ensure the fluids being infused are chemically and physically compatible.

The piggyback rate and piggyback VTBI display until the secondary container has been delivered. Then the primary infusion continues.

Note: The piggyback infusion amount is NOT added to the primary programmed infusion amount.
Preparing for Secondary Delivery (Piggybacking)

1. Ensure a primary piggyback pump set with a proximal Y-site backcheck valve is in place.

2. Use the extension hook from the secondary set to suspend the primary container from the I.V. pole.

3. Prepare the secondary set according to the instructions included with the set.

4. Attach a needle or blunt cannula (if appropriate) and prime the secondary set.

5. Suspend the secondary container from the I.V. pole.

Note: When using a secondary container of 500 ml or greater, ensure the bottom of the secondary container is at least 7 inches (17.8 cm) above the fluid level in the primary container. Use additional extension hooks if necessary.

6. Connect the secondary set to the proximal Y-site (or proximal luer port).
Programming a Secondary Delivery (Piggybacking)

Note: To distinguish the piggyback delivery from the primary delivery, PIGGYBACK displays and the piggyback VTBI counts down to completion. For example, a piggyback rate of 250 mL/hr with a remaining VTBI of 218.5 mL will display as shown.

Tip: Prepare and set up containers BEFORE programming the pump for piggyback delivery.

1. Press [CHANGE] and select PIGGYBACKING from the Change Menu.
2. Enter the dose amount for the secondary container.
3. Enter the infusion time for the secondary container.
4. Open the slide clamp or CAIR® (roller) clamp on the tubing of the secondary container.
5. Press [YES/ENTER] to begin piggyback delivery.

Note: Primary flow stops until the secondary VTBI is delivered; then primary flow continues. Any remaining secondary fluid will be delivered at the primary rate. The maximum piggyback rate is 300 mL/hr. For secondary rates above 300 mL/hr flow may occur from the primary container.

Changing a Piggyback Delivery

1. Press [CHANGE] and select PIGGYBACKING from the Change Menu.
2. Press [CHANGE] to reset the dose amount to zero.
3. Enter the new piggyback dose amount and press [YES/ENTER].
4. Set the infusion time for the secondary container.
5. Press [YES/ENTER] to begin piggyback delivery.

Note: You must know the amount that has already been delivered. When the piggyback dose amount is changed, the pump begins a new VTBI countdown.
8. Continuous

Cancelling a Piggyback Delivery

1. Press [CHANGE] and select PIGGYBACKING from the Change Menu.
2. Press [CHANGE] to reset the dose amount to zero.

Changing a Continuous Program

<table>
<thead>
<tr>
<th>Delivery rate</th>
<th>Container size</th>
<th>Unit of measure</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Air sensitivity</td>
<td>Concentration</td>
</tr>
<tr>
<td>KVO rate</td>
<td>Piggybacking</td>
<td></td>
</tr>
</tbody>
</table>

Note: You cannot change a program when the pump is in FULL or CONTAINER Lock.

To change a program:

1. From the STOP mode, press [CHANGE] and select CHANGE PROGRAM.
2. As each message displays, make the desired changes or press [YES/ENTER] to accept the current setting.
4. Press [START] to begin delivery.
6. Continuous

GemStar®
Continuous Programming Worksheet

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Selected and/or Values to be Entered</th>
<th>Programmable Ranges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Therapy</td>
<td>Continuous</td>
<td>N/A</td>
</tr>
<tr>
<td>Unit of Measure</td>
<td></td>
<td>0.1 - 1000 mg/mL</td>
</tr>
<tr>
<td></td>
<td>Concentration: ___________ mg/mL</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Concentration: ___________ mcg/mL</td>
<td>1 - 1000 mcg/mL</td>
</tr>
<tr>
<td></td>
<td>ml</td>
<td></td>
</tr>
<tr>
<td>Rate</td>
<td></td>
<td>0.1 - 9999 mg/hr</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 - 999900 mcg/hr</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.1 - 1000 mL/hr</td>
</tr>
<tr>
<td>VTBI (Volume To Be Infused)</td>
<td></td>
<td>0.1 - 9999 mg</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 - 999900 mcg</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.1 - 9999 mL</td>
</tr>
<tr>
<td>KVO (Keep Vein Open)</td>
<td>No</td>
<td>KVO Rate: 0.0</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>KVO Rate: ___________</td>
</tr>
<tr>
<td>Container Size (VTBI + KVO)</td>
<td></td>
<td>0.1 - 9999 mg</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 - 999900 mcg</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.1 - 9999 mL</td>
</tr>
<tr>
<td>Air Sensitivity</td>
<td>On</td>
<td>Alarms at approx. 0.5 mL of air</td>
</tr>
<tr>
<td></td>
<td>2 mL Alarms at approx. 2 mL of air</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>No alarm</td>
</tr>
<tr>
<td>Piggyback Dose Amount</td>
<td></td>
<td>1 - 7200 mL</td>
</tr>
<tr>
<td>Piggyback Infusion Time</td>
<td></td>
<td>1 min or dose amount / 300 mL/hr to 24</td>
</tr>
<tr>
<td></td>
<td></td>
<td>hrs or dose amount / 0.1 mL/hr</td>
</tr>
</tbody>
</table>

Hospira GemStar Manual 430-00697-002 (Rev. 10/04) 75
Chapter 7

Weight Dosed

Therapy Features and Specifications

This therapy allows programming of delivery rate as a function of body weight.

- The air sensitivity in a Weight Dosed program is automatically set to ON. This setting can be changed through the Options Menu after programming is complete. Refer to Air Sensitivity in Chapter 10 Options Menu, on page 107.
- The pump automatically delivers KVO (Keep Vein Open) after the programmed VTBI (Volume To Be Infused) has completed.
- The rate can be titrated while the pump is infusing.

Tip: The Programming Worksheet at the end of this chapter lists the minimum and maximum values allowed for this protocol. Use copies of the programming worksheet to record program values before programming the pump.

WARNING: When using a vented drip set, ALWAYS use an air-eliminating filter OR set the air sensitivity to either ON or 2 mL.

CAUTION: When infusing short-half-life drugs (i.e., those dosed with units of mcg/kg/min) at very low rates (0.8 mL/hr or less) the rate may be too slow for that drug. Consider using a lower drug concentration with these drugs so a pump rate above 0.8 mL/hr can be used.
7. Weight Dosed

Weight Dosed Programming Tips

The following table explains how to use the keypad during weight dosed programming:

<table>
<thead>
<tr>
<th>Keypad</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0]-[9]</td>
<td>Selects many items and enters numeric values.</td>
</tr>
<tr>
<td>[←]</td>
<td>Scrolls through program review and help messages. The up arrow inserts a decimal point in a numeric value.</td>
</tr>
<tr>
<td>[△]</td>
<td>Accepts entries or continues when some viewing a display.</td>
</tr>
<tr>
<td>[↓]</td>
<td>Cleans a numeric value (goes to zero) during programming.</td>
</tr>
<tr>
<td>[HELP]</td>
<td>Displays information during programming and alarm conditions.</td>
</tr>
<tr>
<td>[BACK UP]</td>
<td>Returns to a previous display, exits the Options menu, exits the HELP mode.</td>
</tr>
</tbody>
</table>

Weight Dosed Programming

1. Select WEIGHT Dosed from the Programming Menu.
2. Select the unit of measure.
   
   *Note: If two numbers appear before a menu item (e.g., 02), press both number keys to select that item.*
3. Enter the patient weight, if required.
4. Enter the concentration:
   - Enter the value for the unit of measure when it flashes on the display.
   - Press [YES/ENTER] to confirm.
5. Tip: Press [↑] to toggle between units of measure.
6. Enter the rate.
   
   *Note: The pump automatically displays the mI/hr equivalent even when another unit of measure is selected.*
7. Enter the VT?
8. Review the program. Press [↑] to begin review.
7. Weight Dosed

8. If using the PURGE key to prime the pump set, press [PURGE] now.

**WARNING:** ALWAYS disconnect the pump set from the patient before priming or purging.

**Auto KVO**

When the programmed VTI has completed delivery, Auto KVO delivery begins automatically and the empty container alarm sounds.

*Note: Auto KVO delivers even while the empty container alarm sounds. Press [SILENCE] to quiet the alarm for 2 minutes.*

<table>
<thead>
<tr>
<th>If the weight dosed rate is:</th>
<th>Auto KVO delivers at:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Greater than or equal to 1 mL/hr</td>
<td>1 mL/hr</td>
</tr>
<tr>
<td>Less than 1 mL/hr</td>
<td>The weight dosed rate</td>
</tr>
</tbody>
</table>

**Rate Titration**

To titrate the rate while the pump is infusing:

1. In the RUN mode, press the number keys for the new rate. Press [YES/ENTER].
   
   For example: if the current rate is 4.0 mg/kg/hr, press [5] [YES/ENTER] to change the rate to 5.0 mg/kg/hr.

   Press [✔] to enter the rate in mL/hr. When using units other than mL/hr, the pump automatically adjusts the mL/hr value.

   *Note: You have approximately five seconds after pressing a key to press another numeric key, the decimal key, or [YES/ENTER]. If no key is pressed within five seconds, the rate does not change and the delivery continues as previously programmed.*

2. **NEW RATE** displays with the new value.
   
   - Press [YES/ENTER] within 10 seconds to accept the change and begin delivery at the new rate.
   
   - Press [NO] to continue delivery at the previously programmed rate.
7. Weight Dosed

VTBI Titration

To titrate the VTBI while the pump is infusing:

1. Press [CHANGE] and select TITRATE VTBI.

2. Press the number keys for the new VTBI, Press [YES/ENTER].
   For example: if the current VTBI is 50 mL, press [1][0][0][YES/ENTER] to change the VTBI to 100 mL.

   Note: You have approximately five seconds after pressing a key to press another numeric key, the decimal key, or [YES/ENTER]. If no key is pressed within five seconds, the VTBI does not change and the delivery continues as previously programmed.

3. New VTBI displays with the new rate.
   - Press [YES/ENTER] within 10 seconds to accept the change and begin delivery with the new VTBI.
   - Press [NO] to continue delivery at the previously programmed VTBI.

Changing a Weight Dosed Program

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Choice</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery rate</td>
<td></td>
</tr>
<tr>
<td>VTBI</td>
<td></td>
</tr>
<tr>
<td>Patient weight</td>
<td></td>
</tr>
<tr>
<td>Unit of measure</td>
<td>Concentration (amount of drug)</td>
</tr>
</tbody>
</table>

Note: You cannot change a program when the pump is in FULL or CONTAINER Lock.

To change a program:

1. From the STOP mode, press [CHANGE] and select CHANGE PROGRAM.

2. As each message displays, make the desired changes or press [YES/ENTER] to accept the current setting.


4. Press [START] to begin delivery.
### GemStar® Weight Dosed Programming Worksheet

**GIVE:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Concentration/Values to be Entered</th>
<th>Programming/Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Therapy</td>
<td>Weight Dosed</td>
<td>N/A</td>
</tr>
<tr>
<td>Units of Measure**</td>
<td></td>
<td>N/A</td>
</tr>
<tr>
<td>mcg/kg/min</td>
<td>mcg/hr</td>
<td></td>
</tr>
<tr>
<td>mg/kg/hr</td>
<td>mg/hr</td>
<td></td>
</tr>
<tr>
<td>mg/kg/min</td>
<td>mg/min</td>
<td></td>
</tr>
<tr>
<td>ml/hr</td>
<td>mL/hr</td>
<td></td>
</tr>
<tr>
<td>mEq/hr</td>
<td>mEq/hr</td>
<td></td>
</tr>
</tbody>
</table>

### Patient Weight

(When programming in kg/min or kg/hr)

<table>
<thead>
<tr>
<th>Weight</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0 - 200.0 kg</td>
<td></td>
</tr>
</tbody>
</table>

### Concentration

(For all units of measure EXCEPT mL/hr)

<table>
<thead>
<tr>
<th>Concentration</th>
<th>Unit</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>mg/kg/hr</td>
<td>mg/hr</td>
<td>0.1 - 9999999</td>
</tr>
<tr>
<td>mEq/hr</td>
<td>mL/hr</td>
<td>0.1 - 9999 mEq</td>
</tr>
</tbody>
</table>

### Rate

(see below *)

### VTBI

(Volume To Be Infused)

<table>
<thead>
<tr>
<th>Volume</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0.1 - 9999 mL</td>
<td></td>
</tr>
</tbody>
</table>

---

* Programmable Ranges for Rate (not all units of measure are available in all pump configurations):

- 0.001 - 833 mg/kg/min: 0.1 - 1000 mL/hr | 0.001 - 9999999 U/hr
- 0.001 - 500 mg/kg/hr: 0.001 - 9999999 mg/hr | 0.001 - 9999999 U/hr
- 0.001 - 1666.6 mg/kg/min: 0.001 - 9999999 mg/hr | 0.001 - 9999999 U/hr
- 0.001 - 1666.6 mg/kg/hr: 0.001 - 9999999 mg/hr | 0.001 - 9999999 U/hr
- 0.001 - 9999999 mcg/kg/hr: 0.001 - 9999999 mcg/hr | 0.001 - 9999999 U/hr
- 0.0001 - 1666.6 mcg/kg/min: 0.0001 - 9999999 mcg/hr | 0.0001 - 9999999 U/hr

**If two numbers appear before a menu item (e.g., 02), press both number keys to select that item.**

**CAUTION:** When infusing short-half-life drugs (i.e., those dosed with units of mcg/kg/min) at very low rates (0.5 mL/hr or less) the rate may be too slow for that drug. Consider using a lower drug concentration so a pump rate above 0.5 mL/hr can be used.
Chapter 8

mL/hr Only

Therapy Features and Specifications

This therapy allows quick programming of delivery rate in milliliters (mL) only.

- The air sensitivity is automatically set to ON. This setting can be changed through the Options Menu after programming is complete. Refer to Air Sensitivity in Chapter 10 Options Menu, on page 107.
- The pump automatically delivers KVO (Keep Vein Open) after the programmed VTBI (Volume To Be Infused) is complete.
- The rate can be titrated while the pump is infusing.
- An optional secondary container can be “piggybacked” onto the primary container during regular delivery using a GemStar Piggyback Pump Set. Refer to Piggybacking in this chapter for more information.
- A program review is not required and is available only through the Options Menu.

Tip: The Programming Worksheet at the end of this chapter lists the minimum and maximum values allowed for this protocol. Use copies of the programming worksheet to record program values before programming the pump.

WARNING: When using a vented set, ALWAYS use an air-eliminating filter OR set the air sensitivity to either ON or 2 mL.
### mL/hr Programming Tips

The following table explains how to use the keypad during mL/hr programming:

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0] - [9]</td>
<td>Selects menu items and enters numeric values.</td>
</tr>
<tr>
<td>[HELP]</td>
<td>Displays information during programming and alarm conditions.</td>
</tr>
<tr>
<td>[CLR]</td>
<td>Accepts entries or continues when done viewing a display.</td>
</tr>
<tr>
<td>[BACK-UP]</td>
<td>Clears a numeric value (resets to zero) during programming.</td>
</tr>
<tr>
<td>[UP/DOWN]</td>
<td>Scrolls through program review and help messages. The up arrow inserts a decimal point in a numeric value.</td>
</tr>
</tbody>
</table>

### mL/hr Only Programming

1. Select mL/hr Only from the Programming Menu.
2. Enter the rate.
3. Enter the IVBIL.
4. If using the PURGE key to prime the pump set, press [PURGE] now.

**WARNING:** ALWAYS disconnect the pump set from the patient before priming or purging.

**Note:** A program review is not required for mL/hr Only programs.
Auto KVO

When the programmed VTBI has completed delivery, Auto KVO delivery begins automatically and the empty container alarm sounds.

*Note: Auto KVO delivers even while the empty container alarm sounds. Press [SILENCE] to quiet the alarm for 2 minutes.*

<table>
<thead>
<tr>
<th>If the weight-based rate is:</th>
<th>Auto KVO delivers at:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Greater than or equal to 1 mL/hr</td>
<td>1 mL/hr</td>
</tr>
<tr>
<td>Less than 1 mL/hr</td>
<td>The programmed rate</td>
</tr>
</tbody>
</table>

Rate Titration

To titrate the rate while the pump is infusing:

1. In the RUN mode, press the number keys for the new rate. Press [YES/ENTER].
   
   For example, if the current rate is 100 mL/hr, press [5] [9] [YES/ENTER] to change the rate to 50 mL/hr.
   
   *Note: You have approximately five seconds after pressing a key to press another numeric key, the decimal key, or [YES/ENTER]. If no key is pressed within five seconds, the rate does not change and the delivery continues as previously programmed.*

2. **NEW RATE** displays with the new value.
   
   - Press [YES/ENTER] within 10 seconds to accept the change and begin delivery at the new rate.
   - Press [NO] to continue delivery at the previously programmed rate.
VTBI Titration

To change the VTBI while the pump is infusing:

1. Press [CHANGE] and select TITRATE VTBI.
2. Press the number keys for the new VTBI. Press [YES/ENTER].
   For example: if the current VTBI is 50 mL, press [4][6][8][YES/ENTER] to change the VTBI to 190 mL.

   **Note:** You have approximately five seconds after pressing a key to press another numeric key, the decimal key, or [YES/ENTER]. If no key is pressed within five seconds, the VTBI does not change and the delivery continues as previously programmed.

3. New VTBI displays with the new rate.
   - Press [YES/ENTER] within 10 seconds to accept the change and begin delivery with the new VTBI.
   - Press [NO] to continue delivery at the previously programmed VTBI.

Piggybacking

Piggybacking with the GemStar Pump requires a GemStar Primary Piggyback Pump Set with a proximal Y-site backcheck valve and a secondary piggyback set with an extension hook. The secondary container must be higher than the primary container. Refer to the instructions included with the piggyback pump set for more information.

| WARNING: | When using the pump for secondary delivery (piggybacking), ensure the fluids being infused are chemically and physically compatible. |

The piggyback rate and piggyback VTBI display until the secondary container has been delivered. Then the primary infusion continues.

**Note:** The piggyback infusion amount is **NOT** added to the primary programmed infusion amount.
Preparing for Secondary Delivery (Piggybacking)

1. Ensure a primary piggyback pump set with a proximal Y-site backseal valve is in place.

2. Use the extension hook from the secondary set to suspend the primary container from the I.V. pole.

3. Prepare the secondary set according to the instructions included with the set.

4. Attach a needle or blunt cannula (if appropriate) and prime the secondary pump set.

5. Suspend the secondary container from the I.V. pole.

   Note: When using a secondary container of 500 mL or greater, ensure the bottom of the secondary container is at least 7 inches (17.8 cm) above the fluid level in the primary container. Use additional extension hooks if necessary.

6. Connect the secondary set to the proximal Y-site (or proximal iuer port).
Programming a Secondary Delivery (Piggybacking)

Note: To distinguish the piggyback delivery from the primary delivery, PIGGYBACK displays and the piggyback VTBI counts down to completion. For example, a piggyback rate of 250 mL/hr with a remaining VTBI of 218.5 mL will display as shown.

Tip: Prepare and set up containers BEFORE programming the pump for piggyback delivery.

1. Press [CHANGE] and select PIGGYBACKING from the Change Menu.
2. Enter the dose amount for the secondary container.
3. Enter the infusion time for the secondary container.
4. Open the slide clamp or CAIR® (roller) clamp on the tubing of the secondary set.
5. Press [YES/ENTER] to begin piggyback delivery.

Note: Primary flow stops until the secondary VTBI is delivered, then primary flow continues. Any remaining secondary fluid will be delivered at the primary rate. The maximum piggyback rate is 300 mL/hr. For secondary rates above 300 mL/hr, flow may occur from the primary container.

Changing a Piggyback Delivery

1. Press [CHANGE] and select PIGGYBACKING from the Change Menu.
2. Press [CHANGE] to reset the dose amount to zero.
3. Enter the new piggyback dose amount and press [YES/ENTER].
4. Set the infusion time for the secondary container.
5. Press [YES/ENTER] to begin piggyback delivery.

Note: You must know the amount that has already been delivered. When the piggyback dose amount is changed, the pump begins a new VTBI countdown.
8. mL/hr Only

Canceling a Piggyback Delivery

1. Press [CHANGE] and select PIGGYBACKING from the Change Menu.
2. Press [CHANGE] to reset the dose amount to zero.

Changing a mL/hr Only Program

<table>
<thead>
<tr>
<th>Can be changed at any time</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery rate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Container size</td>
<td></td>
<td>VTBI</td>
</tr>
<tr>
<td>Piggybacking</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: You cannot change a program when the pump is in FULL or CONTAINER Lock.

To change a program:

1. From the STOP mode, press [CHANGE] and select CHANGE PROGRAM.
2. As each message displays, make the desired changes or press [YES/ENTER] to accept the current setting.
3. Press [START] to begin delivery.

Note: A program review is not required and is available only through the Change or Options Menu.
### GemStar®

**mL/hr Only Programming Worksheet**

**GIVE:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Saline &amp;/or Volume to Be Infused</th>
<th>Nominal Infusion Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Therapy</td>
<td>mL/hr Only</td>
<td>N/A</td>
</tr>
<tr>
<td>Rate</td>
<td></td>
<td>0.1 - 1000 mL/hr</td>
</tr>
<tr>
<td>VTBI</td>
<td></td>
<td>0.1 - 9999 mL</td>
</tr>
<tr>
<td>(Volume to Be Infused)</td>
<td></td>
<td>1 - 7200 mL</td>
</tr>
</tbody>
</table>

**Piggyback Dose Amount:**

1 min or dose amount / 300 mL/hr to 24 hrs or dose amount / 0.1 mL/hr.
Chapter 9

Variable Time

Therapy Features and Specifications

This therapy allows programming of multiple doses at specified times.

- Optional KVO (Keep Vein Open) can be set during programming.
- The default bolus delivery rate is 400 mL/hr.

Tip: The Programming Worksheet at the end of this chapter lists the minimum and maximum values allowed for this protocol. Use copies of the programming worksheet to record program values before programming the pump.

Variable Time Programming Tips

The following table explains how to use the keypad during variable time programming:

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0] - [9]</td>
<td>Selects menu items and enters numeric values.</td>
<td>[ ]</td>
<td>Scrolls through program review and help messages. Toggles between AM and PM in time-based entries. The up arrow inserts a decimal point in a numeric value.</td>
</tr>
<tr>
<td>YES</td>
<td>Accepts entries or continues when done viewing a display.</td>
<td>CHANGE</td>
<td>Clears a numeric value (resets to zero) during programming.</td>
</tr>
<tr>
<td>HELP</td>
<td>Displays information during programming and alarm conditions.</td>
<td>BACK-UP</td>
<td>Returns to a previous display, exits the Options Menu, and exits the HELP mode.</td>
</tr>
</tbody>
</table>

Hospira GemStar Manual: 430-00897-002 (Rev. 10/04)
Variable Time Programming

1. Select VARIABLE TIME from the Programming Menu.
2. Select the phase type.
3. Select the unit of delivery.
4. Change the displayed time if necessary.
5. Enter the optional base rate with start and stop time.
6. If programming in Rates or Doses, go to step 7. If programming in Percentages, set the daily amount. Then go to step 8.
   Note: If programming in percentages, the total daily amount of all phases programmed must equal 100%.
7. Enter the phase information for each phase. Up to 24 phases can be programmed.
   Note: When entering time in 12-hour format, press \( \text{A.M.} \) or \( \text{P.M.} \) to toggle between A.M. and P.M.
8. Enter the optional bolus dose and its lockout.
9. Enter the optional KVO.
10. Enter the container size.
    The pump calculates the minimum container size required to deliver the phases, base rate, and KVO for one day or in a 24-hour period. If delivering the protocol for more than one day, multiply this amount by the number of days of therapy.
    Note: Increase the container size to include bolus deliveries.
11. Select the air sensitivity, if required.
9. Variable Time

12 Review the program. Press \( \text{\textbullet} \) to begin review.

13 If using the PURGE key to prime the pump set, press [PURGE] now.

**WARNING:** ALWAYS disconnect the pump set from the patient before priming or purging.

Note: With variable time programming, the pump keeps track of where it is in the program each minute of the entire 24-hour period. For example, if Phase 1 is missed, and the pump is placed in RUN mode in the middle of Phase 2, it starts delivery according to the program parameters from the middle of Phase 2.

**Variable Time Delivery Interruptions**

<table>
<thead>
<tr>
<th>If the phase is interrupted and the pump is placed in the RUN mode.</th>
<th>Then:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before the end of the phase.</td>
<td>The phase runs to its scheduled stop time.</td>
</tr>
<tr>
<td>After the end of the phase, but before the beginning of the next start time.</td>
<td>The next phase begins delivery at the scheduled start time. All applicable Base Rate or KVO delivery infuses while waiting for the start of the next phase.</td>
</tr>
<tr>
<td>In the middle of a phase and the phase start was missed because of a program interruption or a missed program start.</td>
<td>The pump immediately begins delivery of the current phase at its current time-based point.</td>
</tr>
</tbody>
</table>
**Changing a Variable Time Program**

<table>
<thead>
<tr>
<th>Can be changed at any time</th>
<th>Cannot be changed before is pressed</th>
<th>Can be changed after is pressed</th>
</tr>
</thead>
<tbody>
<tr>
<td>- KVO rate</td>
<td>- Current time</td>
<td>- Unit of measure</td>
</tr>
<tr>
<td>- Container size</td>
<td>- Dose rate</td>
<td>- Concentration</td>
</tr>
<tr>
<td>- Air sensitivity</td>
<td>- Daily amount</td>
<td>- Phase type</td>
</tr>
<tr>
<td>- Bolus</td>
<td>- Phase parameters</td>
<td></td>
</tr>
</tbody>
</table>

Note: You cannot change a program when the pump is in FULL or CONTAINER Lock.

To change a program:

1. From the STOP mode, press [CHANGE] and select CHANGE PROGRAM.
2. As each program parameter displays, make the desired changes or press [ENTER] to accept the current setting.
4. Press [START] to begin delivery.

Note: The container size cannot be made smaller than the daily total of phases, base rate, and KVO combined, or the current amount delivered, whichever is greater.
## GemStar® Variable Time Programming Worksheet

**GIVE:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Selections and Values to Be Covered</th>
<th>Programmable Ranges</th>
</tr>
</thead>
</table>
| Select Phase Type | □ Percentages  
□ Rates  
□ Doses | 0.1 - 100%  
0.1 - 400 mL/hr  
0.1 - 9600 mL |
| Unit of Measure | □ Concentration: ________ mg/mL  
□ Concentration: ________ mcg/mL  
□ mL | 0.1 - 1000 mg/mL  
1 - 1500 mcg/mL |
| Current Time | Confirm or correct current time. | 12:00 AM - 11:59 PM  
or 00:00 - 23:59 |
| Base Rate | □ No  
□ Yes Start time: __________  
Stop time: __________  
Rate: __________ | 0.1 - 400 mL/hr  
12:00 AM - 11:59 PM  
or 00:00 - 23:59 |
| Total Daily Amount for All Phases: __________ | (required only when programming in percentages)  
SEE ATTACHED WORKSHEET |

**Bolus Dose**

| Dose | 0.1 mL - 25.0 mL  
0.1 mg - 2500 mg  
1 mcg - 25000 mcg |

**Bolus Lockout**

| Duration | 5 - 999 min |

**KVO (Keep Voin Open)**

| □ No  
□ Yes  
KVO Rate: __________ | 0.0 - 5.0 mL/hr  
0.1 - 999988 mg  
1 - 9999900 mcg  
0.1 - 9999 mL |

**Air Sensitivity**

| □ On  
□ Off  
Alarms at approx. 0.5 mL of air  
2 mL Alarms at approx. 2 mL of air  
No alarm | N/A |

*Sum of all phases must equal 100% when programmed in percentages.*
9. Variable Time

<table>
<thead>
<tr>
<th></th>
<th>Start Time</th>
<th>Stop Time</th>
<th>Percentage</th>
<th>Date</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**TOTAL**

*Note: The sum of all values shall equal 100% when programmed in percentage.*
Chapter 10

Options Menu

Overview

1. Press [OPTIONS] from RUN or STOP mode.
2. Select the number key for the desired function.
3. Follow the display messages for the selected function. Refer to the appropriate description in this chapter for more information.

Note: Menu selections may vary depending on the configuration of the pump. For example, NEXT DOSE is only available when an intermittent therapy is programmed.

When the pump exits OPTIONS, the pump returns to the mode it was in when [OPTIONS] was pressed.

Tips for Using the Options Menu

The following keys are helpful when using the Options Menu:

<table>
<thead>
<tr>
<th>Keys</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1] - [8]</td>
<td>Press the corresponding number key to select a menu function.</td>
</tr>
<tr>
<td>![Button]</td>
<td>Press ![Button] to accept changes or to continue when done viewing a display.</td>
</tr>
<tr>
<td>![Button] ![Button]</td>
<td>Press the up or down arrow to scroll through long display messages or to toggle AM and PM in time-based entries.</td>
</tr>
<tr>
<td>![Button]</td>
<td>Press ![Button] to return to a previous display or to exit SETUP RUNS.</td>
</tr>
</tbody>
</table>

Tip: A menu item does not have to be on the display to be selected. For example, only items 1 through 4 are shown when the Options Menu is first displayed. To select the Print Menu without scrolling the display, press [6].

Hospira GemStar Manual 430-00097-A02 (Rev. 02/05) 97
## 13. Options Menu

<table>
<thead>
<tr>
<th>Action Taken Item from the Options Menu</th>
<th>To Do in Function</th>
<th>Commentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>REVIEW PROGRAM</td>
<td>Display the current program settings.</td>
<td>N/A</td>
</tr>
<tr>
<td>HISTORIES</td>
<td>Display the history for the latest 400 events, shift or volume totals, bolus history (if available), or current configuration settings. Clear the history. Display the Operation Text.</td>
<td>N/A</td>
</tr>
<tr>
<td>KEYPAD LOCK</td>
<td>Lock and unlock the keypad to prevent unauthorized changes to the program. The lock levels allow the clinician to restrict access to various levels of pump operation.</td>
<td>N/A</td>
</tr>
<tr>
<td>PUMP SETTINGS</td>
<td>Change the air sensor, occlusion sensor, and sound level settings.</td>
<td>N/A</td>
</tr>
<tr>
<td>SET CLOCK</td>
<td>Set the clock. The clock can be displayed in 12-hour or 24-hour format.</td>
<td>Files may be downloaded to a printer or personal computer.</td>
</tr>
<tr>
<td>PRINT</td>
<td>Print the history event log, bolus history (if available), current program settings, and speed protocols.</td>
<td>Allows up to 9 speed protocols to be saved in pump memory.</td>
</tr>
<tr>
<td>SPEED PROTOCOLS</td>
<td>Assign, review, recall, and delete the stored protocols.</td>
<td>N/A</td>
</tr>
<tr>
<td>NEXT DOSE</td>
<td>Change the start time of the next dose when an interruption has caused a missed dose in an intermittent program.</td>
<td>NEXT DOSE appears on the menu only when the pump is in an intermittent program and changing the next dose is allowed.</td>
</tr>
</tbody>
</table>
10. Options Menu

Review Program

1. Press [OPTIONS] and select REVIEW PROGRAM. The pump displays PROGRAM REVIEW.
2. Press \( \text{ } \) to begin review.
3. Press [YES/ENTER] or [BACK-UP] when done to exit OPTIONS.

Histories

1. Press [OPTIONS] and select HISTORIES.
2. Select the number key for the desired function.
3. Complete the appropriate steps for the selected function.
### Options Menu

<table>
<thead>
<tr>
<th>Selection Title from the History Menu</th>
<th>To do this function</th>
<th>Display/Message</th>
</tr>
</thead>
</table>
| **HISTORY**                          | Display history event log of the latest 400 events. | - Current date and time  
- Date and time the program was cleared, a new container was selected, or a protocol was received  
- History event log of the latest 400 events |
| **SHIFT TOTALS**                     | Display or clear shift totals. | - Time and date when shift was cleared  
- Volume infused in the shift  
- Any relevant program-specific information |
| **VOLUME TOTALS**                    | Display volume totals. | - Amount infused  
- VIBI  
- Any relevant program-specific information |
| **CONFIGURATION**                    | Display pump configuration. | - Dependent upon pump configuration |
| **CLEAR HISTORY**                    | Clear history event log and bolus history. | - CLEARING HISTORY displays for 3 to 4 seconds |
| **BOLUS HISTORY**                    | Display bolus history in hourly increments for the last 24 hours. | - Current date and time  
- Number of boluses delivered  
- Number of boluses demanded  
- Amount delivered through bolus delivery |
| **OPERATION TEST**                   | Perform user-selected Operation Test. | - Messages that guide the user through each section of the test |

**Note:** Some menu items may not be available depending on the configuration of the pump.

**Tip:** Press and HOLD ▲ or ▼ to scroll through the history displays faster.
10. Options Menu

History
To display the history event log:
1. Press [OPTIONS] and select HISTORIES.
2. Select HISTORY from the Histories Menu.
3. Press ▲ or ▼ to scroll the display.
4. Press [BACK-UP] when done to exit OPTIONS.

Shift Totals
To display the shift totals:
1. Press [OPTIONS] and select HISTORIES.
2. Select SHIFT TOTALS from the Histories Menu.
3. The shift totals display, Press ▲ or ▼ to scroll the display.

To clear the shift totals:
1. Follow the steps for displaying shift totals.
2. At the end of the shift totals, the pump displays CLEAR TOTALS? YES OR NO:
   - Press [YES/ENTER] to clear the shift totals.
   - Press [NO] to exit OPTIONS without clearing the shift totals.

Tip: Press [HELP] to display shift totals when the pump is not in PROGRAMMING mode or an alarm condition.
10. Options Menu

**Volume Totals**

To display the volume totals:

1. Press [OPTIONS] and select HISTORIES.
2. Select VOLUME TOTALS from the HISTORIES Menu.
3. Press [BACK-UP] when done to exit OPTIONS.

To clear the volume totals:

1. Follow the steps for displaying volume totals.
2. At the end of the volume totals, the pump displays CLEAR TOTALS? YES OR NO:
   - Press [YES/ENTER] to clear the volume totals.
   - Press [NO] to exit OPTIONS without clearing the volume totals.

**Configuration**

To display the pump configuration:

1. Press [OPTIONS] and select HISTORIES.
2. Select CONFIGURATION from the HISTORIES Menu.
3. Press [BACK-UP] when done to exit OPTIONS.

**Clear History**

To clear the history event log and bolus history:

1. Press [OPTIONS] and select HISTORIES.
2. Select CLEAR HISTORY from the HISTORIES Menu.
3. The pump displays CLEARING HISTORY for 3–4 seconds before exiting OPTIONS.

Tip: Press [BACK-UP] to exit OPTIONS immediately.
10. Options Menu

Bolus History

To display the bolus history:

1. Press [OPTIONS] and select HISTORIES.

2. Select BOLUS HISTORY from the Histories Menu.

3. Press [BACK-UP] when done to exit OPTIONS.

Note: Bolus History is only available if the current program has a bolus programmed, or had a bolus programmed at one time. The Bolus History is maintained in hourly increments for the latest 48 hours. The Bolus History is cleared when a new program is entered, a Speed Protocol is recalled, or the History is cleared.

Operation Test

The Operation Test checks several pump functions to ensure the GemStar Pump is working properly. Refer to Chapter 14 Operation Test on page 143 for instructions.
Keypad Lock

1. Press [OPTIONS] and select KEYPAD LOCK from the Options Menu.
2. Select the desired lock level.

The following lock levels, listed from lowest to highest restrictions, are available:

<table>
<thead>
<tr>
<th>Lock Level</th>
<th>Abbreviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Therapy Lock</td>
<td>T</td>
</tr>
<tr>
<td>Rate Change</td>
<td>R</td>
</tr>
<tr>
<td>Container Lock</td>
<td>C</td>
</tr>
<tr>
<td>Full Lock</td>
<td>F</td>
</tr>
</tbody>
</table>

The GemStar Pump allows two lock levels at the same time. Therapy Lock can be used with either Full Lock, Container Lock, or Rate Change Lock.

When two lock levels are applied, if a function is available under one lock level but not the other, the more stringent restrictions apply. The table on the following page lists the functions available for each lock level.

When the pump is locked under a particular level, a small lock symbol (g) appears next to the applied lock level as shown above. When the pump is in RUN or STOP mode, the lock symbol appears in the lower left corner of the display and the lock level abbreviation appears in the lower right corner.

Consultant refer to Chapter 11 Clinician Instructions on page 161 for detailed instructions.
### SimStar® Keypad Lock Level Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>U</th>
<th>T</th>
<th>R</th>
<th>E</th>
<th>S</th>
<th>G</th>
<th>M</th>
<th>N</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlock</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pain Therapy Keypad</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rate Change Lock</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Unlock:**

- **U (Unlock):** Enables unlocking of the keypad.

**Pain Therapy Keypad:**

- **T (Pain):** Used for managing pain therapy features.

**Rate Change Lock:**

- **R (Rate):** Adjusts the rate settings.

- **E (Encountered):** Indicates that the lock has been encountered.

- **S (Modified):** Shows that the settings have been modified.

- **G (Gr fence):** Protects against unauthorized access.

- **M (Manual):** Allows for manual adjustments.

- **N (Nurse):** Intended for nurse operations.

**Unlock** and **Rate Change Lock** are available only if the current program is Pain Management.

### Other Functions

- **Enter a New Program:**
  - Under Therapy Mode, the new program must be of the same type that was programmed when the unit was locked.

- **Assign or Deactivate Speed Program:**
  - Allows for specifying different speed programs.

- **Set Air Sensitivity, Distal Occlusion Level, Sound Level, and Clock:**
  - Adjusts various settings.

- **Clear Shift Totals:**
  - Clears accumulated totals for specific parameters.

- **Program and Deliver a Cäd and Dose (Outside of Programming Mode):**
  - For programming and delivering medications.

- **Alarm Settings:**
  - Adjusts various alarm settings.

- **Pain Therapy:**
  - Enables pain therapy features.

- **Clear Alarm:**
  - Clears active alarms.

- **Bolus Therapy:**
  - Enables bolus therapy features.
10. Options Menu

**Change Pump Settings**

1. Press [OPTIONS] and select PUMP SETTINGS.
2. Press the number key for the desired pump setting.
3. Follow the display messages. Refer to the instructions of the desired pump setting for more information.

<table>
<thead>
<tr>
<th>Select the item from the Pump Settings Menu</th>
<th>1. Define the function</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIR SENSOR</td>
<td>Change the air sensor sensitivity.</td>
<td>The pump alarms when it detects an air bubble of approximately 0.5 mL when ON, or at approximately 3 mL when OFF is selected. The air alarm does not sound if OFF is selected. The air alarm can also be set during programming if the current therapy allows it.</td>
</tr>
<tr>
<td>OCCL SENSOR</td>
<td>Change the distal occlusion sensor sensitivity.</td>
<td>Default Setting: High</td>
</tr>
<tr>
<td>SOUNI LEVEL</td>
<td>Adjust the audible alarm level.</td>
<td>Default Setting: Minimum</td>
</tr>
</tbody>
</table>

*Note: The current setting flashes on the display.*
10. Options Menu

Air Sensitivity

**WARNING:** To reduce the risk of infusing air, use an air-eliminating filter when the air sensitivity is set to OFF.

1. Press [OPTIONS] and select AIR SENSITIVITY. The current air sensitivity flashes on the display.

2. Select the desired Air Sensitivity level.

   - Note: If OFF is selected, the pump displays:
     
     AIR ELIMINATING FILTER IS RECOMMENDED.
     ENTER TO CONFIRM

   - You must press [YES/ENTER] to confirm.

3. After selecting the desired Air Sensitivity, the pump displays: CHANGE AIR ALARM FROM XXXX TO XXXX:
   - Press [NO] to keep the current air sensitivity. The current air alarm status displays and the pump exits OPTIONS.
   - Press [YES/ENTER] to accept the new setting. The new air alarm status displays and the pump exits OPTIONS.

Occlusion Sensor

1. Press [OPTIONS] and select PUMP SETTINGS.

2. Select DISTAL OCCLUSION from the Pump Settings Menu.

3. Select the desired setting.

4. The pump displays MAKE XXXXX DEFAULT?
   - Press [NO] to temporarily change the distal occlusion setting. The new setting will be in effect until a new program is entered or the pump has been off for more than 24 hours.
   - Press [YES/ENTER] to permanently change the distal occlusion setting. The new setting will remain in effect until the setting is changed again through the Options Menu.
10. Options Menu

Sound Level

1. Press [OPTIONS] and select PUMP SETTINGS.
2. Select SOUND LEVEL from the Pump Settings Menu.
3. When the pump displays the Sound Level function, it sounds intermittent beeps at the current sound level. The blocks on the top line of the display indicate the current sound level.
   - Press (++) to increase the sound level.
   - Press (--) to decrease the sound level.
   - Press [CHANGE] to restore the sound level to the default setting.

Set Clock

1. Press [OPTIONS] and select SET CLOCK.
2. Select 12-hour or 24-hour format (24-hour format is shown in example).
3. Use the arrow keys to set the weekday and month.
4. Use the number keys to enter the current day, year, and time.

Note: When entering the time in 12-hour format, press (+) or (-) to toggle between AM and PM.
5. Press [YES/ENTER] to confirm.

Tip: To view the clock from the RUN or STOP mode, press [YES/ENTER], then immediately press and HOLD [1]. The clock displays until [1] is released.
**10. Options Menu**

**Print**

**WARNING:** Ensure a cassette is installed in the pump before connecting to a printer or computer.

If the pump is connected to a patient: BEFORE connecting the pump to a computer or printer, press [STOP], close the slide clamp, and eject the cassette. Leave the pump set connected to the patient. Install another cassette in the pump before connecting to a printer or computer.

*Note: Ensure the printer is connected to the pump BEFORE selecting a print function. Refer to Connecting to the Seiko Printer on page 115 for more information.*

1. Press [OPTIONS] and select PRINT.
2. Press the number key for the desired print function.
3. When printing is complete, the pump exits OPTIONS.

<table>
<thead>
<tr>
<th>Select this item from the Print Menu</th>
<th>To do this function:</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRINT HISTORY</td>
<td>Print the current program, shift and volume totals, and history event log.</td>
</tr>
<tr>
<td>PRINT PROGRAM</td>
<td>Print the current program.</td>
</tr>
<tr>
<td>PRINT PROTOCOL</td>
<td>Print a specified speed protocol or a complete list of all speed protocols.</td>
</tr>
<tr>
<td>PRINT BOLUS Hx</td>
<td>Print the current program, shift and volume totals, and the bolus history (Hx) for the latest 48 hours.</td>
</tr>
<tr>
<td>STOP PRINT</td>
<td>Cancel printing. This function is only available if the pump is printing.</td>
</tr>
</tbody>
</table>

Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
10. Options Menu

**Speed Protocol**

1. Press [OPTIONS] and select **Speed Protocol**.
2. Press the number key for the desired protocol function.
3. Follow the display messages. Refer to the instructions for Speed Protocol functions for more information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>REVIEW PROGRAM</td>
</tr>
<tr>
<td>2</td>
<td>HISTORIES</td>
</tr>
<tr>
<td>3</td>
<td>RESTART LOCK</td>
</tr>
<tr>
<td>4</td>
<td>PUMP SETTINGS</td>
</tr>
<tr>
<td>5</td>
<td>SET CLOCK</td>
</tr>
<tr>
<td>6</td>
<td>PRINT</td>
</tr>
<tr>
<td>7</td>
<td>NEXT DOSE</td>
</tr>
</tbody>
</table>

**Assign**

1. Press [OPTIONS] and select **Speed Protocol**.
2. Select **ASSIGN** from the Speed Protocol menu.
3. Select [1]-[9] to assign to the new protocol.

If the selected speed protocol is already assigned, the pump displays REPLACE PROTOCOL ASSIGNMENT.

- Press [YES/ENTER] to replace the protocol. The pump displays the new speed protocol and exits OPTIONS.
- Press [NO] to keep the existing protocol and exit OPTIONS.
Review/Recall

1. Press [OPTIONS] and select SPEED PROTOCOL.
2. Select REVIEW/RECALL from the Speed Protocol menu.
3. Select the desired protocol to review/recall.
5. Press [YES/ENTER]:
   - If in the RUN mode, the pump exits OPTIONS.

Delete

1. Press [OPTIONS] and select SPEED PROTOCOL.
2. Select DELETE from the Speed Protocol Menu.
3. Select the desired protocol to delete.
4. Press [YES/ENTER] to confirm deletion or [NO] to exit OPTIONS without deleting.

Next Dose

This function is only available when the current therapy is Intermittent and the pump is not delivering a dose.

To set the time for the next dose:
1. Press [OPTIONS] and select NEXT DOSE.
2. Use the number keys to enter the start time for the next dose. Press [YES/ENTER] to accept the change and exit OPTIONS.

Tip: When entering the time in 12-hour format, press [A] or [B] to toggle between AM and PM.
10. Options Menu

Connecting to the Data Port

Use the Data Port to connect the GemStar Pump to a Seiko® DPU 414 or compatible serial printer to print the Operation Test results or the files available from the Print Menu. Using communication software included with most computer operating systems (or available from local sources), these files can also be transferred to a computer.

**WARNING:** Ensure a cassette is installed in the pump before connecting to a printer or computer.

If the pump is connected to a patient: BEFORE connecting the pump to a computer or printer, press [STOP], close the slide clamp, and eject the cassette. Leave the pump set connected to the patient. Install another cassette in the pump before connecting to a printer or computer.

---

**Equipment Needed**

<table>
<thead>
<tr>
<th>Equipment</th>
<th>Connection Port</th>
<th>Operation Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>GemStar Pump</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hospital Serial Printer Cable List</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Seiko DPU 414 or Compatible Serial Printer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Serial DB9 Female-to-Female Gender Changer*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Null Modem*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computer*</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Available from local sources.
10. Options Menu

Configuration Settings
Refer to the printer or computer documentation for information on configuration settings. Configure the printer or computer as follows to use the Data Port:

- Baud Rate = 2400
- Data Bits = 8
- Stop Bits = 1
- Parity = None
- Carriage Return (Line Feed) = CR+LF
- Flow Control = None

Note: When using the Seiko DPU 414 printer, the switch settings MUST be configured to work with the GemStar Pump.

To configure the switch settings on the Seiko DPU 414:
1. Press and hold the ONLINE button while sliding the POWER switch to ON.
2. When the list of the current settings start printing, release the ONLINE button.
3. Set the switches according to the following table.
   - Press the ONLINE button to continue setting switches.
   - Press ONLINE to set switch ON.
   - Press FEED to set switch OFF.
4. Continue setting switches until “Dip SW setting complete!!” is printed.
### Switches and Functions

<table>
<thead>
<tr>
<th>Switch</th>
<th>Function</th>
<th>Setting</th>
<th>Button to Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>SW1-1</td>
<td>Input Method: Serial</td>
<td>Off</td>
<td>FEED</td>
</tr>
<tr>
<td>SW1-2</td>
<td>Printing Speed: High</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW1-3</td>
<td>Auto Linefeed: On</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW1-4</td>
<td>Ctrl Function: Ctrl and LF</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW1-5</td>
<td>DIP SW setting command:</td>
<td>Enabled</td>
<td>On</td>
</tr>
<tr>
<td>SW1-6</td>
<td>Printing density: 100%</td>
<td>Off</td>
<td>FEED</td>
</tr>
<tr>
<td>SW1-7</td>
<td>Printing density: 100%</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW1-8</td>
<td>Print Mode: 40 columns</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW2-2</td>
<td>User defined char: On</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW2-3</td>
<td>Ordinary Characters: On</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW2-4</td>
<td>Zero Form: No slash</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW2-5</td>
<td>Character Set: American</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW2-6</td>
<td>Character Set: American</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW2-7</td>
<td>Character Set: American</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW2-8</td>
<td>Character Set: American</td>
<td>Off</td>
<td>FEED</td>
</tr>
<tr>
<td>SW3-1</td>
<td>Data bit length: 8 bits</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW3-2</td>
<td>Parity: No parity</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW3-3</td>
<td>Parity condition: Odd</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW3-4</td>
<td>Flow control: HPS busy</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW3-5</td>
<td>Baud rate: 2400 bps</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW3-6</td>
<td>Baud rate: 2400 bps</td>
<td>Off</td>
<td>FEED</td>
</tr>
<tr>
<td>SW3-7</td>
<td>Baud rate: 2400 bps</td>
<td>Off</td>
<td>FEED</td>
</tr>
<tr>
<td>SW3-8</td>
<td>Baud rate: 2400 bps</td>
<td>On</td>
<td>ONLINE</td>
</tr>
</tbody>
</table>
10. Options Menu

Connecting to the Seiko Printer

**WARNING:** Ensure a cassette is installed in the pump before connecting to a printer or computer.

If the pump is connected to a patient: BEFORE connecting the pump to a computer or printer, press [STOP], close the slide clamp, and eject the cassette. Leave the pump set connected to the patient. Install another cassette in the pump before connecting to a printer or computer.

**CAUTION:** Do not connect the GemStar AC Mains Adaptor to a printer.

*Note: For maximum battery life, operate the pump on AC mains when connected to a printer or computer.*

1. Install a cassette into the pump.
2. Connect the GemStar serial cable to the printer and to the data port on the bottom of the pump.
3. Ensure the printer is ONLINE and ready to receive data. Refer to printer documentation for more information.
4. Ensure paper is loaded in the printer.
5. Select the desired print function from the pump menu.
Connecting to a Computer

WARNING: Ensure a cassette is installed in the pump before connecting to a printer or computer.

If the pump is connected to a patient: BEFORE connecting the pump to a computer or printer, press [STOP], close the slide clamp, and eject the cassette. Leave the pump set connected to the patient. Install another cassette in the pump before connecting to a computer or printer.

Note: For maximum battery life, operate the pump on AC mains when connected to a printer or computer.

1. Install a cassette into the pump.
2. Connect the GemStar serial cable to the null modem.
3. Connect the null modem to the serial gender changer.
4. Connect the serial gender changer to the serial port of the computer.
5. Connect the GemStar serial cable to the data port on the bottom of the pump.
6. Configure the communication software on the computer. Refer to Configuration Settings on page 113.

Tip: After the data transfer is complete, use any text editor to view or print the file.
Transferring Data Using a Computer

The GemStar Pump can be connected to a Windows®-compatible computer. The following instructions apply to computers using Microsoft® Windows® 95, Windows® 98, or Windows NT® 4.0 or higher.
13. Options Menu

Creating a New Connection

Note: The following procedure is only needed to create a "New Connection" the first time the pump is connected to the computer.

To create a new connection:
1. Follow steps 1-4 in Using an Existing Connection on the following page.
2. If a message appears asking if a modem is necessary for a connection, click NO.
3. Enter a name for the new connection (e.g., GemStar Print Files) and choose an icon.
4. Click OK.
5. From the Connect drop-down menu, select the appropriate COM port.
6. Click OK.
7. Verify that the following settings are correct:
   - Baud Rate = 2400
   - Data Bits = 8
   - Stop Bits = 1
   - Parity = None
   - Flow Control = None
8. Click OK.
9. Select the Properties icon.
10. Select the Sendings tab.
11. Select the ASCII setup button.
12. Ensure "Append line feeds to incoming line ends" is checked.
13. Click OK in the ASCII setup window.
14. Click OK in the Properties window.
15. From the menu, select File > Save.
16. Exit HyperTerminal.
Using an Existing Connection

To transfer data from the GemStar Pump to a computer:
1. From the Windows® desktop, select the Start Menu.
2. Select Programs.
3. Select Accessories.
4. Select HyperTerminal.
5. Double click on the icon with the name entered in step 3, Creating a New Connection.
6. From the menu, select Call > Connect.
7. From the menu, select Transfer > Capture Text.
8. Type the path and file name where the printout should be saved.
   Ensure the file extension is "txt".
   The default path is: c:\windows\accessories\hyperterminal.
   
   Note: If the file name already exists, the new printout will be added to the end of
   the existing file. For example, use a patient's name or id number as the file name.
   Then select that file for all of that patient's printouts.
9. Click Start.
10. Select the desired print function from the pump. Refer to the table of printing
    functions on page 109.
11. Wait for the transmission to complete.
12. From the menu, select Transfer > Capture Text > Stop.
13. Exit HyperTerminal.
14. Use any text editor to view or print the file.
Chapter 11

Clinician Instructions

The instructions in this section apply to special features available to clinicians. Remove this section from the manual to prevent unauthorized access to these features.

The GemStar pump provides quick access to commonly used functions. Instead of accessing these functions by navigating through the menu system, you can enter the key combinations shown in this table:

<table>
<thead>
<tr>
<th>Function</th>
<th>Quick Access Key Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlock Keypad</td>
<td>Place the pump in STOP mode and then enter the lock sequence to unlock a Full Container or Relock. You cannot use quick access keys to unlock a Therapy Lock.</td>
</tr>
<tr>
<td>Display Shift Totals</td>
<td>Place the pump in STOP mode and then press [HELP] to display Shift Totals.</td>
</tr>
<tr>
<td>Display Clock</td>
<td>Place the pump in STOP mode, press [YES], and then press and hold [1]. The clock displays until you release [1].</td>
</tr>
<tr>
<td>Program a Loading Dose</td>
<td>From the Pain Management STOP MODE, press [YES/ENTER], and then press [6] to program a Loading Dose.</td>
</tr>
</tbody>
</table>
11. Clinician Instructions

Clinician Locking Sequence Instructions

Locking the Pump

To lock the pump from the RUN or STOP mode:

1. Press [OPTIONS] to display the Options Menu.
2. Select [KEEPER LOCK] from the Options Menu.
   
   Note: If a lock level is already applied to the pump, the Lock Sequence Number must be entered before a second lock level can be applied. Refer to Adding a Second Lock Level on page 123 for more information.
3. Select the desired lock level. For THERAPY, CONTAINER and FULL Lock, go to step 5.
4. For RATE CHANGE Lock, set the minimum and maximum programmable ranges for the continuous delivery rate and bonus dose in a Pain Management program.

   Tip: Press [O] to toggle between the MIN and MAX values.
   - MIN flashes on the display. Enter the minimum value.
   - MAX flashes on the display. Enter the maximum value.
5. Press [YES/ENTER] when done
6. Repeat steps 4 and 5 for a bonus dose if available in the current program.
7. Enter the lock sequence number. Asterisks display as the numbers are entered.
   - For THERAPY Lock, enter [0][6][6][1][6]
   - For UNLOCKED, FULL, CONTAINER, and RATE CHANGE lock levels, enter [1][6][6][0][9][6]

   Note: Default lock sequence numbers are shown.
11. Clinician Instructions

**Adding a Second Lock Level**

1. Press [OPTIONS] to display the Options Menu.
2. Select KEYPAD LOCK from the Options Menu.
3. Enter the Lock Sequence Number.
4. For RATE CHANGE Lock, set the minimum and maximum programmable ranges for the continuous delivery rate and bolus dose in a Pain Management program.

   **Tip:** Press 
   - MIN flashes on the display. Enter the minimum value.
   - MAX flashes on the display. Enter the maximum value.
6. Repeat steps 4 and 5 for a bolus dose if available in the current program.

   **Note:** When two lock levels are applied, if a function is available under one lock level but not the other, the more stringent restrictions apply.

7. Enter the lock sequence number. Asterisks display as the numbers are entered.
   - For THERAPY Lock, enter [0][0][9][3][1].
   - For UNLOCKED, FULL, CONTAINER, and RATE CHANGE lock levels, enter [1][3][0][0][0].

   **Note:** Default lock sequence numbers are shown.
41. Clinician Instructions

Unlock the Pump

1. Press [OPTIONS] to display the Options Menu.
2. Select KEYPAD LOCK from the Options Menu.
3. Select the lock level to be unlocked.
4. Enter the lock sequence number for that level.

Note: If the pump is locked under two levels, each level must be unlocked separately. Unlocking one level has no effect on the other level. For example, if both THERAPY and RATE CHANGE lock levels are applied, the clinician must unlock both the RATE CHANGE and THERAPY levels.

5. The pump displays the current lock level. Press [YES/ENTER] to return to the mode the pump was in when [OPTIONS] was pressed.

Program and Deliver a Clinician Activated Loading Dose

This feature is available only when the keypad is UNLOCKED or when THERAPY is the only lock level. The default loading dose rate is 1.25 ml/hr.

1. From the stop mode, press [YES/ENTER] [9].
2. The pump displays: PROGRAM A LOADING DOSE?
   Press [YES/ENTER].
3. Enter the loading dose. Press [YES/ENTER].
4. The pump displays: DELIVER THE LOADING DOSE NOW?
   To deliver the loading dose immediately, press [YES/ENTER].
   Primary infusion DOES NOT begin automatically when the clinician activated loading dose is complete. Press [START] to continue primary infusion.

   To deliver the loading dose later, press [NO].
   The pump returns to the stop mode. The next time [START] is pressed, the pump again displays: DELIVER LOADING DOSE NOW?
   • Press [YES/ENTER] to deliver the loading dose. Primary infusion continues automatically when the loading dose is complete.
   • Press [NO] to cancel the loading dose and continue primary infusion.
11. Clinician Instructions

Shift Totals and History

Shift Totals:

1. Press [OPTIONS] and select HISTORIES.
2. Select SHIFT TOTALS from the Histories Menu.
3. The shift totals display. Press ▲ and ◀ to scroll the display. When done, the pump displays CLEAR TOTALS? YES OR NO.
   - Press [YES/ENTER] to clear the shift totals.
   - Press [NO] to exit OPTIONS without clearing the shift totals.

Tip: Press [HELP] to display shift totals when the pump is not in PROGRAMMING mode or an alarm condition.

Clear History Event Log and Bolus History

1. Press [OPTIONS] and select HISTORIES.
2. Select CLEAR HISTORY.
3. CLEARING HISTORY displays and the pump exits OPTIONS.
Chapter 12

Troubleshooting

This section contains information on audible and visual alarms that may occur with the GemStar Pump.

CAUTION: If the pump does not perform as stated in this manual, stop using it IMMEDIATELY.

For consultation and technical support contact either an authorized Hospira representative or the Hospira Technical Support Operations hotline (available 24 hours a day).

To return the pump for service, first contact Hospira Customer Support between 7:00 AM and 4:00 PM Pacific time. Have the pump serial number available.

In the USA

Hospira Technical Support Operations
1-800-241-4002

Hospira, Inc.
Technical Support Operations
755 Jarvis Drive
Morgan Hill, CA 95037

Outside the USA:

Contact your local Hospira sales office.

Tip: Press [HELP] for additional information during programming and alarm conditions.
## 12. Troubleshooting

### Alarm Messages

<table>
<thead>
<tr>
<th>Alarm Display Message</th>
<th>Y/N</th>
<th>A/V</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIR IN LINE</td>
<td></td>
<td>A/N</td>
<td>1. Press [SILENCE] to quiet the alarm for 1 minute.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Press [STOP] to clear the alarm.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Disconnect the patient from the pump set.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. Press and hold [PURGE]. Note: Purge rate is 250 mL/hr. The pump purges for up to 2 minutes each time you press and hold [PURGE]. Purge volume may be limited in a Pain Management program.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5. Reconnect the pump set to the patient-access device.</td>
</tr>
</tbody>
</table>

| CHARGE BATTERIES      |     | A/V | 1. Replace both disposable batteries with fresh AA batteries and press [GO] to restart the pump. OR connect the pump to the AC mains adapter and the pump will automatically restart. Replace both batteries as soon as possible. |
|                       |     |     | 2. After power-on, reseed the current program. Refer to Accessing the Programming Menu in Chapter 2 Basic Operation for more information. |
## 12. Troubleshooting

<table>
<thead>
<tr>
<th>Alarm Condition Message</th>
<th>is the pump infusion?</th>
<th>Alarm Condition</th>
<th>Cause of Alarm</th>
<th>Repair</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y = Yes</td>
<td></td>
<td>A = Audible alarm</td>
<td>V = Visual alarm</td>
<td></td>
</tr>
<tr>
<td>N = No</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### CHECK CASSETTE-X

| N | A/V | The cassette is improperly installed or not installed. | 1 Press [SILENCE] to quiet the alarm for 1 minute. |
|   |     | X indicates where to look for the cause of the alarm:  | 2 Press [STOP] to place the pump in the STOP mode. |
|   |     | A = Air Sensor                                           | 3 Reinstall the cassette. |
|   |     | D = Distal                                               | **CAUTION:** Ensure all four cassette latches are clearly visible after the cassette is installed. |
|   |     | P = Proximal                                             |

**Note:** Ensure the tubing is behind the tubing guide (at the distal end). Refer to Loading the Cassette on page 32.

### CALL 1.800.XXX.XXXX CODE: RN/MM/TIT

| N | A/V | The pump has detected a condition that may require service. |
|   |     | 1 Write down the telephone number and code. |
|   |     | 2 Power-off the pump. If the pump does not power-off, disconnect external power and remove the batteries. |
|   |     | 3 Call the telephone number shown on the display message. |

Hospira GemStar Manual 430-00897-002 (Rev. 10/04) 129
# 42. Troubleshooting

<table>
<thead>
<tr>
<th>Alarm Condition</th>
<th>Action</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DILUTION</strong></td>
<td>Y = Yes</td>
<td><strong>1.</strong> Press [SILENCE] to quiet the alarm for 1 minute.</td>
</tr>
<tr>
<td><strong>OCCLUSION</strong></td>
<td>N = No</td>
<td><strong>2.</strong> Press [STOP] to place the pump in the auto mode.</td>
</tr>
<tr>
<td><strong>N = No</strong></td>
<td><strong>3.</strong> Check for sources of distal occlusion:</td>
<td></td>
</tr>
<tr>
<td><strong>N = No</strong></td>
<td></td>
<td>- Misplaced tubing below the pump</td>
</tr>
<tr>
<td><strong>N = No</strong></td>
<td></td>
<td>- Clogged patient access device</td>
</tr>
<tr>
<td><strong>N = No</strong></td>
<td></td>
<td>- Clogged I.V. filter</td>
</tr>
<tr>
<td><strong>N = No</strong></td>
<td></td>
<td>- Other obstructions</td>
</tr>
<tr>
<td><strong>N = No</strong></td>
<td></td>
<td>If the problem continues, remove and reinstall the cassette.</td>
</tr>
<tr>
<td><strong>N = No</strong></td>
<td></td>
<td><strong>CAUTION:</strong> Ensure all four cassette latches are clearly visible after they are installed.</td>
</tr>
<tr>
<td><strong>N = No</strong></td>
<td></td>
<td>Note: Ensure the tubing is sealed at the tubing guide (at the distal end). Refer to Loading the Cassette on page 22.</td>
</tr>
<tr>
<td><strong>N = No</strong></td>
<td></td>
<td><strong>5.</strong> Press [START] to begin inflow.</td>
</tr>
</tbody>
</table>

1. The pump has detected sustained distal pressure over the user-selected limit.
2. To avoid a bolus infusion after an occlusion, complete the following steps:
   1. Press [STOP].
   2. Close the distal clamp.
   3. Press the cassette release button to remove the cassette from the pump.
   4. Open the flow stop.
   5. Wait 10 seconds.
   6. Close the flow stop.
   7. Load the cassette into the pump.
   8. Open the distal clamp.
   9. Review the program.
10. Press [START] to start the pump.
### 12. Troubleshooting

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>N = No</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. Press [STOP] to place the pump in the STOP mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Connect the pump to AC mains adapter, rechargeable battery pack, or replace both disposable batteries with fresh AA batteries.</td>
</tr>
</tbody>
</table>

*Note: The pump allows the user to clear the LOW BATTERIES alarm. If the condition has not been corrected after 15 minutes, the alarm continues.*

*If an external power source is used, the rate is changed, or the pump is powered-on after a LOW BATTERIES alarm and those same batteries are still in the pump, this interval may be different.*

* *
## Troubleshooting

<table>
<thead>
<tr>
<th>Fault</th>
<th>Yes</th>
<th>No</th>
<th>Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>POWER LOSS</td>
<td>M</td>
<td>A/V</td>
<td>1. Connect the pump to AC mains adapter, replace the battery pack, OR replace both disposable batteries with fresh AA batteries.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Power on the pump. Review the program if required.</td>
</tr>
</tbody>
</table>

**Legend:**
- Y = Yes
- N = No
- A = Audio alarm
- V = Visual alarm

The pump has detected a power failure due to one of the following:
- Batteries have been removed while the pump was on battery source.
- External power has failed or has been disconnected and no batteries are installed.
- Pump has been powered on with insufficient power source.
## 12. Troubleshooting

<table>
<thead>
<tr>
<th>Condition</th>
<th>Is the Pump Running?</th>
<th>Alarm Type</th>
<th>Cause/Condition</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>A = Audible alarm</td>
<td></td>
<td></td>
<td>1. Press [SILENCE] to quiet the alarm for 1 minute.</td>
<td></td>
</tr>
<tr>
<td>V = Visual alarm</td>
<td></td>
<td></td>
<td>2. Press [STOP] to place the pump in the stop mode.</td>
<td></td>
</tr>
<tr>
<td>PROX OCCLUSION N V A/V</td>
<td></td>
<td></td>
<td>3. WARNING: When a Proximal Occlusion alarm activates, DO NOT power-off the pump.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. Check for sources of proximal occlusion:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Kinked tubing above pump</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Blockage in the container and in the spike</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Closed clamps above pump</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Empty container</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- High torque syringes</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Other obstructions</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5. Press [START] to begin infusion.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>6. If the problem continues, power-off the pump, install a new primed set and begin infusion.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CAUTION: Ensure all four cassette latches are clearly visible after the cassette is installed.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Ensure the tubing is behind the tubing guides (at the distal end). Refer to Loading the Cassette on page 32.
## 12. Troubleshooting

### Using Batteries

<table>
<thead>
<tr>
<th>Message</th>
<th>Audible Alarm</th>
<th>Visual Alarm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y = Yes</td>
<td>A = Yes</td>
<td>V = Yes</td>
</tr>
<tr>
<td>N = No</td>
<td>A = No</td>
<td>V = No</td>
</tr>
</tbody>
</table>

**Using Batteries**

<table>
<thead>
<tr>
<th><strong>Y</strong></th>
<th><strong>V</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>This is a normal response when:</strong></td>
<td></td>
</tr>
</tbody>
</table>

- The pump has been powered on with only disposable batteries as a power source, or
- The pump has switched to internal power (disposable batteries) due to a loss of external power or a reduction in external power below acceptable levels.

When powering on the pump:
- Press [YES/ENTER] to confirm disposable batteries are the only power source.

When switching from AC mains power:
- Press [SILENCE] to clear the alarm.

### Using Bat Batt

<table>
<thead>
<tr>
<th><strong>Y</strong></th>
<th><strong>V</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>This is a normal response when:</strong></td>
<td></td>
</tr>
</tbody>
</table>

- The pump has been powered on with external batteries as a power source, or
- The pump has switched to external battery power due to a loss of AC mains power, or
- The pump has switched to external battery power while running on internal batteries.

When powering on the pump:
- Press [YES/ENTER] to confirm external battery power source.

When switching from AC mains power:
- Press [SILENCE] to clear the alarm.
## Alert Messages

<table>
<thead>
<tr>
<th>Alert Display Message</th>
<th>Is the pump infusing?</th>
<th>Alarm</th>
<th>Cause of Alarm</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ALMOST EMPTY</strong></td>
<td>Y</td>
<td>A/V</td>
<td>Delivery will complete in 30 minutes or less. For bolus only program, delivery will complete during the next bolus delivery.</td>
<td>Press [SILENCE] to quiet the alarm for 10 minutes. Note: This alarm is available only with Pain Management protocols.</td>
</tr>
<tr>
<td><strong>CHECK PRINTER</strong></td>
<td>Y</td>
<td>A/V</td>
<td>- The printer has not responded to commands from the pump. - The printer is not properly connected to the pump.</td>
<td>1. Press [SILENCE] to quiet the alarm for 2 minutes. 2. Ensure the printer is properly connected to the pump by checking the following:  - Printer is powered on and in ONLINE mode  - Cable is plugged in to both the pump and the printer.  - Cable part number and printer settings are correct. 3. If the problem continues, select <strong>STOP PRINT</strong> from the Print Menu to cancel all print jobs.</td>
</tr>
</tbody>
</table>
### 12. Troubleshooting

<table>
<thead>
<tr>
<th>Alarm Display Message</th>
<th>Possible Causes</th>
<th>Possible Solutions</th>
</tr>
</thead>
</table>

**Y** = Yes  
**N** = No  
**A** = Audible alarm  
**V** = Visual alarm

#### Empty Container

<table>
<thead>
<tr>
<th>N</th>
<th>ANV</th>
<th>1</th>
<th>2</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>The pump has delivered the programmed container size or the pump has delivered the programmed VTPH and AN in KVO is delivering (if available in current program).</td>
<td>Press [SILENCE] to quiet the alarm for 2 minutes.</td>
<td>Press [STOP] to place the pump in the STOP mode and clear the alarm.</td>
<td>Use the NEW CONTAINER function to reset the current program. Refer to Adding a New Container in Chapter 2 Basic Operation.</td>
</tr>
</tbody>
</table>

#### End of Infusion

<table>
<thead>
<tr>
<th>ANV</th>
<th>1</th>
<th>2</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>The pump has delivered the entire programmed protocol.</td>
<td>If no KVO is selected:</td>
<td>1</td>
<td>Press [SILENCE] to quiet the alarm for 2 minutes.</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Press [STOP] to place the pump in the STOP mode and clear the alarm.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3</td>
<td>If KVO is selected:</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>The pump sounds 3 beeps approximately every 15 minutes.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Press [STOP] to place the pump in STOP mode and clear the alarm.</td>
<td></td>
</tr>
</tbody>
</table>
### 12. Troubleshooting

<table>
<thead>
<tr>
<th>Alert Display Description</th>
<th>Alert Condition</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y = Yes</td>
<td>A = Audible alarm</td>
<td></td>
</tr>
<tr>
<td>FLASING DISPLAY</td>
<td>N = No</td>
<td></td>
</tr>
<tr>
<td>Line four of the display flashes.</td>
<td>N</td>
<td>A/V</td>
</tr>
<tr>
<td>NO INTERNAL BATT</td>
<td>N = A/V</td>
<td></td>
</tr>
<tr>
<td>NO POWER LOSS</td>
<td>N = No</td>
<td></td>
</tr>
<tr>
<td>ALARM AVAILABLE</td>
<td>N = Yes</td>
<td></td>
</tr>
<tr>
<td>ENTER TO CONFIRM</td>
<td>N = No</td>
<td></td>
</tr>
<tr>
<td>PROGRAMMING INCOMPLETE</td>
<td>N = Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>N = A/V</td>
<td></td>
</tr>
<tr>
<td>Programming has not been completed and no keys have been pressed within three minutes. 1 Press [YES/ENTER] to confirm. 2 Power-off the pump and install two fresh disposable AA batteries as a backup power source.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>START</td>
<td>N = Yes</td>
<td></td>
</tr>
<tr>
<td>START flashes on the display. Other parts of the display are not affected.</td>
<td>N = A/V</td>
<td></td>
</tr>
<tr>
<td>A Stop Mode Callback has occurred because the programmed pump has remained in the STOP mode for more than three minutes. 1 Press [SILENCE] to quiet the alarm for 3 minutes. 2 Follow the instructions on the display to clear the alarm.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## 12. Troubleshooting

### Other Display Messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Display Condition</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>KEYPAD LOCKED</td>
<td>User has attempted to perform a function that has been locked out.</td>
<td>Unlock the keypad to access the desired function.</td>
</tr>
<tr>
<td>NOT ALLOWED DURING INFUSION PRESS STOP TO HALT DELIVERY</td>
<td>User has attempted to perform a function that is not available in RUN mode.</td>
<td>Press [STOP] to access the desired function. Press [YES/ENTER] to return to the RUN mode display.</td>
</tr>
<tr>
<td>ROUNDED * The pump has rounded a number that was entered during programming.</td>
<td>Press [YES/ENTER] to accept the rounded value and continue to the next step.</td>
<td></td>
</tr>
</tbody>
</table>
| IN PROGRESS NEW CONTAINER NOT ALLOWED | User has attempted to access NEW CONTAINER function when it is not allowed. | 1. Press [STOP].
2. Increase the container size to complete the dose.
3. Set NEW CONTAINER through the Change Menu. |
| INFUSED XX.X ML NO START DELAY PRESS START TO INFUSE | The pump has not delivered any doses and there is no start delay. | Press [START] to infuse dose. |
| CHANGE CHARGE CLOCK MULTI TIME DELIVERY IS IN PROGRESS | User has attempted to change the clock during a time-based delivery. | 1. Press [STOP].
2. Clear the program through the Change Menu.
3. Change the clock through the Options Menu.
4. Reprogram the pump. |
| PROGRAM EXCEEDS MAX CONTAINER SIZE CHANGE PROGRAM VALUES | The VTH + KVO volume resulted in a container size greater than the allowed value. | 1. Press [HELP] to display the allowed values.
2. Change the program values. |
| THIS OPTION NOT AVAILABLE WHILE PROGRAMMING THE PUMP | User has attempted to access a function that is not available from the first programming display. | 1. Press [YES/ENTER] to return to the first programming display.
2. Complete programming.
3. Access desired function. |
Chapter 13

Maintenance

Pump Storage

Store the GemStar Pump in a cool, dry place. Remove the disposable batteries and
the battery pack before storing the pump.

Program and event history are protected in the software memory for at least one year
when power is removed from the pump.

Cleaning and Disinfecting

Establish a routine schedule for cleaning the pump to keep the case exterior, cassette
pocket, and tubing channel free of contamination.

CAUTION: To avoid mechanical or electronic damage, do not immerse pump in
any fluids or cleaning solutions.

Some cleaning and sanitizing compounds may slowly degrade
components made from some plastic materials. Do not use
compounds containing combinations of isopropyl alcohol and
dimethyl benzyl ammonium chloride.

Do not sterilize by heat, steam, ETO, or radiation. Apply
disinfectants to the outside surface of the pump only. Do not use
abrasive cleaners or materials on the pump. Using abrasive
cleaners or cleaning solutions not recommended by Hospira may
result in product damage.

To avoid pump damage, cleaning solutions should be used only as
directed in the table on the following page. The disinfecting
properties of cleaning solutions vary; consult the manufacturer for
specific information.

Never use sharp objects (such as pens, pencils, fingernails, paper
clips, needles, etc.) to clean the pump.
Recommended Cleaning Solutions

The pump is not adversely affected by the recommended cleaning solutions in the table below:

<table>
<thead>
<tr>
<th>Cleaning Solution</th>
<th>Manufacturer</th>
<th>Preparation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Super Edisonite®</td>
<td>S. W. Edison Chemical Co.</td>
<td>Per manufacturer's recommendation</td>
</tr>
<tr>
<td>Vasprin®</td>
<td>Calyx Vessel Laboratories</td>
<td>Per manufacturer's recommendation</td>
</tr>
<tr>
<td>Meno-Plenz®</td>
<td>Calyx Vessel Laboratories</td>
<td>Per manufacturer's recommendation</td>
</tr>
<tr>
<td>Formula C™</td>
<td>Diversey Corp.</td>
<td>Per manufacturer's recommendation</td>
</tr>
<tr>
<td>Household bleach</td>
<td>Various</td>
<td>Per household facility procedures; DO NOT exceed one part bleach in ten parts water</td>
</tr>
<tr>
<td>(5.25% sodium hypochlorite)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: NOT all cleaning solutions are disinfectants. Check product labeling.

Cleaning the Pump Case

1. Power-off the pump.
2. Disconnect the pump from AC mains power.
3. Clean the exposed surfaces of the pump with a soft, lint-free cloth dampened with the appropriate cleaning solution.
4. Wipe the solution from the pump surface with a water-moistened, lint-free cloth.
5. Use a dry, lint-free cloth to dry the pump after cleaning.
13. Maintenance

Cleaning the Cassette Pocket and Tubing Channel

The area containing the ultrasonic sensors, located in the cassette pocket, should be cleaned on a regular basis.

CAUTION: Use care not to damage the silicone seals around the sensor bodies.

1. Remove the cassette, if installed.
2. Use a cotton swab, moistened with an approved cleaning solution, to clean the sensor faces (A), tubing channel (B), plunger tip (C), and sensor pins (D).
3. Dry the sensor faces and tubing channel and ensure the sensor faces are free of detergent film and/or debris.

Repair

- The GemStar Pump has no user-serviceable components, with the exception of disposable batteries.
- If the display clock stops working, contact Hospira Technical Support Operations to arrange for internal lithium battery replacement.
- **Homecare Customers:** Call your healthcare professional or homecare company regarding any required service or repairs. DO NOT attempt to repair the pump for any reason.
- The GemStar Pump is covered by a manufacturer’s warranty for one year after purchase. During this time, opening the pump case for any reason voids this warranty. Refer to Chapter 18 Warranty/Technical Assistance, page 189 for details.
- Refer all service to Hospira certified technicians only. *A GemStar Technical Field Service Manual* is available to Hospira certified technicians.
Chapter 14

Operation Test

This test is designed to ensure the GemStar Pump is operating properly. Hospira recommends performing this test a minimum of once every 12 months. Refer to facility requirements to determine additional testing needs.

The test can be performed when the pump is in the STOP mode and requires approximately 15 minutes to complete. The pump provides step-by-step instructions through each section of the test.

Note: This test is available only when the pump is UNLOCKED.

WARNING: Disconnect the pump from the patient BEFORE performing the Operation Test.

Equipment Required

- GemStar Pump
- Two GemStar Micubore Pump Sets without a filter
- Reservoir with at least 50 mL of water
- 20+ mL or larger graduated cylinder (graduated in 0.1 mL)
- Two fresh, disposable AA batteries
- Appropriate GemStar AC Maus Adaptor or other Hospira approved external power source
14. Operation Test

Test Setup

Note: The pump clears any program and shift totals stored in pump memory before starting the Operation Test.

1. Connect the external power source and install two fresh, disposable AA batteries.
2. Power-on the pump.
3. Press [OPTIONS].
4. Select [HISTORY] from the Options Menu.
5. Select [OPERATION TEST] from the History Menu.
6. Follow the instructions on the display.

Performing the Operation Test

Tip: The checklist at the end of this section may be copied to record test results.

Case Inspection

1. Visually inspect the case and keypad for damage. Check the case for missing screws, or labels.
2. Enter the results:
   - If the pump is free of damage and all the screws and labels are in place, press [YES].
   - If damage is found on the case or keypad, or any screws or labels are missing, press [NO].
Cassette Pocket and Latch Inspection
1. Visually inspect the cassette pocket and the sensors (A). Verify that they are free of dirt and residue.
2. Verify that the four cassette latches (B) are present. Verify that they open and close when the cassette release button is pressed.
3. Verify that the plunger seal (C) and sensor seals (D) are present and intact.
4. Verify that the plunger (E) is not scraped or damaged.
5. Verify that the sensor pins (F) are not damaged.
6. Install the cassette. Verify the cassette fits smoothly and securely.
7. Enter the results:
   - If the cassette pocket area and latches are free of damage, and ALL of the above steps are verified, press [YES/ENTER].
   - If damage is found, or ANY of the above steps cannot be verified, press [NO].
14. Operation Test

Power Check

Tip: Opening the battery compartment door will disconnect the batteries enough for the pump to recognize external power. Then the door can be tightened and testing can continue. This can save time when performing multiple tests on a group of pumps.

1. The display indicates that an external power source and batteries are connected. Press \( \mathbf{H} \).

2. Remove battery door and press \( \mathbf{H} \). The display indicates that only external power is connected. Press \( \mathbf{H} \).

3. Return the battery door to the closed position.

4. Disconnect the external power source and press \( \mathbf{H} \).

5. The display indicates that only batteries are connected and displays the test results. Press \( \mathbf{H} \).

6. If the pump fails, reconnect the external power source and press \( \mathbf{H} \) to run the test, or press [YES/ENTER] to confirm failure.

Keypad Test

1. Press each key, including the Bolus button. Press [YES/ENTER] last.

2. Enter the results:
   - If each key makes an audible tone, press [YES/ENTER].
   - If any key does not make an audible tone, press [NO].

Display Test

1. Press [YES/ENTER] when prompted. The display fills with solid boxes for approximately 10 seconds. To view the solid boxes for another 10 seconds after the display times-out, press \( \mathbf{H} \).

2. Enter the results:
   - If the display fills with solid boxes, press [YES/ENTER].
   - If the display does not fill with solid boxes, press [NO].
14. Operation Test

**LED Test**

1. Verify that both the Power (green) and Alarm (red) LEDs are lit. Refer to the GemStar Pump Layout in the “Introduction” section for the location of the LEDs.

2. Enter the results:
   - If both LEDs are lit, press [YES/ENTER].
   - If either of the LEDs does not light, press [NO].

Tip: Use two microbore pump sets to save time during the next four tests. The first set should be fully primed BEFORE beginning the volume accuracy test. Use a second, DRY set for the air-in-line test.

When the proximal occlusion test is complete, remove the WET set from the pump and insert the DRY set. Press [START] to begin the air-in-line test. The WET set can then be placed in the next unit ready for testing.

**Volume Accuracy Test**

The pump should deliver between 19.0 to 21.0 mL within approximately 3 minutes to pass this test.

1. Load a primed pump set into the pump. Press ( ).
2. Place the proximal end in the reservoir of water. Press ( ).
3. Place the distal end in a 20+ mL graduated cylinder. Press ( ).
4. Press [START].
5. Enter the results:
   - If the pump delivers between 19.0 to 21.0 mL, press [YES/ENTER].
   - If the pump does not deliver between 19.0 to 21.0 mL, press [NO].
14. Operation Test

**Digital Occlusion Test**

The occlusion should occur within approximately 20 seconds to pass this test.

1. Clamp the pump set 10 to 12 inches (25.4 to 30.5 cm) below the cassette.
2. Press [START].
3. The test result displays. Release the clamp and press OK.
   - If the test is passed, the pump advances to the next test.
   - If the test is failed, clean the sensors and press OK to rerun the test or press [YES/ENTER] to confirm failure.

*Note: Clean the sensor pins before repeating the digital occlusion test. Refer to Chapter 13 Maintenance for instructions.*

**Proximal Occlusion Test**

The occlusion should occur within approximately 30 seconds to pass this test.

1. Clamp the pump set above the cassette.
2. Press [START].
3. The test result displays. Press OK.
   - If the test is passed, the pump advances to the next test.
   - If the test is failed, clean the sensors and press OK to rerun the test or press [YES/ENTER] to confirm failure.

*Note: Clean the sensor pins before repeating the proximal occlusion test. Refer to Chapter 13 Maintenance for instructions.*
14. Operation Test

**Air-in-line Test**

The air-in-line alarm should occur within approximately 1 minute to pass this test.

1. Release the clamp.
2. Remove the proximal end of the pump set from the reservoir. Press (✓).
3. Press [START].
4. The test result displays. Press (✓).
   - If the test is passed, the pump advances to the next test.
   - If the test is failed, clean the sensors and press (✓) to rerun the test or press [YES/ENTER] to confirm failure.

*Note: Clean the sensor faces before repeating the air-in-line test. Refer to Chapter 13 Maintenance for instructions.*

**Printing Test Results**

When the test is complete, the pump displays an option to print the test results. If desired, follow the steps below to print the test results. An example of the printed test results is shown.

*Note: For maximum battery life, operate the pump on AC mains power when connected to a printer or computer.*

1. Connect the serial printer cable to the pump. Refer to *Connecting to the Seiko Printer* in Chapter 10 Options Menu, on page 115.
2. Press [YES/ENTER] to print the test results.
3. The pump displays the Programming Menu when the results have finished transmitting or if [NO] is pressed.
14. Operation Test

**HOSPINA GemStar**

**OPERATION TEST**

**RESULTS**

**PUMP SERIAL NUMBER: XXXXXXX**

10:45AM JUL 3, 05

**VERSION X.X.X**

<table>
<thead>
<tr>
<th>Test Description</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Case Inspection</td>
<td>PASS</td>
</tr>
<tr>
<td>2. Cassette Pocket &amp; Latch</td>
<td>PASS</td>
</tr>
<tr>
<td>3. Power Check</td>
<td>PASS</td>
</tr>
<tr>
<td>4. Keypad Test</td>
<td>PASS</td>
</tr>
<tr>
<td>5. Display Test</td>
<td>FAIL</td>
</tr>
<tr>
<td>6. LED Test</td>
<td>PASS</td>
</tr>
<tr>
<td>7. Volume Accuracy Test</td>
<td>PASS</td>
</tr>
<tr>
<td>8. Distal Occlusion Test</td>
<td>PASS</td>
</tr>
<tr>
<td>9. Proximal Occlusion Test</td>
<td>PASS</td>
</tr>
<tr>
<td>10. Air-in-Line Test</td>
<td>PASS</td>
</tr>
</tbody>
</table>

**VERIFIED BY:**

**END OF**

**OPERATION TEST**

**RESULTS**

```
12345678901234567890123456789012345678901234567890
```
# 14. Operation Test

**GemStar®**  
Operation Test Checklist

<table>
<thead>
<tr>
<th>Test Description</th>
<th>Pass</th>
<th>Fail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case Inspection</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Cassette Pocket and Latch Inspection</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Power Check</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Keypad Check</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Display Test</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>LED Test</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Volume Accuracy Test</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Distal Occlusion Test</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Proximal Occlusion Test</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Air-in-line Test</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Printed Test Results</td>
<td>☐</td>
<td>☐</td>
</tr>
</tbody>
</table>

**Serial Number:**

**Verified By:**

**Date:**

Hospira GemStar Manual 430-00897-002 (Rev. 10/04)  151
Chapter 15

Optional System Components

All GemStar Optional System Components are composed of latex-free components only.

<table>
<thead>
<tr>
<th>Product Description</th>
<th>List #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GemStar AC Mains Adaptor (110 Volts - USA)</td>
<td>13028-01</td>
<td>Wall-mount adaptor plugs into a 110 VAC mains supply to power the GemStar Pump. 6 ft (1.8 m) cord.</td>
</tr>
<tr>
<td>GemStar AC Mains Adaptor (100 - 240 Volts - Universal)</td>
<td>13072-01</td>
<td>Tabletop adaptor plugs into a 100 – 240 VAC mains supply to power the GemStar Pump.</td>
</tr>
<tr>
<td>GemStar Bolus Cord</td>
<td>13027-01</td>
<td>Allows bolus requests to be made up to 6 feet (1.8 m) from the pump.</td>
</tr>
<tr>
<td>GemStar Pole Clamp</td>
<td>13075-01</td>
<td>Attaches the GemStar Pump to an I.V. pole. The clamp is mounted to the track on the back of the pump. Press the release button to remove the pump.</td>
</tr>
<tr>
<td>GemStar Battery Pack</td>
<td>13073-01</td>
<td>The rechargeable nickel metal hydride batteries power the GemStar Pump during periods of transport or when use of AC power is not desirable. The battery pack is recharged using a Gemstar AC Mains Adaptor.</td>
</tr>
<tr>
<td>GemStar Universal Lockbox</td>
<td>12499-01</td>
<td>Locks the GemStar Pump and up to a 250 mL flexible I.V. container or 30 mL PCA vial in a plastic enclosure. The lockbox can be attached to an I.V. pole using the GemStar Pole Clamp (available separately)</td>
</tr>
<tr>
<td>GemStar 250 mL Lockbox</td>
<td>13024-01</td>
<td>Locks the GemStar Pump and up to a 250 mL flexible I.V. container in a plastic enclosure. The lockbox can be attached to an I.V. pole using the GemStar Pole Clamp (available separately).</td>
</tr>
</tbody>
</table>
## 15. Optional System Components

<table>
<thead>
<tr>
<th>Component</th>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GemStar 30 ml PCA Vial Lockbox</td>
<td>13077-01</td>
<td>Locks the GemStar Pump and a 30 ml PCA vial in a plastic enclosure. The lockbox can be attached to an I.V. pole using the GemStar Pole Clamp (available separately).</td>
</tr>
<tr>
<td>Hospira Carrying Case - 250 ml</td>
<td>15364-01</td>
<td>Soft-sided carrying case can be worn around the waist to hold the GemStar Pump and up to a 250 ml flexible container.</td>
</tr>
<tr>
<td>Hospira Carrying Case - 500 ml</td>
<td>13079-01</td>
<td>Soft-sided carrying case can be worn around the waist or over the shoulder to hold the GemStar Pump and up to a 500 ml flexible container.</td>
</tr>
<tr>
<td>Hospira Carrying Case - 1000 ml</td>
<td>13980-01</td>
<td>Soft-sided carrying case can be worn around the waist or over the shoulder to hold the GemStar Pump and up to a 1000 ml flexible container.</td>
</tr>
<tr>
<td>Hospira Carrying Case - 3 Liter</td>
<td>13693-01</td>
<td>Soft-sided carrying case can be worn around the waist or as a backpack to hold a 3 liter or smaller flexible container and the GemStar Pump with batteries or battery pack. Includes list 13593-01.</td>
</tr>
<tr>
<td>Hospira 3 Liter Carrier</td>
<td>13580-01</td>
<td>Interior support for the Hospira Carrying Case - 3 Liter.</td>
</tr>
<tr>
<td>GemStar Docking Station</td>
<td>13075-01</td>
<td>Plugs into a 100 - 240 VAC Volt mains supply to power the GemStar Pump when mounted on an I.V. pole. During periods of transport, an internal rechargeable battery pack powers the pump for up to 16 hours at a rate of 100 ml/hr or less. When the AC mains supply is attached, the internal batteries are recharged in 4 to 6 hours. 12 ft. (3.6 m) cord.</td>
</tr>
<tr>
<td>GemStar Serial Cable</td>
<td>13078-01</td>
<td>Connects the GemStar Pump to a compatible serial printer or computer to download the event history, program, or speed protocol information.</td>
</tr>
</tbody>
</table>
## 15. Optional System Components

<table>
<thead>
<tr>
<th>Product Description</th>
<th>List #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GemStar Connect Clinician Kit</td>
<td>13048-01</td>
<td>Allows remote access from a clinician's computer to a GemStar Pump. The Kit includes a modem, phone cable, serial cable, and GemStar Connect software.</td>
</tr>
<tr>
<td>GemStar Connect Patient Kit</td>
<td>13049-01</td>
<td>Use with the GemStar Connect Clinician Kit to allow remote access to a GemStar Pump. The Patient Kit includes a modem, phone cable, and remote pump cable.</td>
</tr>
<tr>
<td>GemStar Triple Pole Clamp</td>
<td>13022-01</td>
<td>Not for use with a lockbox.</td>
</tr>
<tr>
<td>GemStar Configuration Guide</td>
<td>13000-97</td>
<td>Provides advance instructions for biomed technicians.</td>
</tr>
<tr>
<td>GemStar System Operating Manual</td>
<td>13081-01</td>
<td>Provides operating instructions for patients and caregivers.</td>
</tr>
</tbody>
</table>
Connecting the Bolus Cord
(List 13027-01)

Connect the bolus cord to the port labeled “Bolus” on the bottom of the pump.

CAUTION: When removing the cord from the bottom of the pump, firmly grasp the connector and pull straight out. DO NOT twist or bend the cord or connector.

Using the GemStar Lockboxes

The GemStar Lockbox is an enclosure that can be lockable with a key to secure the pump, and a flexible container or vial. When the pump is secured in the lockbox, the user has access to the AC mains connector, data and bolus ports, keypad, and bolus button.

Note: For the GemStar Universal Lockbox (List 12499-01) refer to the lockbox for instructions.
15. Optional System Components

**39 mL PCA Vial Lockbox (List 13077-01)**

1. Open the lockbox (A).
2. Flip the top door up (B).
3. Align the pump with the lockbox (C).
4. Slide the pump down into the lockbox until fully seated.
5. Flip the top door down.
6. Connect the pump set to the vial and prime.
7. Place the vial inside the lockbox (D).
8. Load the cassette (E).

**CAUTION:** Ensure all four cassette latches are clearly visible after the cassette is installed. Refer to *Loading the Cassette* on page 32.

**Note:** Ensure the tubing is in the tubing guide (at the distal end).

9. Ensure the tubing will not be pinched when closing the lockbox.
10. Close and lock the lockbox.
11. Remove the key.
15. Optional System Components

250 ml. Lockbox (Part 13900-01)

1. Open the lockbox (A).
2. Flip the top door up (B).
3. Align the pump with the lockbox (C).
4. Slide the pump down into the lockbox until fully seated.
5. Hang the bag on the hook inside the lockbox (D).
6. Load the cassette (E).

CAUTION: Ensure all four cassette latchers are clearly visible after the cassette is installed. Refer to Loading the Cassette on page 32.

Note: Ensure the tubing is in the tubing guide (fit the dual end).

7. Place the flexible container inside the lockbox with the administrative port down (D).
8. Flip the top door down.
9. Connect the pump set to the bag and prime.

10. Ensure the tubing will not be pinched when closing the lockbox.
11. Close and lock the lockbox.
12. Remove the key.
15. Optional System Components

Removing the Lockbox
1. Remove the lockbox from the pole.
2. Unlock the lockbox.
3. Open the lockbox and flip the top door up.
4. Press the cassette release button to remove the cassette.
5. Lift the pump out of the lockbox.

Using the Hospira Carrying Cases
Ensure the administration set is fully primed and the cassette is properly loaded before placing the pump in the carrying case. Refer to Chapter 2 Basic Operation for more information.

Carrying Case - 250 mL (List 10004-01)
This soft-sided carrying case can be worn around the waist. It is designed to hold the GemStar Pump and up to a 250 mL flexible fluid bag.

4. Place the fluid bag in the zippered compartment (A) on the backside of the case. Ensure the bag spike is positioned so that the fluid flow is not restricted.

2. Place the pump inside the front compartment (B) of the case.
13. Optional System Components

3. Secure the tubing to the inside of the pack with the Velcro® tabs (C). Ensure the tubing is not kinked.

4. Use the large Velcro flap (D) on the upper left side of the case to secure the tubing on the outside of the case.

5. Close the zipper. Ensure the tubing exits the side of the case near the zipper tab when the zipper is closed (E).

6. Place the case around the waist. Snap the buckle together to secure.

7. Adjust the belt for a snug, comfortable fit.

Carrying Case - 500 mL (List 13759-01) or 1000 mL (List 13580-01)

These soft-sided carrying cases can be worn around the waist or over the shoulder. They are designed to hold the GemStar Pump and up to a 500 mL (List 13759-01) or a 1000 mL (List 13580-01) flexible fluid bag.
15. Optional System Components

1. Place the pump on the inside front window (A). Ensure the keypad is facing the "window."

2. Secure the pump with the large side straps (B) and (C). Then secure the top (D) and bottom (E) straps.

3. Place the fluid bag on the backside of the compartment (F).

4. Secure the bag with flaps (G) and (H).

5. Secure the bag spike with strap (I). Ensure the fluid flow is not restricted.

6. Use a "figure-8" pattern to wrap the tubing. Secure the tubing to the inside of the case with tabs (J) and (K). Ensure the tubing is not kinked.

7. Zip the case closed. Ensure the tubing exits through one of the sides near the zipper tab when the case is closed.
15. Optional System Components

Place the case around the waist with the front “window” facing away from the body. Snap the buckle together to secure. Adjust the belt for a snug, comfortable fit.

Carrying Case - 3 Liter p/n: 13390-01

This soft-sided carrying case can be worn around the waist or as a backpack. It is designed to hold the GemStar Pump with batteries or a battery pack, and up to a 3 liter flexible feed bag.

Note: This carrying case includes an interior support (Hospira 3 Liter Carrier List 13390-01) that may be removed from the case and used separately.
15. Optional System Components

1. Unzip the carrying case and release all Velcro straps and flaps.
2. Place the fluid bag on the carrying case as shown (A).
3. Hook top strap (D) through the hole in the top of the fluid bag and secure.
4. Fold small flaps (C) and (D) over the bag as shown and secure.
5. Secure straps (E) and (F) across the length of the fluid bag and over the small flaps.
6. Secure the spike connection with strap (G).
7. Fold large flaps (H) and (I) over as shown and secure.
8. Place the pump, with the keypad facing upward, inside the pocket (J) on the flap. The pump’s display should be visible through the opening on the front of the pocket.
9. Secure the pump with straps (K) and (L).
10. Secure the tubing with strap (M).
11. Place the secured pump (N) inside the large zipper case or other carrying case.
12. Zip the large case closed.
13. If desired, route the tubing through the loops on the bottom of the carrying case. Ensure the tubing is not kinked.
14. Adjust the shoulder straps and waist belt for a snug, comfortable fit.

Tip: When not using the waist belt, secure it under the large flap on the back of the case.
15. Optional System Components
15. Optional System Components

Using the GemStar Docking Station
(List 13075-01)

Connecting the Pump

1. Mount the docking station to the I.V. pole and tighten the knob.
2. Align the connectors on the bottom of the pump with the connectors on the docking station.
3. Slide the pump into the docking station until it snaps into place.
4. Connect the docking station to AC mains power.

*Note: The docking station light is yellow while the docking station is charging. When the docking station is fully charged, the light is green.*
15. Optional System Components

Connecting the Bolus Cord and Printer Cable

WARNING: Ensure a cassette is installed in the pump before connecting to a printer or computer.

If the pump is connected to a patient: BEFORE connecting the pump to a computer or printer, press [Stop], close the slide clamp, and eject the cassette. Leave the pump set connected to the patient. Install another cassette in the pump before connecting to a printer or computer.

1. Plug the bolus cord into the bolus port on the rear, right side of the docking station.

2. Plug the printer cable into the printer port on the rear, right side of the docking station.

Disconnecting the Pump

To remove the pump:

1. Press the release button on the top of the docking station.
2. Slide the pump out.
Chapter 16

Pump Sets

CAUTION: USE ONLY GemStar Pump Sets with the GemStar Pump. Use of unauthorized sets may result in injury to the patient or damage to the pump.

Contact a Hospira Representative for appropriate pump set configurations.

Fluid path and areas beneath undisturbed protective set covers are sterile and nonpyrogenic in the intact unit package.

The GemStar Pump Sets, listed in the table on the following page are available for use with the GemStar Pump.

Note: The disposable pump sets should be changed per the Centers for Disease Control (CDC) guidelines or health care provider policy. Discard after use. All GemStar Pump Sets are composed of latex-free components only.

GemStar Pump Sets contain an anti-siphon valve to reduce the potential for gravity flow at a typical 36-inch head height.
16. Pump Sets

The following sets are a representation of the GemStar® Pump Sets currently available:

<table>
<thead>
<tr>
<th>List No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ambulatory Sets</strong></td>
<td></td>
</tr>
<tr>
<td>13263</td>
<td>Latex-Free GemStar® Pump Set and Extension Set with integral pressure-activated anti-siphon valve, Secure Lock, Nonvented, Microbore tubing, 96 in (244 cm)</td>
</tr>
<tr>
<td>13264</td>
<td>Latex Free, LifeShield®, GemStar® Pump Set with 0.2 Micron Filter, Secure Lock, Pre-attached needle injection site, Nonvented, Pressure-activated anti-siphon valve, Microbore tubing, 96 in (244 cm)</td>
</tr>
<tr>
<td>13266</td>
<td>Latex-Free, LifeShield®, GemStar® Pump Set with 1.2 Micron Filter, Secure lock, Pre-attached needle injection site, Nonvented, Pre-attached pressure-activated anti-siphon valve, Non-Shield (Non-DELIP) microbore tubing, 96 in (244 cm)</td>
</tr>
<tr>
<td>13273</td>
<td>Latex-Free GemStar® Pump Set, Secure lock, Non vented, Pre attached pressure-activated anti-siphon valve, Microbore tubing, 96 in (244 cm)</td>
</tr>
<tr>
<td><strong>General Infusion Sets</strong></td>
<td></td>
</tr>
<tr>
<td>13264</td>
<td>Latex-Free, GemStar® H:MA® II, Y Type Blood Set, 210 Micron Filter, Lower CLAVE® Connectors, Microbore tubing, 110 in (279 cm)</td>
</tr>
<tr>
<td>13275</td>
<td>Latex-Free, LifeShield®, GemStar® Primary Pendant Pump Set, Secure Lock, Convertible, Microbore Tubing Pressure Pin, 2 CLAVE® Connectors, Pre-attached pressure-activated anti-siphon valve, Microbore tubing, 110 in (279 cm)</td>
</tr>
<tr>
<td>13272</td>
<td>Latex-Free, LifeShield®, GemStar® 150 μL micro drip Set, SecoSet® Orbital Lock, Convertible Pressure Pin, 2 CLAVE® Connectors, Microbore tubing, 110 in (279 cm)</td>
</tr>
<tr>
<td>13276</td>
<td>Latex-Free, LifeShield®, GemStar® Piggyback Pump Set, with 0.2 Micron Filter, Secure Lock, Convertible Pressure Pin, 3 CLAVE® Connectors, Pre-attached pressure-activated anti-siphon valve, Microbore tubing, 110 in (279 cm)</td>
</tr>
</tbody>
</table>
### Pain Management Sets

<table>
<thead>
<tr>
<th>List No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>13045</td>
<td>Latex-Free, GemStar® Pump Set, Integral pressure-activated anti-siphon valve Secure Lock, Nonvented with PCA injector and female Luer Lock™ adapter, Microbore tubing, 98 in (244 cm)</td>
</tr>
<tr>
<td>13047</td>
<td>Latex-Free, GemStar® Pump Set with PCA Extension, Integral pressure-activated anti-siphon valve, Secure Lock, Nonvented with PCA injector and female Luer Lock™ adapter, Microbore tubing, 98 in (244 cm)</td>
</tr>
<tr>
<td>13281</td>
<td>Latex-Free, GemStar® Pump Set and Extension Set with integral pressure-activated anti-siphon valve, Secure Lock, Non-vented, Microbore tubing, 118 in (270 cm), Yellow Striped Tubing</td>
</tr>
</tbody>
</table>
# Chapter 17

## GemStar Pump Specifications

<table>
<thead>
<tr>
<th>Physical</th>
<th>The GemStar Pump is composed of latex-free components only.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions:</td>
<td>Height: 5.5 in. (14.0 cm)</td>
</tr>
<tr>
<td></td>
<td>Width: 3.8 in. (9.7 cm)</td>
</tr>
<tr>
<td></td>
<td>Depth: 2.3 in. (5.1 cm)</td>
</tr>
<tr>
<td>Weight:</td>
<td>Approximately 17 oz. (482 grams) excluding batteries</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transport and Storage Environment</th>
<th>Store in cool and dry environment.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ambient Temperatures:</td>
<td>-4°F to +140°F (-20°C to +60°C)</td>
</tr>
<tr>
<td>Relative Humidity:</td>
<td>10% to 90%</td>
</tr>
<tr>
<td>Atmospheric Pressure:</td>
<td>0–10,000 ft. (0–3,000 m) equivalent pressure</td>
</tr>
</tbody>
</table>

| Operating Environment | Ambient Temperatures: | +41°F to +104°F (+5°C to +40°C) |

<table>
<thead>
<tr>
<th>Power Sources</th>
<th>AC Mains:</th>
</tr>
</thead>
<tbody>
<tr>
<td>List 13026-01 (USA) complies with UL 544</td>
<td>Wall-mount AC mains adaptor; 6 ft. (1.8 m) cord molded plug</td>
</tr>
<tr>
<td>Input: 110 VAC</td>
<td>Output: 3.0 VDC</td>
</tr>
<tr>
<td>List 13072-01 (International) complies with CSA 22.2 No. 601.1 and UL 60601-1</td>
<td>Desktop AC mains adaptor; molded plug</td>
</tr>
<tr>
<td>Input: 100–240 VAC</td>
<td>Output: 3.0 VDC</td>
</tr>
<tr>
<td>Battery:</td>
<td>Two disposable AA alkaline or lithium batteries</td>
</tr>
<tr>
<td>Battery Pack:</td>
<td>Rechargeable using GemStar AC Mains Adaptor</td>
</tr>
<tr>
<td>Docking Station:</td>
<td>Mounts on an I.V. pole; 12 ft. (3.6 m) cord</td>
</tr>
<tr>
<td>Input: 100–240 VAC</td>
<td>Output: 3.0 VDC</td>
</tr>
<tr>
<td></td>
<td>Internal rechargeable battery</td>
</tr>
</tbody>
</table>
17. GemStar Pump Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient Capacity</td>
<td>Using two fresh, disposable AA batteries or a charged battery pack, at temperatures between 55°F and 95°F (13°C and 35°C), the pump is capable of delivering approximately 96 hours at rates below 5 ml/hr, 48 hours at rates at or above 5 ml/hr but below 25 ml/hr, 24 hours at rates at or above 25 ml/hr and below 125 ml/hr, 800 ml at a rate of 125 ml/hr or higher.</td>
</tr>
<tr>
<td>Pump Mechanism</td>
<td>Volumetric, Piston Driven</td>
</tr>
<tr>
<td>Memory Protection</td>
<td>Current program and 400-event (history) log protected by internal lithium battery-backed memory for at least one year after power is removed.</td>
</tr>
<tr>
<td>Operating Controls</td>
<td>One 23-key keypad, buttons, data port, and AC mains jack, volts button.</td>
</tr>
<tr>
<td>External Power LED</td>
<td>Green LED marked with plug icon lights continuously when pump is connected to AC mains power. Green LED flashes when pump is connected to external batteries.</td>
</tr>
<tr>
<td>Alarm LED</td>
<td>Red LED marked with alarm icon lights during silent conditions.</td>
</tr>
<tr>
<td>Audible Alarm</td>
<td>The audible alarm is user-adjustable from the maximum volume down to silent. The alarm automatically reverts to the maximum volume if the user does not respond within one minute.</td>
</tr>
<tr>
<td>Display</td>
<td>Backlit, four-line by sixteen-character alphanumeric graphic display.</td>
</tr>
<tr>
<td>Backlight on AC:</td>
<td>Continuous.</td>
</tr>
<tr>
<td>Backlight on Batteries:</td>
<td>Continuous during programming, program review, and history display; otherwise, activated by keypress or alarm; not activated by button request.</td>
</tr>
<tr>
<td>Real Time Clock</td>
<td>Accuracy of 25 minutes per month or better at temperatures between 50°F and 95°F (10°C and 35°C).</td>
</tr>
<tr>
<td>Heat Function</td>
<td>RS-232 serial interface port (data port), minimum baud rate of 38400, baud rate circuit.</td>
</tr>
<tr>
<td>Printers:</td>
<td>Seiko BPU 414 or compatible serial printer.</td>
</tr>
<tr>
<td>System Accuracy</td>
<td>± 10% for rates of 0.1 ml/hr to less than 5 ml/hr.</td>
</tr>
<tr>
<td></td>
<td>± 8% for rates of 5 ml/hr to 1000 ml/hr.</td>
</tr>
</tbody>
</table>

172 Hospital GemStar Manual 430-00897-002 (Rev. 10/04)
17. GemStar Pump Specifications

<table>
<thead>
<tr>
<th>Air Sensitivity</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ON:</strong></td>
<td>Pump alarms at approximately 0.5 mL of air</td>
</tr>
<tr>
<td></td>
<td>Alarms for any bubble greater than 500 microliters with a tolerance of 200 microliters</td>
</tr>
<tr>
<td>2 mL.</td>
<td>Pump alarms at approximately 2 mL of air</td>
</tr>
<tr>
<td></td>
<td>Alarms when pump detects 2.0 ± 1.5-3.2 mL of air in 6 mL of total volume delivered</td>
</tr>
<tr>
<td><strong>OFF:</strong></td>
<td>Alarm is not activated</td>
</tr>
<tr>
<td></td>
<td>Recommend using air-eclimating filter when Air Sensitivity is set to OFF</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Occlusion Sensitivity</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Distal Occlusion:</strong></td>
<td>Alarms when pump detects distal pressure within a selectable range:</td>
</tr>
<tr>
<td></td>
<td>Low: 7 psi (48 kPa) ± 5 psi (±34 kPa)</td>
</tr>
<tr>
<td></td>
<td>Medium: 12 psi (83 kPa) ± 8 psi (±55 kPa)</td>
</tr>
<tr>
<td></td>
<td>High: 26 psi (179 kPa) ± 14 psi (±96 kPa)</td>
</tr>
<tr>
<td><strong>Proximal Occlusion:</strong></td>
<td>Alarms when pump detects proximal pressure less than or equal to -4 psi (-28 kPa)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Piggyback Rate</th>
<th>0.1 to 300 mL per hour</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Pump Self-Tests and Safety Features</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Self-test performed when the power switch is activated</strong></td>
<td>Diagnostic routine, including motor speed and air-detection monitoring, is repeated continuously while the pump is powered on.</td>
</tr>
<tr>
<td><strong>Error and alarm conditions are indicated by both audible and visual alarms; delivery in progress is stopped, if appropriate (refer to Chapter 12 Troubleshooting)</strong></td>
<td></td>
</tr>
</tbody>
</table>
Occlusion Information

Avoiding Bolus Infusion after Occlusion:

1. Press [STOP].
2. Close the distal slide clamp or CAIR® roller clamp.

3. Press the cassette release button to eject the cassette from the pump.

4. Press down on ( ) to open the flow stop.
5. Wait 10 seconds.

6. Press down on ( ) to close the flow stop.
7 Load the cassette.

CAUTION: Ensure all four cassette latches are clearly visible after the cassette is installed. Refer to Loading the Cassette on page 32.

Note: Ensure the tubing is behind the tubing guide (at the distal end).

8 Open the distal slide clamp or CAIR® (roller) clamp.

9 Review the program. Press \( \text{F1} \) to begin review.

10 Press [START] to start the pump.
17. GemStar Pump Specifications

Stored Occlusion Volumes

<table>
<thead>
<tr>
<th>Pressure Setting</th>
<th>Delivery Rate of 25 mL/hr</th>
<th>Pressure Limit</th>
<th>Stored Volume Limit</th>
<th>Time to Occlude in Seconds</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Macro</td>
<td>Micro</td>
<td>Macro</td>
<td>Micro</td>
</tr>
<tr>
<td>Low</td>
<td>7 psig (49.3 kPa)</td>
<td>7 psig (49.3 kPa)</td>
<td>0.20</td>
<td>0.09</td>
</tr>
<tr>
<td>Medium</td>
<td>14 psig (98.5 kPa)</td>
<td>13 psig (98.6 kPa)</td>
<td>0.54</td>
<td>0.44</td>
</tr>
<tr>
<td>High</td>
<td>32 psig (220.6 kPa)</td>
<td>30 psig (206.8 kPa)</td>
<td>1.24</td>
<td>0.46</td>
</tr>
</tbody>
</table>

Delivery Rate Accuracy

The following pump curves represent the typical flow rate deviations, both positive and negative, from the programmed flow rate under test conditions defined by International Electrotechnical Commission (IEC) Standards for infusion pumps. Using these curves, the medical professional may determine if the device can be expected to perform in a manner suitable for the drug or fluid to be infused. The pump sets used in this test are compatible to GemStar Pump Set List 13273.

The typical accuracy for this device is ±5% of the programmed rate for most conditions, after a period of normalisation. It is recommended that the medical professional refer to the following curves when making decisions regarding drug and fluid administration.

A single fault condition occurs when a single pump for protection against a safety hazard in equipment is defective or a single external abnormal condition is present.

The maximum over-infusion volume from a single fault condition is based upon the calculation of the maximum time to generate an error times the maximum rate possible (1000 mL/hr) as a consequence of the fault. This has been determined not to exceed 3.76 mL.

**CAUTION:** When using pre-filled vials, the system may underdeliver at low flow rates.

**Note:** False occlusion alarms and fluid delivery inconsistencies may occur when pumping viscous fluids in microbore tubing at rates greater than 500 mL/hr.
17. GemStar Pump Specifications

**Trumpet Curves**

The Trumpet Curve Graphs following the Example show representative maximum and minimum percent flow rate deviation from the programmed rate over time. This information was developed in accordance with IEC 60601-2-24: 1998, Sub-Clause 50.102. Refer to this standard for detailed information.

How to read a Trumpet Curve Graph (Refer to example on the following page):

The graphs following the Example plot flow rates at 30 second intervals for the first 2 hours and for the 96th hour of delivery. The graph plots mean delivery rate error (Average of 3 pumps) for the 2nd hour and the 96th hour as a straight line. The graph also presents maximum and minimum average delivery rate error for this interval plotted by averaging delivery errors over intervals of 2, 5, 11, 19 and 31 minutes ("Trumpet Curve").

**Example**

From the Trumpet Curve Graph sample that follows, find the 5 minute interval (A) at the horizontal axis and read the corresponding points (B) and (C) on the vertical axis. The values are approximately +2.8% and -0.5%.

This means that at the rate of 25 mL/hr the average maximum flow rate fluctuation for any 5 minute time interval during the 2nd hour of operation was within the limits of +2.8% and -0.5% from the nominal rate. The average delivery rate error over the entire 2nd hour was +1.6% (D).

For other time intervals look at other points at the horizontal axis and determine corresponding limits as above.
A trained professional can use the resulting graphs to select a pump with the appropriate startup and flow characteristics to suit the clinical application.

Note: As an example of how the trumpet curves can be used, consider the maximum and minimum deviations at the 5 minute average interval. The upper curve provides the maximum expected delivery rate error over a 5 minute interval; the lower curve provides the minimum expected delivery rate error over a 5 minute interval. An example would be Dopamine administered at 5 μg/kg/min. At 5 minutes, the average drug delivery error would be within the range of +2.5% and -0.5% of the expected nominal rate.
17. GemStar Pump Specifications

FLOW RATE
0.1 mL, 0 mm Hg Delivery Head, Start Up

PERCENT ERROR
0.1 mL, 0 mm Hg Delivery Head, Start Up

Observation Interval (minutes): Observation Interval (minutes)
- Max - Min - Mean
17. GemStar Pump Specifications

FLOW RATE
1 mL, 0 mm Hg Delivery Head, Start Up

PERCENT ERROR
1 mL, 0 mm Hg Delivery Head, Start Up
FLOW RATE
1 mL, 0 mm Hg Delivery Head, Hour 96

PERCENT ERROR
1 mL, 0 mm Hg Delivery Head, Hour 96

Observation Interval (minutes)
- Max - Min - Mean
17. GemStar Pump Specifications

FLOW RATE
25 ml, 0 mm Hg Delivery Head, Start Up

PERCENT ERROR
25 ml, 0 mm Hg Delivery Head, Start Up
FLOW RATE
25 ml, 0 mm Hg Delivery Head, 50 Hour

PERCENT ERROR
25 ml, 0 mm Hg Delivery Head, 50 Hour
17. GemStar Pump Specifications

**FLOW RATE**
25 mL, -100 mm Hg Delivery Head, Start Up

**PERCENT ERROR**
25 mL, -100 mm Hg Delivery Head, Start Up
17. GemStar Pump Specifications

FLOW RATE
25 mL, 140 mm Hg Delivery Head, Start Up

PERCENT ERROR
25 mL, +100 mm Hg Delivery Head, Start Up

Unit (percentage)
- Actual Rate — Programmed Rate

Observation Interval (minutes)
- a — Max  — s — Min  — r — Mean
17. GemStar Pump Specifications

FLOW RATE
25 mL, 0 mm Hg Delivery Head, -20 in H20 Filling Head, Start Up

PERCENT ERROR
25 mL, 0 mm Hg Delivery Head, -20 in H20 Filling Head, Start Up

Hospira GemStar Manual 450-90397-002 (Rev. 10/04)
Chapter 18

Warranty/Technical Assistance

The GemStar Pump has been carefully manufactured using high-quality components. It is warranted to be free from defects in material and workmanship for a period of one year from the date of purchase under normal use and service. The warranty on the optional battery pack and other accessories is limited to 90 days.

On return to Hospira, the pump will be repaired or replaced within the terms of this warranty. Material returned to Hospira must be properly packaged and sent freight prepaid.

This warranty shall not apply if the pump has been repaired by anyone other than Hospira qualified service personnel; or altered in any way which, in Hospira's judgment, affects its stability or reliability; or if the serial number has been altered, effaced, or removed.

THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED.
16. Warranty/Technical Assistance

For customer service within the United States, contact:
1-877-HOSPIRA (1-877-947-7474)

For technical assistance and product return authorization within the United States, contact:
1-800-241-4002

For additional technical assistance, including Technical Service Bulletins, technical training, and product information, visit the Web site at:

www.hospiraparts.com

After authorization, ship prepaid product returns to the following address:

Hospira, Inc.
Technical Support Operations
735 Bath's Drive
Morgan Hill, CA 95037

Note: Outside the U.S., contact your local Hospira sales office.
Index

Numerics
1-hour dose limit, 55
4-hour dose limit, 55

A
AC mains
  power connector, 4
  power indicator, 3
Pump Specifications, 171
regarding handling and maintenance, 13
regarding pump operation, 13
AC Mains Adaptor
  connecting to, 20
administration set. See pump set
air sensitivity, 77, 83, 107
  regarding air-in-line infusion, 13
  specifications, 173
air-in-line, alarm, 11, 13
  test of, 149
alarm messages, 128–134
alert messages, 135–137
anti-siphon valve, 12, 30, 31
Auto KVO, 5
  in mL/hr Only therapy, 83
  in Weight Dosed therapy, 79
Auto Taper Down
  in TPN therapy, 50
  See also taper down; taper up
auto tapering. See Auto Taper Down; taper
down; taper up

B
backcheck valve, 71, 72, 86, 87
BACK-UP key, 3, 28, 97, 102
base rate, 92, 93, 94
batteries, 115
  alarm messages, 128–134
  battery compartment, 4
  battery pack connector, 4
  installing disposable batteries, 19
  maintenance, 139
  power check, 146
  specifications, 171
  using the rechargeable battery pack, 21
  warnings and cautions, 13–16
head rate, 172
  configuration settings for the Data
  Port, 113, 116
  switch settings for Seiko printer, 114
bolus, 5, 30, 57
  bolus button, 4
  bolus delivery, 56–57
  bolus dose interruptions, 57
cleancare, 122, 123
clinician instructions, 122, 123
  connecting the bolus cord, 156, 166
  history, 98
  occlusion information, 174
  optional system components, 153
  in Pain Management therapy, 53–57
  print, 98, 109
  in Variable Time therapy, 91, 94
1-hour or 4-hour dose limit, 55
call back alarm, 51
continuing cases
  using the Abbott carry cases, 159–164
  cassette, 30
    cassette pocket, 4
    cassette release button, 4
    cleaning of, 139–141
    error message, 129
    inspection of, 140
    loading the cassette, 30
    releasing the cassette, 30
    warnings and cautions, 13

change history, ii
change menu, 8
clinician instructions, 121–125
  adding a second lock level, 123
  locking the pump, 122
  program and deliver a clinician activated
    loading dose, 124
  unlocking the pump, 124
configuration settings, data port, 113
  connecting the Abbott GemStar A.C. mains
    adapter, 20
  connecting the hoses cord, 156
  connecting to a computer, 116
  see also data port
  connecting to the Seiko printer, 115
  see also data port
continual delivery
  in pain management therapy, 55–58
  in TPN therapy, 47, 56
continuous therapy, 5, 69–73
  changing a continuous program, 74
clinician instructions, 122, 123
  features and specifications, 69
  piggybacking in continuous
    therapy, 71–74
  programmable ranges, 75
  programming, 69
  Programming worksheet, 75
  rate titration, 71
  contraindications for use, 11

data port, connecting to, 112–117
  configuration settings, 115
  connecting to a computer, 116
  connecting to the Seiko printer, 115
  connector, 4
  disconnecting the pump, 23
  distal end, 30, 35, 147
  distal occlusion, 6, 106
  alarm message, 120
  occlusion sensitivity, 170
  occlusion sensor setting, 127
  test of, 148
  troubleshooting, 156
  docking station, 154
  connecting the hoses cord and printer
    cable, 166
  connecting the pump, 165
  disconnecting the pump, 166
  close limit, 55
  drip chamber
    swining pump sets with a drip
      chamber, 56
    priming pump sets with a drip chamber
      using the PURGE key, 49

event log, 6
  history, display, 100
  print, 98
flow trace, 30, 33, 34, 36, 38, 40, 42, 45, 174
full look, 104
lock level functions, 105
Hospira GemStar manual 430-00867-002 (Rev. 10/04)
locking the pump, 122
unlocking the pump, 124

G
GemStar pump components, 4
GemStar pump features, 6
GemStar pump layout, 2–3

H
Heading 1, 17
HELP key, 3, 9, 28, 47, 54, 61, 69, 78, 84, 91, 101, 122, 127
HELP mode, 9
history, 6, 56, 57, 98, 109, 139
display bolus history, 103
display, clear history, 102
print, bolus history, 98, 109

I
Intermittent therapy, 5, 81–82
changing an Intermittent therapy, 66
changing the start time, 98
delivery interruptions, 64–65
features and specifications, 6
Next Dose function, 111
programmable ranges, 67
programming of, 62–63
Programming Worksheet, 67

K
Keep Vein Open. See KVO; Auto KVO
KVO, 5
in Continuous therapy, 69
in intermittent therapy, 61, 67
in mL/hr Only therapy, 85
in TPN therapy, 47
in Variable Time therapy, 91
in Weight Dosed therapy, 77, 79
troubleshooting, 138

L
loading dose, 2, 55
clinicactivated loading dose, 124
delivery, 57–58
in Pain Management therapy, 53
loading the cassette, 52
lock, 3
adding a second lock level, 123
Full Lock, 104, 105
keypad lock, 3, 98, 104
keypad lock level functions, 105
locking the pump, 122
Luer Lock, 12
Rate Change Lock, 58, 104, 105, 122, 123
unlocking the pump, 124
lockboxes
using the Abbott GemStar
lockboxes, 156–159
locking the pump, 122
adding a second lock level, 123
Luer Lock, 12

M
maintenance, 139–141
cleaning and disinfecting, 139
cleaning the cassette pocket and tubing channel, 141
cleaning the pump case, 140
recommended cleaning solutions, 140
repair, 141
Menu
Programming, Change, Options, 7
mL/hr Only therapy
VTBI Titration, 86
mL/hr Only therapy, 5, 83–90
Auto KVO, 83
changing a mL/hr Only program, 89
features and specifications, 83
piggybacking, 86–89
programmable ranges, 90
Index

programming of, 83, 84
Programming Worksheet, 90
care situation, 88

Med new container, 6
starting a new container, 29
troubleshooting, 136, 137
New Container Lock
locking the pump, 122
unlocking the pump, 124
next dose, 98, 111

C occlusion, 106
changing the occlusion sensor settings, 107
occlusion information, 174–176
occlusion sensitivity, 173
See also distal occlusion; proximal occlusion
occlusion sensor
changing the occlusion sensor settings, 107
See also distal occlusion; proximal occlusion
Operating Modes
Help, Programming, Run, Stop, 9
operation test, 143–151
air-in-line test, 149
assessing pocket and back inspection, 145
display test, 146
distal occlusion test, 143
equipment required, 143
hep pd test, 146
LED test, 147
Operation Test Checklist, 151
power check, 146
printing the results, 149
proximal occlusion test, 148
reset setup, 144
volumes, accuracy test, 147
optional system components, 153–156
OPTIONS key, 3
display shift totals, 101, 125
Options Menu, 8, 97–117
change Pump Settings, 106
correcting to the data port, 112–117
Histories, 99
Keypad Lock, 104
Next Dose, 111
Operation Test, 105
Print, 102
Review Program, 59
Set Clock, 108
Speed Protocol, 110
tips for using the options menu, 97
other display messages, 138

Pain Management therapy, 5, 83–86
1-Hour or 4-Hour Dose Limit, 55
alert messages, 138
bolus delivery, 56
changing a Pain Management therapy, 58
features and specifications, 53
loading dose delivery, 57
programming ranges, 60
programming of, 54–56
Programming Worksheet, 60
piggybacking, 5, 6
safely ending a piggyback delivery, 74, 89
starting a piggyback delivery, 72, 88
in Continuous therapy, 71–74
in Nutritional Only therapy, 86–89
programming for secondary delivery, 72, 87
programming a secondary delivery, 73, 88

184 Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
power indicator, 3
power sources
  power check, 146
  selecting, 18
powering on the pump, 24
prime, 3, 31
priming, 11
  priming extension sets, 45
  priming pump sets using pre-filled vials, 42
  priming pump sets with a drip chamber, 38
  priming pump sets with a drip chamber using the PURGE Key, 36
  priming pump sets without a drip chamber using the PURGE Key, 36
pump sets without a drip chamber, 34
See also prime; purge
Print, 109
programmable ranges
  in Continuous therapy, 75
  in Intermittent therapy, 67
  in mL/hr Only therapy, 90
  in Pain Management therapy, 60
  in TPN therapy, 51
  in Variable Time therapy, 95
  in Weight Dosed therapy, 81
Programming Menu, 8
  accessing the Programming Menu, 26
Programming Worksheet
  Continuous, 75
  Intermittent, 67
  mL/hr Only, 90
  Pain Management, 60
  TPN, 51
  Variable Time, 95
  Weight Dosed, 81
proximal end, 30, 147
proximal occlusion
  alarm messages, 133
  occlusion sensitivity, 173
  test of, 148
pump components, 4
pump features, 6
pump layout, 2–3
pump set, 12–16, 29, 167–169
GemStar Piggyback Pump Set, 69
pump components, 4
See also pump settings
pump settings, 3, 98
  air sensitivity, 107
  change pump settings, 106
  occlusion sensor, 107
  sound level, 108
pump specifications, 171–173
PURGE key, 3
  priming pump sets with a drip chamber using the PURGE Key, 36
  priming pump sets without a drip chamber using the PURGE Key, 36
R
Rate Change Lock, 58, 104, 122, 123
  lock level functions, 105
  locking the pump, 122
  unlocking the pump, 124
rate duration
  in Continuous therapy, 71
  in mL/hr Only therapy, 85
  in Weight Dosed therapy, 79
releasing the cassette, 33
RUN mode, 9
S
SILENCE key, 3
Speed Protocols, 6, 98, 109
  assign, review/recall, delete, 110–111
Index

START key, 3
starting a new container, 39
STOP key, 3
STOP mode, 9

T
tape down, 47, 48, 50
tape up, 47
technical assistance, 192

Therapies, 5
Continuous, 69–75
Intermittent, 61–67
inf/inf Only, 83–86
Pain Management, 53–60
Total Parenteral Nutrition (TPN), 47–51
Variable Time, 91–95
Weight Dosed, 77

Therapy Lock, 104
lock level functions, 105
Locking Sequence instructions, 122
unlocking the pump, 124

Tilted Rates, 5
Tilting VTBI, 5
Total Parenteral Nutrition. See TPN therapy

TPN therapy, 5, 47–51
Auto Tap Down, 56
caching a TPN program, 49
Features and specifications, 47
programmable ranges, 51
programming of, 48
Programming Worksheet, 51
troubleshooting, 127–133
telem messages, 128–129
text messages, 135
other display messages, 138

U
unlocking the pump, 124
UP/DOWN key, 38

V
Variable Time therapy, 5, 91–95
changing a Variable Time program, 94
delivery interruptions, 99
features and specifications, 91
programmable ranges, 95
programming of, 91
Programming Worksheet, 95
Volume To Be Infused. See VTBI
VTBI, 70, 78, 84
piggyback VTBI, 71–73, 86–88
VTBI Titration, 80, 86

W
warnings and cautions, 11
Weight Dosed therapy, 5, 77
Auto KVO, 79
caching a Weight Dosed program, 80
features and specifications, 77
programmable ranges, 81
programming of, 78
programming worksheet, 81
rate titration, 79
VTBI Titration, 80

Y
YES/ENTER key, 3, 23, 47, 54, 61, 69, 78, 84, 91

100

Hospital Gambetar Manual 330-00937-902 (Rev. 10/04)
CAUTION: Federal (USA) law restricts this device to sale by or on the order of a physician or other licensed practitioner.

DANGER: Possible explosion hazard exists if used in the presence of flammable anesthetics.

Authorized Representative:
Hospira
Donough Hill, Town:
Co. Donegal, Ireland

The 'C' and 'US' indications adjacent to the CSA Mark signify that the product has been evaluated to the applicable CSA and ANSI/UL Standards, for use in Canada and the U.S., respectively. This 'US' indicator includes products eligible to bear the 'NRTL' indicator. NRTL, i.e. National Recognized Testing Laboratory, is a designation granted by the U.S. Occupational Safety and Health Administration (OSHA) to laboratories which have been recognized to perform certification to U.S. Standards.

Equipment providing a degree of protection higher than that for Type E equipment against electrical shock particularly regarding allowable leakage currents and having an F-type applied part.

Protected against dripping water.

Attention: Consult accompanying documents.


This document and the subject matter disclosed herein are proprietary information. Hospira retains all the exclusive rights of dissemination, reproduction, manufacture and sale. Any party using this documentation accepts it in confidence, and agrees not to duplicate it, in whole or in part, or disclose it to others without the written consent of Hospira.

© 2005 Hospira, Inc.
Lake Forest, Illinois 60045, USA
Printed in USA

Hospira GemStar Manual 430-00897-A02 (Rev. 02/05)